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1. About This Guide 
This guide explains how to operate and maintain your wide format scanner. The guide assumes 
basic knowledge of your computer and operating system and does not repeat material from 
their documentation. 

Be sure to refer to: 
• The Installation Guide – accessed from the menu on the WIDEsystem TOOLS CD-

ROM – describes installation of your driver and scan-to-net setup issues. 
• The readme.htm file in the ws folder on the WIDEsystem TOOLS CD-ROM – contains 

the most current installation and OS compatibility issues. 
• WIDEsystem TOOLS Help – Press F1 after installing and opening WIDEsystem. – 

Contains information on using the WIDEsystem application and Scanner Maintenance 
software.   

Identify your scanner model icon 
This operator’s guide covers several scanner models, although there are individual differences 
between the models.  Use the guide’s scanner type icons to direct you to descriptions about 
your specific scanner model. Topics describing scanner functions that apply solely for specific 
models will be marked with one or several of the icons shown in the table below. Topics 
describing functions that apply for all models will be marked with all the icons.  
 
Before proceeding, identify the icon that applies to your scanner model. You can then use the 
icon throughout this guide to find the function description that applies for your specific scanner.  
 
If in doubt as to which icon refers to your scanner model, see the Model ID on the sticker on the 
back of the scanner. Models not listed in the table below are not within the scope of this guide. 
 

Icon in Guide Applies for scanners… Model IDs 

 

25” scanners with FireWire and USB  
 

GQ67D 
GR67D 

 

 

36” scanners with FireWire and SCSI 
GM67D 
GL67D 
GK67D 

 

36” scanners with FireWire and USB 
Replaceable parts. 

HA68A 
HB68A 

 

 

42” scanners with FireWire and 
USB 
 
ATAC and replaceable parts. 
ENERGY STAR®  compliant.  
 

GS67D 
GT67D 
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54” scanners with FireWire and SCSI 
ATAC and replaceable parts. 

GH67D 
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2. Scanner System Requirements 
 

On All Scanners      
 

• PC or supported workstation. 
• Compatible Windows operating system – View the ws/readme.htm file on the 

WIDEsystem TOOLS CD-ROM. 
• USB port, enabled FireWire Port, or an SCSI interface-kit matching your workstation.  
• The WIDEsystem TOOLS CD supplied with your scanner. 
• Scanning software and compatible third party software. 
• Grounded power outlet. 
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3. Installation 

3.1 Installation Steps 

On All Scanners      
 
To get your scanner up and running, follow the steps below in their written order. You will find 
detailed descriptions of each step in the sections specified under the column “Instructions in 
section…”. 
 
Step number Description Instructions in 

section… 
1 Insert WIDEsystem TOOLS CD-ROM into your PC. 

 IMPORTANT : DO NOT YET CONNECT THE SCANNER TO 
POWER OR PC.  
You will install WIDEsystem before you connect the scanner or install any 
scanner software applications. Your scanner drivers are automatically 
installed with WIDEsystem and your PC will then be fully prepared to 
detect and setup the newly connected scanner device.  
Start up the WIDEsystem TOOLS CD-ROM by inserting the CD-ROM into 
your PC. Normally the setup program interface will start automatically. If it 
does not, see section 3.2 for instructions on manual startup. 

3.2 

2 Install WIDEsystem software 
Click on the option Install WIDEsystem Software from CD main menu or 
run the setup.exe program directly from the WIDEsystem (ws) folder on the 
CD-ROM. Follow the installation instructions that appear on your screen. 

3.2 

3 Install Scanner Maintenance Software 
Click on the option Install Scanner Maintenance Software from CD’s 
menu. Follow the instructions that appear on your screen. 

3.2 

4 Shut down (power off) the PC  
Your PC is now prepared and must be powered off before connection with 
the scanner. 

 

5 Perform Preliminary Maintenance – Cleaning  
Clean your scanner’s flat surface so dirt and dust are not dragged into the 
scan area with the original. Clean the internal Scan area. 

3.10, 7.2 

6 Set up your scan station and control the smart card 
Your wide format copy scanner should be placed either on the specially 
designed stand-alone floor stand or on a sturdy table. For sheet feed 
models, make sure there is enough space behind the scanner to allow the 
media to run out.  Make sure that the scanner’s smart card is in place. 

3.3, 3.4 

7 Connect interface cable to scanner and PC 3.5, 3.6, 3.7, 3.8 

8 Connect scanner power cable 

The scanner is equipped with a three-wire (pin) grounding type plug. If 
you cannot insert the plug into your outlet, contact your electrician to 
replace the outlet and ensure a grounded power connection. Do not try to 
defeat or ignore the purpose of the grounding-type plug. 
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9 Turn on the Scanner 
To turn on the scanner - at back of the scanner, plug in the power cable 
and flip the Outlet Switch to ON. The scanner starts the init and self test 
sequence. 

 Power outlet and switch is found at the back of the scanner 

 

 10 Turn on the PC 

 Make sure the PC connected to the scanner is likewise power-
connected to a grounding-type power outlet with a three-wire (pin) 
grounding type plug. 

 

11 Verify installation of new hardware 
Double click on the WIDEsystem scanner icon on the Windows system 
tray. The program should detect a Selected Scanner in the dialog. 

3.9 

12 Run preliminary Scanner Maintenance - Maintenance program 
Left click on the WIDEsystem scanner Icon and select Launch Scanner 
Maintenance from the menu. Follow the instructions on your screen.   

7.3 
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3.2 Install Drivers and Maintenance Software  

On All Scanners       
 
Before connecting the scanner, you must install its basic drivers and maintenance utilities on 
your PC. The basic drivers and maintenance utilities are installed from the WIDEsystem TOOLS 
CD-ROM that came with your scanner.  

 
 

 Important: Be sure to install WIDEsystem before you connect the scanner or install any 
scanner software applications. Your scanner drivers are automatically installed with 
WIDEsystem and your PC will then be fully prepared to detect and setup the newly connected 
scanner device.  
If you connected and tried to install the scanner before installing WIDEsystem, the scanner will 
be entered on the system as a new device without functional drivers. The scanner will be 
displayed in the Windows Device Manager with a yellow error icon.  The scanner entry must be 
removed from the Device manager before re-installing.  

 Important: Be sure to use the WIDEsystem TOOLS CD-ROM that came with your scanner 
or a newer version. Out-of-date versions of WIDEsystem software may not detect your scanner 
model.  

To install the basic drivers and maintenance software: 

1. Start up the WIDEsystem TOOLS CD-ROM - Insert the CD-ROM into your PC. 
Normally the setup menu interface will start automatically. If it does not, perform the 
following steps to activate it. 

a. Click the Start button on the taskbar and choose Run from the menu. 
b. Type D:\setup in the Command Line Box (where D: represents the name of 

your CD-ROM drive). 
c. Select the OK button. 

2. View Installation Instructions - Click on the CD’s Installation Guide option to view 
additional installation instructions.  

3. Install WIDEsystem and drivers - click on the option from main menu or run the 
setup.exe program directly from the WIDEsystem (ws) folder on the CD-ROM. Follow 
the instructions that appear on your screen. 

4. Install the Scanner Maintenance program - click on the option from main menu or run 
the setup.exe program directly from the Scanner Maintenance (sm) folder on the CD-
ROM. Follow the instructions that appear on your screen. 
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NOTE: On Windows Compatibility - Your scanner and drivers are tested and developed to 
support the most current active Microsoft Windows version OS systems. Drivers and interface 
support in regard to specific Windows versions will follow the Microsoft Support Lifecycle Policy. 
The compatibility specifications can therefore change accordingly. The most current OS 
compatibility specifications and drivers will be available on your manufacturer’s website.  

 

3.3 Set Up the Scan Station 

On All Scanners      
 
Your wide format scanner should be placed either on the specially designed stand-alone floor 
stand or on a sturdy table. Make sure there is enough space behind the scanner to allow the 
media to run out. Thick stiff media requires space that is at least as large as the media length. 
 

 Slots or openings in the cabinet at the back or bottom are provided for ventilation. This 
ensures reliable operation of the product and protects it from overheating. These openings must 
never be blocked or covered by placing the unit on a bed, sofa, rug, or other similar soft 
surface.  
 

 Your scanner should never be placed near or over a radiator or heat register.  
 

 You should not place the scanner in a built-in installation unless proper ventilation is 
provided. 
 

 The scanner is equipped with a three-wire (pin) grounding type plug. This plug will fit only 
into a grounding-type power outlet. This is a safety feature. If you cannot insert the plug into 
your outlet, contact your electrician to replace the outlet and ensure a grounded power 
connection. Do not try to defeat or ignore the purpose of the grounding-type plug.  
 X 

 
 Make sure the PC connected to the scanner is likewise power-connected to a grounding-

type power outlet with a three-wire (pin) grounding type plug. 
 
 
 

  See also the Safety Instructions at the end of this operator’s guide. 
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3.4 Control the Smart Card 
Check that the Smart Card is correctly installed (contact side downwards) and corresponds to 
your scanner model. The scanner will function correctly only with a Smart Card inserted.  

 Be sure that the scanner is turned off when removing/inserting a Smart Card or 
accessing the Smart Card area. 

 
Locating the Smart Card 

On Scanners:     
You will find the Smart Card in the small drawer labeled “PUSH” behind the scanner front 
streamer (slide the streamer towards the left to access the drawer). Notice that the SCSI DIL 
switch controls are in the Smart Card drawer. The DIL switches are used only for certain 
configurations with SCSI interfacing (described in section Connection through SCSI interface). 

 

Smart Card drawer behind the streamer 

 
Locating the Smart Card 

On Scanners:  
On these models you access the Smart Card by lifting the scanning area lid towards the back. 
The Smart Card is placed in its insertion slot on the top right side of the scanner.  

 

Lift the scanning area lid to access the smart card 
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Locating the Smart Card 

On Scanners:  
On the 42” models you will find the Smart Card by removing the scanner’s right side cover. 
The Smart Card is placed in its insertion slot above the scanner interface connectors. 

 Be sure to reattach the cover after inserting the smart card. The cover must always be 
closed before you turn the scanner ON. 

 Remove the scanner’s right side cover Smart Card slot above interface connectors 

    
 

Locating the Smart Card 

On Scanners:  

On the 54” models you will find the Smart Card in the small drawer labeled “PUSH” behind the 
scanner front streamer (slide the streamer out to access the drawer). Notice that the SCSI DIL 
switch controls are in the Smart Card drawer. The DIL switches are used only for certain 
configurations with SCSI interfacing (described in section on Connection through SCSI 
interface). 

 

54” ATAC models - Smart Card drawer behind the streamer 
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3.5 Select the Scanner Interface   
Different scanner models support specific types of interface connections. Most scanners 
support two different types of interfaces and you need to select the one that is best for your 
scanning purposes and compatible with your PC system. The different interface types are 
described below.  
 
To see which interface options are available on your scanner: 
You can identify the specific interface types available on your scanner model by viewing the 
scanner’s Cable-Connector-Panel. (See the next section: Locate the Cable-Connector Panel). 
 
 

3.5.1 Description of Interface Types  
FireWire  
FireWire can accommodate 400 megabits (around 50 megabytes) per second, which is more 
than adequate for high volume scanning of large formats. FireWire is a plug-and-play (PnP) 
specification. FireWire usage requires a FireWire Card and Port installed on the computer. A 
FireWire card is supplied with the scanner. 
See your Windows documentation for information on OS capability with FireWire. 
 
USB 2.0 
With USB connectivity you do not need to open the computer and install cards. USB is a plug-n-
play (PnP) specification. The USB 2.0 interface supports a data transfer speed of 480 megabits 
making it one of the industry’s most effective interface options. Older computers with USB 1.1 
ports will function with a USB 2.0 (scanner) device but at the USB 1.1 (slower) speeds. 
See your Windows documentation for information on OS capability with USB. 
 
SCSI 
Setting up the SCSI connection requires installation of an SCSI board in your PC, installation of 
the SCSI driver and in some cases, setting the scanner’s SCSI DIL switches. SCSI is 
recommended only if you cannot use the FireWire or USB 2.0 connection option. 
SCSI interface scanners support the Ultra SCSI (8-bit Narrow) SCSI type interface. 
SCSI is supported on most Windows host platforms. 
 
NOTE: On Windows Compatibility - Your scanner and drivers are tested and developed to 
support the most current active Microsoft Windows version OS systems. Drivers and interface 
support in regard to specific Windows versions will follow the Microsoft Support Lifecycle Policy. 
The compatibility specifications can therefore change accordingly. The most current OS 
compatibility specifications and drivers will be available on your manufacturers website.  
 

Regulatory Notice: Your scanner product has been tested to comply with the EMC Standards 
EN55022 and FCC, Part 15. To maintain compliance, only use the interface cables supplied 
with the scanner.  
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3.5.2 Locate the Cable-Connector-Panel 
The interface cable connectors are grouped in a Cable-Connector-Panel. Different scanner 
models support different options for interfacing. You can identify the interface types available to 
you by viewing the scanner’s cable-connector-panel. You can find your scanner’s cable-
connector-panel as follows: 
 
Locate the cable-connector-panel 

On Scanners:    
 
FireWire and SCSI interface connectors or FireWire and USB connectors (25” models). The 
cable-connector-panel is found on the underside of the scanner and accessed from the 
scanner’s back.  

 
Cable-connector-panel is accessed from the scanner’s backside.

 
 

Locate the cable-connector-panel 

On Scanners:  
 
FireWire and USB interface connectors. The cable-connector-panel is found on the back. 

 
The cable-connector-panel is found on the scanner’s back.
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Locate the cable-connector-panel 

On Scanners:  
 
FireWire and USB interface connectors. You will find the cable-connector-panel by removing 
the scanner’s right side cover. You feed the interface cable through the opening in the back of 
the scanner until it emerges in front of the cable-connector-panel.  

 Be sure to reattach the cover after you connect the interface. The cover must always be 
closed before you turn the scanner ON. 

 Remove the scanner’s right side cover Interface connectors (cable-connector-panel)

    
 
 

 

Feed the interface cable through the hole in the back until it emerges in interface area.  

Interface area is behind the cover 
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3.6 Connection Through the FireWire Interface 
To connect through FireWire, you will need the FireWire cable that came with your scanner.  
Your computer must be enabled for FireWire through a FireWire card and port.  
 
Check your computer for FireWire 
Many computers come with FireWire inputs. Follow these steps to check if FireWire is enabled 
on your computer:  

1. In Windows, Click Start, Settings, and then Control Panel.  
2. Double-click the System icon.  
3. Click the Device Manager tab.   

If a FireWire host controller (IEEE) is listed, then FireWire is enabled on your computer. If you 
do not see this device listed, you will need to install a FireWire card. 
 
To install a FireWire card, shutdown your computer and install the card into an empty PCI slot. 
See your computer’s user’s manual for installation of new hardware and the driver installation 
information that came with your FireWire card.   
 
Connect scanner to PC with Firewire cable 

1. Make sure you have installed WIDEsystem on your PC before you connect the 
scanner. Your scanner drivers are automatically installed with WIDEsystem and your 
PC will then be fully prepared to detect and setup the newly connected scanner device.  

2. Shut down (power off) your PC. Do not connect the scanner power cable or turn on the 
scanner. 

3. Locate the FireWire cable that came with your scanner. 
4. Connect the PC end to the FireWire port on your computer 
5. Connect the peripheral end to a FireWire connection socket on your scanner. 
6. Connect the power cable to your scanner and turn the scanner on. 
7. Turn on the PC. The OS will detect and setup the newly connected scanner device. 
8. If an ”Unknown device is found” message appears after you plug in the cable, follow the 

steps described below under Unknown device is found message. 
 
Note: The extra FireWire connector is for daisy-chaining another device to your system and not 
for interfacing with another PC. 
 
“Unknown device is found” message 
If your system has problems detecting the scanner, make sure your FireWire port is enabled 
(see above). Make sure you have installed the WIDEsystem software from the CD that came 
with your scanner or a newer WIDEsystem version. Make sure you have installed WIDEsystem 
before connecting the scanner. You should never attempt to step through device installation 
dialogs before installing WIDEsystem. If you have done so, see the trouble shooting section for 
instructions on reinstalling. 
If your system still does not detect the device, disconnect the FireWire cable, unplug the power 
to your scanner and turn off the computer. Wait a few minutes, reconnect the scanner, restart 
the PC and turn on the scanner. 
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3.7 Connection through the USB Interface  
Verify that your scanner’s cable-connector-panel contains a USB port. Your computer must also 
have an enabled USB port. You will need the USB cable that came with your scanner.  
 
Check your USB Port 
Even if the computer has a USB port, it will not function unless it is enabled. Follow the 
instructions below to determine whether your USB port is enabled. 

1. In Windows, Click Start, Settings, and then Control Panel.  
2. Double-click the System icon.  
3. Click the Device Manager tab.   
4. Click the plus (+) icon to the left of the Universal Serial Bus Controller item. 

If a USB host controller and a USB root hub are listed, then USB is probably enabled on your 
computer. If you do not see these devices listed, refer to your computer's documentation or 
contact the manufacturer for more information on enabling and setting up USB. 
 
Connect scanner to PC with USB cable 

1. Make sure you have installed WIDEsystem on your PC before you connect the 
scanner. Your scanner drivers are automatically installed with WIDEsystem and your 
PC will then be fully prepared to detect and setup the newly connected scanner device.  

2. Shut down (power off) your PC. Do not connect the scanner power cable or turn on the 
scanner. 

3. Locate the USB cable that came with your scanner. 
4. Connect the PC end to a USB port on your computer 
5. Connect the peripheral end to the USB connection socket on your scanner. 
6. Connect the power cable to your scanner and turn the scanner on. 
7. Turn on the PC. The OS will detect and setup the newly connected scanner device. 
8. If an ”Unknown device is found” message appears after you plug in the USB cable, 

follow the steps described below under Unknown device is found message. 
 
“Unknown device is found” message 
If your system has problems detecting the scanner, make sure your USB port is enabled (see 
above). Make sure you have installed the WIDEsystem software from the CD that came with 
your scanner or a newer WIDEsystem version. Make sure you have installed WIDEsystem 
before connecting the scanner. You should never attempt to step through device installation 
dialogs before installing WIDEsystem. If you have done so, see the trouble shooting section for 
instructions on reinstalling. 
If your system still does not detect the device, disconnect the USB cable, unplug the power to 
your scanner and turn off the computer. Wait a few minutes, reconnect the scanner, restart the 
PC and turn on the scanner. 
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3.8 Connection through the SCSI Interface 
Verify that your scanner’s Cable-Connector-Panel contains a SCSI port. SCSI interfacing 
supports the Ultra SCSI (8-bit Narrow) SCSI type interface. If your PC does not support a SCSI 
interface, you will have to configure one. For this you will need:  

• A SCSI host adapter board (also called a SCSI controller)  
• SCSI driver software 
• A SCSI cable  

 
How to configure the SCSI interface  
Configuring the SCSI Interface requires the following steps. Each step is described in detail in 
the following sections: 

1. Install the SCSI host adapter board into an empty slot in PC. 
2. Install the SCSI adapter board driver software. 
3. Connect the scanner to PC. 
4. Set scanner DIL switches and DIL switch 4 termination if the default settings require 

changing. 
 
Step 1: Install the SCSI host adapter board 

1. Set the PC power-switch to OFF. 
2. Set any external device power switches to OFF (such as printers, displays etc.). 
3. Unplug the PC-system unit and all other devices from the wall outlet. 
4. Remove the cover of your computer to expose the expansion slots. 
5. Align and insert the SCSI host adapter board into an empty slot. 
6. Use the expansion slot panel screw to secure the host adapter to the computer frame. 

 
Step 2: Install the SCSI driver software 
The correct steps for SCSI driver installation depend on your Windows operating system. 
Follow the instructions for your operating system described in the SCSI driver documentation. 
 
Step 3: Connect scanner to PC with SCSI cable 

1. Make sure you have installed WIDEsystem on your PC before you connect the 
scanner. Your scanner drivers are automatically installed with WIDEsystem and your 
PC will then be fully prepared to detect and setup the newly connected scanner device.  

2. Shut down (power off) your PC. Do not connect the power cable or turn on the scanner. 
3. Locate the SCSI cable that came with your scanner. 
4. Connect the PC end to the SCSI port on your computer 
5. Connect the peripheral end to a SCSI connection socket on your scanner. 
6. If you do not need to configure the DIL switches (see next section) then you can 

connect the scanner power cable and turn the scanner power on. Otherwise, set your 
DIL switches before turning the scanner on and then proceed to the next step. 

7. Turn on the PC. The OS will detect and setup the newly connected scanner device. 
8. If an ”Unknown device is found” message appears after you plug in the cable, follow the 

steps described below under Unknown device is found message. 
 
Note: The extra SCSI connector is for daisy-chaining another device to your system and not for 
interfacing with another PC. 
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“Unknown device is found” message 
If your system has problems detecting the scanner, make sure your SCSI interface and driver is 
connected correctly. Make sure you have installed the WIDEsystem software from the CD that 
came with your scanner or a newer WIDEsystem version. Make sure you have installed 
WIDEsystem before connecting the scanner. You should never attempt to step through device 
installation dialogs before installing WIDEsystem. If you have done so, see the trouble shooting 
section for instructions on reinstalling. 
If your system still does not detect the device, disconnect the SCSI cable, unplug the power to 
your scanner and turn off the computer. Wait a few minutes, reconnect the scanner, restart the 
PC and turn on the scanner. 

Step 4: Setting the scanner DIL-switches  
The DIL-switches are used for setting up of the scanner’s SCSI connection ports, and for 
selection of the scanner test mode and the scanner forced boot start up mode. 

NOTE: 
The DIL-switches are set from the factory to default settings that apply to most common 
configurations so usually you will not have to change the DIL-switch settings. Best 
scanning performance is obtained with only one device on the SCSI bus. However, if your 
configuration requires more than one device on the bus, you may need to change the 
DIL-switch settings.  

The factory default DIL-switch settings and the DIL-switch Value table are shown on the 
following page. Use the table and the following instructions for each switch to determine if your 
DIL-switch settings need to be changed. 

Before accessing and setting DIL switches, you must turn the scanner power off. 
Removing and inserting the Smart Card (see below) while power is on can damage the 
scanner. 

On scanners with the SCSI interfacing option, you will find the DIL-switches in the small Smart 
Card drawer labeled “PUSH” behind the scanner front streamer. To access the switches 
remove the streamer, push the drawer inwards and release so it pops open and remove the 
Smart Card.   

 Important: Remember to reinsert the Smart Card when finished setting the DIL-switches 
and before turning power on. 
 

 

Smart Card drawer behind the streamer. Remove the card to access the DIL-switches. 
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SCSI DIL-Switches – Factory Default Settings 
 

SCSI Device Address               1

SCSI Device Address               2

SCSI Device Address             3

SCSI Built–in Termination         4

No Synchronous Transfer       5

Not in use                                6

Force Boot Start up               7

Continuous Test Mode            8

 
Device number setup – combinations of switches 1,2,3 
Make sure the power to the computer and the scanner are OFF when setting the SCSI device 
number, as the switch settings are only read from the scanner DIL-switch during the scanner’s 
power up. 
You can set up the SCSI device number for the scanner to any unused SCSI device number. 
The combination of the three SCSI Device Address switches determines the scanners device 
number. To set the SCSI device number to the one required, you set the switches 1, 2 and 3 to 
the combination of ON/OFF values specified in the table below. The scanner is set as SCSI 
Device number 2 from the factory. 

SCSI device no / Switch combination: 1 2 3 
SCSI device no. 0 ON ON ON 
SCSI device no. 1 OFF ON ON 
*SCSI device no. 2 ON OFF ON 
SCSI device no. 3 OFF OFF ON 
SCSI device no. 4 ON ON OFF
SCSI device no. 5 OFF ON OFF
SCSI device no. 6 ON OFF OFF
SCSI device no. 7 OFF OFF OFF

* Factory Default                                                                       
 
SCSI built-in active termination – switch 4 
Scanners with SCSI interface connectors have a built-in active SCSI termination that works 
better than a passive terminator at high transfer rates.  
The built-in active termination for the SCSI bus is enabled when switch 4 is ON (default) and 
disabled by setting it to OFF. 
If the scanner is the only or last device on the SCSI bus, make sure switch 4 is ON.  If the 
scanner is not the last device make sure switch 4 is OFF. (see the following illustrations). 

 Important:  Never set switch 4 to ON and use a terminator block at the same time. 
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The following 3 scenarios show how to terminate the SCSI bus correctly: 
 
A. The Scanner is the only external device on the SCSI bus 

Host Computer

SCSI SCANNER

Switch 4 must be ON

 
B. The Scanner is the last device on the SCSI bus 

SCANNER

Switch 4 must be ON

Host Computer

SCSI

CD-ROM

SCSI

 
C. The Scanner is not the last device on the SCSI bus 

SCANNER

Switch 4 must be OFF

Host Computer

SCSI

CD-ROM

SCSI

Must be
terminated

 
Note: If the scanner is connected to a SCSI controller in the PC that is used with an internal 
SCSI device (f.ex. hard disk), make sure that the on-board SCSI termination for that device is 
disabled before attaching the scanner. Refer to the internal device’s documentation.  
 
Troubleshooting and Test Controls – switches 5, 6, 7 and 8  
 
Switch 5. No synchronous transfer (default OFF): When ON switch 5 disables SCSI 
synchronous transfer mode (reverts to asynchronous transfer). Switch 5 should only be ON for 
testing as it slows the scanner down. 
 
Switch 6. Not in use – no effect.  
 
NOTE: The following switch 7 and 8 functions, Force Boot and Continuous Test modes can 
also be set from the Operator’s Panel with switch 7 and 8 on OFF (default setting). This is also 
the recommend method. See the section Operator’s Panel and Indicators for instructions.  
 
Switch 7. Force boot start up (default OFF): If an error occurred during a scanner firmware 
update, you can use this switch to force the scanner into firmware boot mode, enabling you to 
repeat the firmware update. 
Switch 8. Continuous test mode (default OFF): This switch is only turned ON for special 
technical maintenance and renders the scanner inaccessible. 
 

 Important : For normal scanning, make sure that all of the troubleshooting and test control 
switches 5, 6, 7, 8 are OFF.  

 



Installation    3-16 

3.9 Installation Verification 

On All Scanners       
 
 
 

1. Locate the scanner icon on the Windows System Tray. This is the WIDEsystem 
program icon. 

2. Double click on the WIDEsystem program icon.  
3. The program should detect a Selected Scanner in the dialog.  
4. If the scanner was not installed correctly, a message will inform you that your scanner 

could not be detected. If this is the case turn off power to all connected devices and 
repeat the installation steps. 

 

3.10 Preliminary Maintenance 

On All Scanners        
 
Once you have setup your scanner and verified your installation, it is important that you run your 
first maintenance session before working with the scanner. Shipping and transportation of your 
scanner from the factory may have affected the camera positions and therefore it is 
recommended to run camera alignment and calibration using the Scanner Maintenace program 
wizard. But before you do so, you must thoroughly clean the scanner’s flat topside (where paper 
rests during scanning) and the internal scan area (glass plate and rollers).  
 
Follow the instructions described in the section Regular Maintenance in this Operators Guide.  
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4. Scanner Operation - Panel and Indicators 
 
This section describes the scanner operator’s panel. The operator’s panel contains LED 
indicators and operation keys. The indicator’s function is to display scanner status in relation to 
its basic operations such as self-testing and media readiness. Interpretation of the LED 
indicator messages and operation of the keys are described in this section. You can always 
return to this section to reference specific tasks and LED patterns.  
 
4.1 The Operator’s Panel  
 
The standard Operator’s Panel 

On Scanners:     
 

Paper Ready LED 

Power Switch 

Power LED 

Wait LED 

Email Application 

Scan Application 

Copy Application 

Paper Forward/Reverse 

Diagnostics LED 

 
 
 
The following sections describe usage of the panel keys and the how to understand the panel 
LED lighting patterns.  
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The ATAC Operator’s Panel 

On Scanners:    
 

Paper Ready LED 

Power Key 

Power LED 

Wait LED 

Email Application 

Scan Application 

Copy Application 

Paper Forward/Reverse Keys 

Diagnostics LED 

ATAC key 
 

 
 
The following sections describe usage of the panel keys and the how to understand the panel 
LED lighting patterns.  
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4.2 Scanner Control – Hard and Soft Power ON/OFF and Panel LEDs 

On All Scanners:        
 
Hard Power and Soft Power - Two Ways for Turning Power On and Off 
 
• Hard Power ON/OFF  

You can power on and off by flipping the outlet switch at the back of the scanner. This is 
what you will have to do the first time you turn on power, if you move the scanner to a new 
power wall-outlet or if you want to force the scanner into Firmware Boot mode.   

 
 
• Soft Power OFF/ON 

Turn OFF and ON by pressing the power key on the operator’s panel. The scanner must be 
Hard Powered ON – i.e the switch at the scanner’s back must always be ON in order to use 
Soft Power OFF/ON. Soft Power OFF/ON is how you would normally power off and on, and 
the switch at the back will always be flipped to ON.  
 
Advantages with Soft Power OFF/ON:  

Power OFF 
 

Power ON
 

• You turn the scanner OFF and ON by pressing the power key on the panel. The 
scanner is ready to scan sooner than with Hard Power ON.   

• Scanner power ON and power OFF can be controlled through the WIDEsystem 
software timer feature or an idle time setting. Power down reaches the strict ENERGY 
STAR®  low power values on ENERGY STAR® compliant models).  

• The green power LED will blink just before the scanner powers off because its defined 
power off time (in WIDEsystem) has been reached. If you are using the scanner and 
want to cancel power down, press the power key until the green LED stops blinking. 
You can always disable or change timer settings in WIDEsystem.  

• When OFF (LED is red) The scanner can be powered up by pressing the power key or 
just by inserting paper into the scanner indicating you wish to use it. 

 
The scanner’s Self Test Procedure 
 
When you connect the scanner to the power outlet and turn on the outlet switch at the back of 
the scanner, it starts up with a self-test procedure. The scanner’s self-test procedure consists of 
two main steps –  
• Init (Initialization) Sequence – the scanner loads and tests internal parameters. Only 

initiated when you power up by flipping the outlet switch at the back of the scanner (Hard 
Power On). 
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• Self-Adjustment  - includes a short warmup period, adjustment of light profiles, stitching 
and black/white points. Invoked every time you turn on power with either outlet switch (Hard 
Power On) or through power OFF/ON key (Soft Power On). 

 
The scanner will be ready to scan on completion of its self-test procedure. Normally, after 
powering up for the first time, you will leave the outlet switch permanently ON, and turn scanner 
power ON and OFF with the Power key on the operator’s panel.  To ensure optimal 
functionality, the scanner will always run Self-Adjustment when you turn power from OFF to ON.  
 
The illustrations below marked “startup – phase 1 (2,3,4)” show how the Operator’s panel will 
look (LED lighting patterns) starting from when you turn power ON, through the self-test 
procedures and until the scanner is ready to scan.  
 
NOTE: For simplicity, the illustrations below display a Standard Panel i.e., without an ATAC key. 
The LED behavior of the Power LED, Diagnostics LED and Wait LED, are identical for Standard 
and ATAC operator’s panels. 
 
How it looks on scanner… What it means…. 

    

Turn the scanner power ON – First Time –  Hard Power ON 
 
At back of the scanner, plug in the power cable and flip the Outlet 
Switch to ON. The scanner starts the self-test procedure which 
starts with the Init Sequence (see next).   

 

 

Init Sequence (startup phase 1) 
 

When you invoke Hard Power On by turning scanner power ON from 
the outlet at the back, the scanner runs it initialization sequence. ALL 
the LEDs are lighted as shown in the illustration on the left.  
 
Panel input is disabled and you cannot begin scanning.  
 
NOTE: When you power up through Soft Power On, by pressing the 
power key (from red to green) as described in “Soft power ON/OFF”, 
this initialization sequence is skipped and the scanner goes directly to 
Self-Adjustment (startup-phase 3) as described below.  
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Power LED Green (startup – phase 2) 
 
Towards the end of Init Sequence, the Power LED will change to 
green while the other LEDs remain unchanged (lighted).  
 
From here the scanner moves on to Self Adjustment (startup 
phase 3). 
 
 

 
 

Power ON 

 
 

Power OFF 

 

Soft Power ON and OFF- Turn power ON/OFF with power key –
normal use (with outlet switch always ON) 
 
With the outlet switch always ON, use the Operator’s panel Power key 
to control scanner power. Hold down on the Power key to toggle 
power OFF/ON. This is termed Soft Power OFF/ON mode.  
 
The Power LED lights green when the scanner is ON and red when 
power is OFF.  When you turn the scanner ON in this manner, it starts 
in Self-Adjustment mode (startup phase 3) as described below.  
 
When in the power OFF/ON mode, the scanner can automatically be 
powered up and down by WIDEsystem’s timer or an idle time setting. 
See WIDEsystem Help for instructions. 

 

 

Self-Adjustment (startup –phase 3) 
 
If you used Hard Power On - On completion of the Init Sequence, 
the power LED (green) and the Wait LED (yellow) remain lighted while 
the others LEDs turn off. This indicates that the scanner is running its 
Self-Adjustment of light profiles, stitching and black/white points.  
 
If you used Soft Power On - the power LED turns to green and the 
Wait LED turns on yellow while others LEDs are off. This indicates 
that the scanner is running its Self-Adjustment with warm-up and 
adjustment of  light profiles, stitching and black/white points.  
 
To maintain optimal conditions, the scanner runs new Self-adjustment 
procedures periodically during the day (without lighting the wait LED). 
If the Wait indicator flashes, the scanner needs to run Self-Adjustment 
but cannot (see below).  
 

 

 

Scanner Ready (startup – phase 4) 
 
When the Wait LED turns off, and only the Power LED is on and lights 
green, self-adjustment is completed and the scanner is ready to scan.  
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Green Power LED flashing 
 
The green power LED will flash just before the scanner 
automatically powers off because its defined automatic power 
OFF time (in WIDEsystem) has been reached in the timer.  
 
If you are still using the scanner and want to cancel the timer 
controlled power OFF, press the power key until the LED stops 
blinking.  
 
You can at any time disable or change timer settings in 
WIDEsystem (see WIDEsystem on-line help for details).  
 

 

 

Wait LED Flashes - Self-Adjustment required but not possible 
 
If the Wait LED flashes (and the Diagnostics LED is off) the scanner 
needs to run Self-Adjustment but cannot. Self-Adjustment is 
necessary for maintaining optimal and stabile internal conditions.  
 
To solve this, any original in the scanner should be removed, and the 
pressure-platen should be set to the Normal position (i.e., not a thick 
media setting). A scan may be issued, but the quality will be 
compromised. When Self-Adjustment is again possible, the Wait LED 
stops flashing, but continues to be on until Self-Adjustment is 
completed. The scanner should be left alone while Self-adjustment is 
running.  
 

 

 

During Calibration – Wait LED lights 
 
This is normal. The Wait LED is on during Calibration to indicate that 
the original should not be removed or moved during the Calibration 
procedure.  
All panel input is prevented during basic calibration. 
 

 

 

Diagnostics LED Flashes – Error detected during Self-Test 
 
The Diagnostics LED shows the scanner’s Self-Test result status. An 
unlit Diagnostics LED means that the scanner’s Self-Test procedures 
encountered no errors.  
 
If the Diagnostics LED flashes, an error was discovered during Self-
Test. Open WIDEsystem (scanner icon on your system tray) and 
select the Status tab to view additional information about the error. 
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Both Diagnostic LED and Wait LED Flash – Maintenance needed 
 
Simultaneous flashing by both the Diagnostic LED and the Wait LED 
may mean that the scanning area needs cleaning and the cameras 
calibrated. See the section on "Maintenance" for instructions.  
 
If the Diagnostic and the Wait LEDs continue to flash after scanner 
maintenance, there may be camera position errors that require 
professional technical service. 
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4.3 Application Control – One Touch Scan 

On All Scanners:        
 

The Application Control keys require correct installation of WIDEsystem software, scan 
applications and setup definitions before they can become active. Your PC must be turned on 
and running. 
Descriptions of the key’s intentional functionality follow below. You can however, assign 
applications with other functions to any of the Application Control keys. For instructions on 
configuring the keys to other applications, view WIDEsystem TOOLS Help 
 
 
How it looks on scanner… 
 

What it means…. 
 

 

Email Application  
 
This key is for activating an application that scans and prepares 
images for sending via E-mail from the scanner. 

 

Scan Application  
 
This key is for activating the scanning application installed on your 
PC so as to trigger a scan of the document currently loaded in the 
scanner. 
 

 

 

Copy Application  
 
This key is for activating a scan-to-copy application installed on your 
PC.   

 
 
 
NOTE: The applications you wish to use with the buttons must be designed to recognize your 
scanner device and the signals sent from its buttons so that when a button is pressed, a scan is 
initiated and the result is loaded into the application triggered. Any application you assign to a 
button must be specially programmed in order to work in this manner. Check your application’s 
documentation to verify its functionality with your scanner’s one-touch-scan buttons. 
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4.4 Media Control from the Panel 
 
For both thin and thick media, the Paper Ready LED lights up when the media is inserted into 
the original’s insertion slot and correctly positioned for feeding on a straight path. The media 
can then be moved into the start-scan position by pressing the Paper Forward Key or through 
automatic loading. The Paper Ready LED will blink during scanning. 
 
Media Control  
 

On Scanners:     
 

How it looks on scanner… What it means…. 

 

Paper Forward and Paper Reverse Keys 
 
The Paper Forward Key moves the drawing into the start-scan position 
for manual loading (see section on Loading).  
If Auto-Load  is applied, loading will occur automatically (without 
pressing the key) when the original enters the insertion slot.   
Pressing the Paper Forward Key during scanning will stop the scanning 
process and feed the original through the scanner while the key is held 
down. 
The Paper Reverse Key stops the current scanning process and 
reverses the original. The original will be fed backwards through the 
scanner while the key is held down. 

 

 

Paper Ready LED Green - Ready for Normal media 
 
The Paper Ready LED lights green when normal thin media is 
positioned correctly in the insertion slot and stays green when the media 
is moved to the start-scan position. 
From there, scanning can be controlled from the computer. 
 
 

 

 

Paper Ready LED Yellow - Ready for Thick media 
 
The Paper Ready LED lights yellow when thick media is positioned 
correctly in the adjusted insertion slot and stays yellow when the media 
is moved to the start-scan position. 
From there, scanning can be controlled from the computer. 
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Paper Ready LED Blinks – (green or yellow) – Media is being 
scanned  
 
The Paper Ready LED blinks during scanning.  
On completion of the scan, the Paper Ready LED will stop blinking. 
Scanning can then be repeated from the computer or terminated by 
ejecting the media from the scanner. 
The above behavior applies for both thin media scanning (green 
blinking) and thick media scanning (yellow blinking). 
 
 

 

 

Paper Ready LED Red – No Thick media detected 
 
The paper ready indicator will light red if the pressure-platen is in a thick 
media setting (a raised pressure-platen) but the scanner does not detect 
the media.  
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Media Control  

On Scanners:    

Scanners with the Automatic Thickness Adjustment Control (ATAC) key  
 
These scanner models support Automatic Thickness Adjustment Control for easy adjustment of the 
pressure-platen level for scanning thick media.  Thick media scanning will be described in detail later in this 
manual. 
 
For both thin and thick media, the Paper Ready LED lights up when the media is inserted into the original’s 
insertion slot and correctly positioned. The media can then be moved into the start-scan position by 
pressing the Paper Forward Key or through automatic loading. The Paper Ready LED will blink during 
scanning. 

 
How it looks on scanner… 
 

What it means…. 
 

 

Paper Forward and Paper Reverse Keys 
 
The Paper Forward Key moves the drawing into the start-scan 
position for manual loading (see section on Loading).  
If Auto-Load  is applied, loading will occur automatically (without 
pressing the key) when the original enters the insertion slot.   
Pressing the Paper Forward Key during scanning will stop the 
scanning process and feed the original through the scanner while 
the key is held down. 
The Paper Reverse Key stops the current scanning process and 
reverses the original. The original will be fed backwards through 
the scanner while the key is held down. 
When the scanner is in Automatic Thickness Adjustment Control 
(ATAC) mode the paper forward and paper reverse keys become 
“pressure-platen up” and “pressure-platen Down” keys (see below).  

 

Paper Ready LED Green - Ready for Normal media 
 
The Paper Ready LED lights green when normal thin media is 
positioned correctly in the insertion slot and stays green when the 
media is moved to the start-scan position. 
From there, scanning can be controlled from the computer. 
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Paper Ready LED Flashes Yellow – Scanner in ATAC mode 
 

ATAC key    
When you press the ATAC key, you set the scanner in ATAC 
mode. The Paper Ready Key flashes yellow to indicate ATAC 
mode.  
 
The Paper Forward and Paper Reverse keys become “Pressure-
platen Up” and “Pressure-platen Down” keys.  
 

 Paper Forward and Paper reverse Keys become Up/Down keys
 

 

Paper Ready LED Yellow - Ready for Thick media 
 
The Paper Ready LED lights yellow when the scanner is ready to 
scan thick media. The pressure-platen has been lowered and the 
media is positioned correctly in the scanner. 
The scanner goes automatically out of ATAC mode. The Paper 
Forward and Paper Reverse keys resume their normal functionality 
so you can move the thick original forwards and backwards in the 
scanner. 
Scanning can be controlled from the computer. 
 

 

Paper Ready LED Flashes – (green or yellow) – Media is being 
scanned  
 
The Paper Ready LED blinks during scanning.  
On completion of the scan, the Paper Ready LED will stop blinking. 
Scanning can then be repeated from the computer or terminated 
by ejecting the media from the scanner. 
The above behavior applies for both thin media scanning (green 
blinking) and thick media scanning (yellow blinking). 
 
 

 

Paper Ready LED Red – No Thick media detected 
 
The paper ready indicator will light red if the pressure-platen is in a 
thick media setting (a raised pressure-platen) but no media is 
detected in the scanner.  
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4.5 Setting the Scanner in Firmware BOOT Mode  

On All Scanners         
 
You can force the scanner to firmware boot mode. This is useful if an error or power-failure 
occurred during a firmware update and you need to restart the firmware update process. A 
scanner will not run correctly after an interrupted firmware update process.  
 
To force the scanner to firmware boot mode:  

1. If restarting after a power-failure interrupted your firmware update, the scanner should 
start up in boot mode. If not, you can use the following panel function to force the 
scanner into boot mode.  

2. Turn the scanner power off with the outlet switch at the back – Hard Power Off.  

 
3. Press and hold down the Power key on the operator’s panel.  

4. As you hold down the power key, reach to its back and Hard Power On the scanner by 
flipping on the outlet switch at the back of the scanner.  

Invoke Firmware Boot Mode - Press and hold 
down the Power Key as you Hard Power On. 

 
5. When the Power LED turns red and the other LEDs flash as shown below, the scanner 

is in Firmware Boot mode and you can reapply the Firmware. 
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4.6 Automatic Power functions 

On All Scanners         
 
You can set the scanner for automatic power OFF (power down) and power ON. Automatic 
power functionality is set and controlled through the WIDEsystem software. There are two 
automatic power functions - the Timer function and the Automatic power down (after Idle 
time) setting. Automatic power functionality lets you schedule your scanner’s up-time optimally 
and helps save energy. The power down mode, on ENERGY STAR®  compliant scanners, 
meets the low values of ENERGY STAR®  criteria. 

In order to use automatic power functionality: the scanner must be Hard Powered ON – i.e 
the switch at the scanner’s back must always be ON.  

 
 
With the scanner Hard Powered On, the scanner can be brought into Soft Power ON and Soft 
Power Off manually - by pressing the panel’s power button or by using the automatic power 
functions – Timer and Idle time. The power LED on the operator’s panel will light red when 
the scanner is powered OFF and green when powered ON. 

Power OFF 
 

Power ON
 

 

4.7 Energy Star® 

On Scanners:  

 

ENERGY STAR® is a program helping businesses and individuals protect the environment 
through superior energy efficiency. ENERGY STAR® qualified scanners automatically enter a 
low-power "sleep" mode after a period of inactivity. Spending a large portion of time in low-
power mode not only saves energy but helps scanner equipment run cooler and last longer.  
These scanners support an Automatic Power Down after Idle time functionality in addition to the 
Timer function described in the next section.  
Both automatic power down functions (Timer and Idle Time), on ENERGY STAR® compliant 
scanners, reach the low power values that meet ENERGY STAR® criteria. 
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4.8 Timer Function - Automatic Power ON/OFF 

On All Scanners         
 

To best explain usage of the Timer automatic power function, please look at the following 
example: 
 
Your business opens a bit later on Mondays then on other days, so you want the scanner to 
power on at 07:30 so that by the time you reach work at 08:00, the scanner will be warmed up 
and ready to run at an optimal internal temperature. On Tuesday you need to process a heavy 
copy order and anticipate a long day. You therefore set the scanner to shut down much later 
than usual. On Wednesdays, you are always attending meetings and won’t need the scanner 
until after lunch. Thursday and Friday are normal workdays and the shop is closed during the 
weekend.    
You can program this whole weekly schedule into the scanner and rid yourself of worries about 
getting early to work in order to warm up your equipment. Nor do you have to worry about 
remembering to shut off the device before going home to save energy. Once you fill out the 
timer values in WIDEsystem’s Timer tab, the scanner takes care of these things itself. 
To use the Timer function: 

1. Double-click on the scanner icon in the system tray to display the WIDEsystem interface. 
2. Select the Timer Tab. 
3. Click the checkmark fields for each day you want automatic power-on and power-off.     
4. Click the 2-digit hour field in the On column to highlight it. Use the arrow box to increase or 

decrease the hour value.   
5. Click the 2-digit minute field in the Wake-up column to highlight it. Use the arrow box to 

increase or decrease the minute value. 
6. Repeat this process in the Power down column for the same week-day. 
7. Continue making settings for the other week-days in the same manner or…. 
8. You can use the Link Monday to Friday option to make your settings for Monday apply for 

the whole work-day-week. 
9. Note that the Idle time setting (Automatic power down) will still apply and may conflict with 

your Timer settings. Change the Automatic Power down – Idle time setting if it does.  
10. When you have filled out the dialog, press Apply to download your settings into the 

scanner’s memory. 
 
After making your Timer settings: 
 
1. Your scanner will remember your settings even after you turn off your PC and thereby 

shutdown the WIDEsystem application. The settings displayed in the WIDEsystem Timer 
tab are retrieved from the scanner every time you start WIDEsystem. This means that the 
Timer tab always displays the values currently stored in the scanner. 

2. When WIDEsystem runs, it checks that the scanner’s clock is within 2 minutes from the PC 
clock. If not, WIDEsystem will synchronize clocks. Normally this only happens when the 
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scanner’s central power switch has been turned OFF manually and its clock needs to be 
reset. 

3. If the scanner is in use then the scanner will delay power down. Just before automatic 
power down with the timer occurs, the power LED on the panel will flash. You can cancel 
power down by pressing the power button. 

4. Note that the Idle time setting (Automatic power down) will still apply and may conflict with 
your Timer settings. Change the Automatic Power down – Idle time setting if it does.  

 

4.9 Automatic Power Down – After Idle Time  

On Scanners:  

These scanners support an Automatic Power Down after Idle time functionality in addition to the 
Timer function described in the previous section. The Automatic Power Down after Idle time 
functionality is an ENERGY STAR®  compliant feature.  

NOTE: On delivery, your scanner was set to comply with the ENERGY STAR® environmental 
guidelines with entry into power down mode after being idle for 15 minutes. When you start the 
scanner the first time, you are offered the option to change this. If you chose to keep the default 
settings at that opportunity, you can at any later time change the settings by following the 
instructions below: 

To change the Automatic Power down – Idle Time…: 

1. Double-click on the scanner icon in the system tray to display the WIDEsystem interface. 

2. Select the Timer Tab. 

3. Select or Deselect the Automatic power down option in the Timer tab dialog. 

4. If you selected the option, use the arrows to select the Idle time value – the number of 
minutes the scanner can stand idle before powering down on its own.  

5. Press Apply to download your settings into the scanner’s memory. 
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5. Loading Originals into the Scanner 

5.1 Center-loading and Side-loading 

On Scanners      
 
These scanners support both Center-loading and Side-loading. The default method is Center-
loading. The loading method can be selected in the scanning application. Center-loading is 
preferable to Side-loading, as the original will be positioned symmetrically on the feed rollers 
resulting in an optimal grip and straight scan path. Side-loading is for large irregular sized 
originals that you want to measure using the ruler above the insertion slot (see section on Size 
Setting below). All other scanners support center loading only and the loading method is not 
optional. 

5.2 Manual-loading and Auto-loading 

On All Scanners       
 
You can use manual loading or automatic loading. The loading options are selected in the 
scanning application.  

With manual loading you determine when the scanner pulls in the original:   
1. Position the original in center or side according to your setting. 
2. Push the original into the insertion slot until you feel it contact the rollers. 
3. The Paper Ready LED lights green (yellow for thick media) when the original is 

positioned correctly for a straight scan path. 
4. While holding the original in place with one hand, use the other hand to press and hold 

down the Paper Forward button on the scanner. 
5. The original moves into the start-scan position. 

With automatic loading, the scanner takes the original as soon as you insert it in the paper 
slot. Automatic loading is reliable for most jobs and especially useful for batch scanning jobs. 

1. Position the original in center or side according to your setting. 
2. Push the original into the insertion slot until you feel it contact the rollers. 
3. The Paper Ready LED lights green (yellow for thick media) when the original is 

positioned correctly for a straight scan path. 
4. The scanner will grab the original automatically and move it into start-scan position.  
5. A delay factor can be set in the scanning application. The delay will give you time to 

control straight positioning if the scanner is grabbing the original too fast. 
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5.3 Fast-loading  
Fast-loading is a time-saving loading option designed for batch scanning. The fast-loading 
option can be selected in the scanning application.  

What is Fast-loading? – With normal (default) loading, i.e. without the Fast-load option 
selected, the original is pulled all the way into the drive system, past both roller axles, and then 
reversed to start-scan position in order to ensure precise detection of the original’s placement in 
the scanner. With the Fast-load option selected, the original is pulled only under the first roller 
axle and scanning will start from there. The Fast-load option is convenient for batch scanning of 
originals with robust edges that feed easily. Normally, with batch scanning, you would use the 
Fast-load option in conjunction with automatic loading however you can also use manual 
loading to feed the original into start-scan position.  

5.4 Soft-handling 
Your device is designed to scan at very high speeds for maximum efficiency. However, some 
old, curled or creased originals can trigger a paper jam when fed and scanned at high speeds. 
You may also have a fragile original that you want passed delicately through the drive system.  
The Soft-handling option can be selected in the scanning application. With the Soft-handling 
option selected, both feeding and scanning are slowed down to enable smooth scanning of 
curled, creased, frayed or fragile originals. You can use the option with Manual, Auto or Fast 
loading.  

Use this option when: 

You received a Paper Jam error  
1. A Paper jam error has occurred when the scanner stops scanning and the Paper-

Ready key shuts OFF (from blinking) while the original is still engaged in the drive 
system. Your scanning application and WIDEsystem’s Status tab will report the Paper 
Jam error.   

2. Remove the original from the scanner. Use the Paper-Back or Paper-Forward keys. If 
the original does not respond, remove the pressure-platen as described under the 
section Maintenance – Cleaning and take the original out of the scanning area. 

3. Select the Soft-handling option.  
4. Feed the document again to scan. 

You have a fragile original  
1. Select the Soft-handling option.  
2. Feed the original normally. 
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5.5 Loading Fragile Originals 

On Scanners:   
On these scanners, gentle-feed control lets you protect very fragile documents by manually 
engaging the document into the drive system without feeding its edges into the rollers.  

1. Raise the scanning area lid. 
2. The rollers will lift and open the drive pinch.  
3. Position your fragile document with the top edge past the backmost rollers. 
4. Close the scanning area lid. The document will then be safely engaged in the drive 

system. 

 
Loading fragile originals: 
 

On All Scanners       
 
Through your scanning application, you can set the scanner to feed and scan at a slower 
speed. See the previous section describing the Soft-handling option. 

5.6 Pressure Weights – fine-adjusting for optimal pressure  

On Scanners:   
 
On these scanners you can fine-adjust the pressure-platen’s pressure on the original. You can 
add or remove one or more of the pressure-platen’s loose pressure-weight-strips to give the 
specific original optimal contact with the glass-plate. This is useful when scanning originals that 
are either stiff or fragile.  
 
To apply/remove weights: 

1. Open the scanning area lid. 
2. The pressure-weight-strips rest on the white pressure-platen.  
3. To stabilize the weights on the pressure-platen, fit the holes in the pressure-weight-

strips into the pins on top of the platen.  
4. Normal weight for most original types is applied with 2 pressure-weight-strips. 
5. Remove 1 or both pressure-weight-strips for thin fragile originals. 
6. Add 1 or 2 additional pressure-weight-strips for stiff originals. 
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 Weight strips rest on the top of the pressure platen.

 

5.7 Size Settings   

On All Scanners        
 
Common standard sizes are marked on the scanner topside. Use these markings to guide you 
when positioning standard sized originals in the center of the scanner. Enter the size in your 
application’s media size setup dialogs 
 

On Scanners      
 
For irregular sizes with these scanners, you can use Side-loading and the scanner’s 
measurement ruler just above the insertion slot. The width setting for an original can thereby be 
measured with the original inserted into the scanner. Read the width and enter your 
measurement in the width setting box in your application’s media size setup dialogs. 
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6. Scanning Thick Media 
Many industries, such as reprographics and GIS, will find the need to digitize or copy images 
printed or pasted on thick media such as cardboard, foamboards, gatorboards etc. To support 
such needs you can change the vertical size of the insertion slot (pressure-platen height) on 
your scanner to fit the slot to the thickness of your original. Depending on your scanner model, 
adjusting the pressure-platen’s height is either a manual or automatic process.  

6.1 Adjustment for Thick Media – Slider Controls 

On Scanners:       
 
You can manually change the insertion slot size (pressure-platen height) on your scanner from 
2mm to 15mm (up to 0.6”) so you can fit the slot to the thickness of your original. Originals up to 
2mm thick should be scanned with the Normal (2mm) setting. Thicker originals will require 
adjustment for thick media.  

Adjusting the insertion slot for thick media  – Normal Method – For all original types: 
1. Measure the thickness of your original to find the right setting. 
2. Insert your fingers in the insertion slot and lift to open the scanning area lid. 
3. The thickness adjustment sliders are on right and left sides of the pressure-platen. 
4. The slider is divided into a Normal position and Extended positions. 
5. The Extended settings are marked in inches and millimeters. Each step marks an 

interval, i.e., the 4 setting means documents from 2mm to 4mm etcetera.    
6. The round metal button indicates the current setting (see illustration below). For paper 

thin originals this will be on the 2mm (0.08”) setting – also called the “Normal” setting. 
7. Press down on the right slider and move inwards (towards middle of scanner) to the 

correct thickness setting. 
8. Press down on the left slider and move to the same thickness setting as above. 
9. Close the scanning area lid. 
10. Feed your thick original. The Paper Ready key will turn yellow (stop blinking) when the 

pressure-platen is positioned correctly and is ready to scan your thick original. 

Quick method –for stiff and thick originals only: 
You can use the following Quick method for stiff and hard surface originals. This method is not 
recommended for soft or flexible media such as originals mounted on foam boards, as there is a 
high risk for creating an over-tight insertion slot and causing damage to the original.  

1. Insert your fingers in the insertion slot and lift to open the scanning area lid. 
2. The thickness adjustment sliders are on right and left sides of the pressure-platen. 
3. Press down on the right slider and move inwards (towards middle of scanner) to the 

highest setting, the 16mm (0.63”) mark thickness setting. Repeat with the left slider. 
4. Slide the original into the insertion slot and under the pressure-platen. 
5. With both hands, press down gently on each side of the pressure-platen until you feel it 

contacts the original underneath and the sliders adjust themselves to the proper height.   
6. Be sure to control that both sliders (on each side) are set to the same thickness value. If 

not, adjust the sliders so they are. 
7. The Paper Ready key will turn yellow (stop blinking) when the pressure-platen is 

positioned correctly and is ready for thick media scanning. 
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Thickness Adjustments Sliders – Normal Method for all original types: 
 

1. The sliders are on each side of the scanner. 
2. Place both hands on a slider, push down and move the slider towards the scanner’s middle  while maintaining 

pressure. 
3. Move to the correct thickness setting.  
4. Be sure to set the sliders to the same setting on each side of  the scanner. 

 
 Thickness Adjustment 

Slider 
 
In this example, the 
button position shows the 
slider set for an original 
that is 6mm. (0.24”) thick. 

 
 
 

 
 



Scanning Thick Media   6-3 

6.2 Adjustment for Thick Media – Lever Controls 

On Scanners:   
 
On this scanner model you can adjust the insertion slot size (guide plate height) from 3 to 12 
mm (up to 0.47”) using adjustment levers at each side of the scanner. Originals up to 3mm thick 
should be scanned with the 3mm (lowest) lever setting. Thicker originals will require you adjust 
the lever settings for thick media.  
 
Adjusting the insertion slot for thick media  - lever controls 
 

1.  Raise the scanning area lid.  

2. The thickness adjustment levers are found on the scanner’s right and left sides. 
3. Measure the thickness of your original to find the right setting.  
4. The lever’s numbered settings represent millimeters. 
5. Be sure to set to the same thickness value on both sides. 
6. For stiff originals, apply pressure-weight-strips if necessary. See the section on Loading 

for instructions. 
7. Close the scanning area lid. 
8. Feed your thick original The Paper Ready key will turn yellow (stop blinking) when the 

pressure-platen is positioned correctly and is ready to scan your thick original. 
 

 Thickness Adjustment Lever – (Right Side) 
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6.3 Automatic Thickness Adjustment Control 

On Scanners:    
 
Scanners supporting Automatic Thickness Adjustment Control (ATAC) have an ATAC key on 
the operator’s panel. You use the key to raise and lower the pressure-platen. You can change 
the insertion slot size (pressure-platen height) on your scanner from 2mm to 15 mm (up to 0.6”). 
Originals up to 2mm thick should be scanned with the pressure all the way down (normal 
position). Thicker originals will require you use the ATAC key to adjust for thick media.  

The ATAC key is on the operator panel. 
 
 
Adjusting the insertion slot for thick media with ATAC: 
 

1. Press the ATAC key on your operator’s panel to set the scanner in ATAC mode. 
2. The Paper Ready Indicator blinks yellow indicating the scanner is in ATAC mode but 

not yet ready, i.e., the pressure-platen is not yet positioned on the thick original. 
3. Press and hold the Paper Forward key (arrow up) key to raise the pressure-platen until 

there is room to insert the thick original. 
4. Insert the thick original evenly for a straight scan path. 
5. Press and hold the Paper Reverse (arrow down) key to lower the pressure-platen until 

the pressure-platen stops on its own. 
6. The Paper Ready indicator will turn yellow (stop blinking) when the pressure-platen is 

positioned correctly and is ready for thick media scanning. 
7. The scanner will automatically leave the ATAC mode, which means that the Paper 

Forward and Paper Reverse keys will return to their normal functionality for moving the 
original forwards and backwards. 

 
 Press the ATAC key on your operator’s 

panel to set the scanner in ATAC mode. 
Pressure Platen in UP position - Press and hold the Paper
Forward key (arrow up) key to raise the pressure-platen.  
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6.4 When Scanning in Thick Media Positions 

On All Scanners         
 
For Auto-adjustment – return to the Normal position. 
The scanner employs an automatic self-adjustment procedure (light profile, stitching etc.) that 
can only auto-activate when the scanner is in the Normal position. With prolonged scanning in 
extended thickness settings, you should from time to time return the scanner to its Normal 
position to allow it to self-adjust. This will ensure refreshed self-adjustment and optimal 
performance of your scanner. Make a habit of always setting the scanner in the Normal position 
when shutting down, so it can auto-adjust the next time you turn it ON 
 
NOTE:The scanner runs at its optimal speed in the Normal position. To allow stable drive 
handling, scanning speed is automatically reduced when the scanner is in the extended 
thickness positions.  
 
Modifying Stitching Parameters 
Thick stiff originals will rest on top of the scanner rollers and thus raise a small distance over the 
glass-plate. This can lead to irregularities in the stitching of images at points between the 
cameras (overlapping pixels). In such cases, the stitching parameters will need to be modified. 
You can modify stitching parameters through your scanning application.  

1. Insert your thick original in the scanner and scan the image using your scanning 
application. 

2. Check the result in the viewer for overlapping or missing pixels in the camera transition 
areas.  

3. Adjust the stitching values in the application’s scanner setup dialogs.  
4. Repeat scanning and adjustment until the effect is minimized. 

  
Treating Edge Distortion  
Scanning thick originals can give distortions when the front edge meets the exit rollers or the 
trailing edge leaves the entry rollers. To omit this, the leading and trailing edges are by default 
skipped when in an extended thickness position. 
Leading/trailing edge skipping can be turned off through the scanning application’s setup 
dialogs. 
 
Supporting Thick Originals 
Center-loading is the best method for loading thick originals. Its also important to help support 
the original during scanning - both at the entrance side and the exit side of the scanner. 
Specially designed support tables can be attached to the back of the scanner. Such a table is 
recommended for high volume thick media scanning. Ask your local dealer for purchase 
information. 
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7. Maintenance 

7.1 Regular Scanner Maintenance 
Regular scanner maintenance is a sure way to minimize costly downtime. The three routine 
maintenance procedures cleaning, camera alignment and calibration will improve image 
quality and reduce your service costs.  
 
The three maintenance functions are closely entwined and they should all be performed in a 
single maintenance session, starting with cleaning the scan area and ending with calibration. 
The reason for this is simple. If you clean the glass or adjust the cameras then you will have 
changed conditions in the scanning area and will need to calibrate in order to readjust black, 
white and color interpretation. This works the other way as well – scanner calibration must 
always be preceded by cleaning and camera alignment to get reliable calibration results.  
 
Scanner Maintenance is very easy to perform and most of it is completely automatic.  After 
manually cleaning the scan area, you just insert a Calibration Sheet, start the Scanner 
Maintenance program and let the wizard take over as it performs camera alignment and 
calibration.  
 
The tools for scanner maintenance were supplied with your scanner - including the program that 
will check your scanner and guide you through the maintenance steps. Be sure to install the 
Scanner Maintenance program from the WIDEsystem TOOLS CD-ROM. For best results, run 
the maintenance procedures right after setting up your scanner for the first time.  
 

7.2 Cleaning the Scan Area 
A clean scan area is vital for optimal results.  
 
In order to access the scan area for cleaning or other maintenance purposes, you have to free 
the pressure-platen. On some scanner models, the pressure-platen is completely detached 
from the scanner. On scanners with Automatic Thickness Adjustment Control (ATAC), the 
pressure-platen is fixed inside the scanning area lid and you just have to open it. Cleaning 
instructions for each scanner type follow below: 
 

 Caution: do not use abrasives, acetone, benzene or fluids that contain these chemicals. 
Do not spray liquids directly onto the scanner glass-plate or anywhere else in the scanner. 
 

 Caution: Before cleaning the scan area, be sure to turn the scanner power off and 
disconnect the power plug. 

 
NOTE: be sure to also clean the scanner’s flat surface so dirt and dust are not dragged into the 
scan area with the original. 
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Cleaning the Scan Area  

On Scanners:       
 

1. Turn the scanner power off and disconnect the power plug.  
2. Place your fingers in the insertion slot and flip open the scanning area lid. 
3. Press down on the extended media thickness adjustment slider on the right side of the 

pressure-platen. 
4. While maintaining pressure, slide the right extended media thickness adjustment slider 

towards the middle of the pressure-platen (see illustration below). 
5. Push the slider all the way until the metal safety button under the slider pops up (see 

illustration below). 
6. Repeat the process on the left side.  
7. Make sure the platen is completely free. 
8. On the topside of the pressure-platen are one or two hinged handles. Flip up the 

handles and use them to lift out the pressure-platen (see illustration below). 
9. The glass-plate is now exposed for cleaning. Clean the glass with a lint-free cloth and a 

mild, streak-free, glass cleaner. Dry the glass completely using a separate clean, dry 
lint-free cloth like the one provided with the maintenance kit. 

10. The white-background-platen is on the backside of the pressure-platen you just 
removed. Flip the pressure-platen over to clean the white background.  

11. Wipe the white area and the transport rollers with a lint-free cloth and a mild, streak-
free, glass cleaner. Apply the cleaner to the cloth and first wipe the platen’s white area 
and then the transport roller’s surface.  

12. Dry the pressure-platen and rollers completely using separate clean, dry lint-free cloths. 
13. Reverse the above procedure to reinsert the pressure-platen. On each end, you will 

need to press down the metal button before you can move the slider back from the Exit 
position. 

14. Clean also the scanner surface so dirt and dust are not dragged into the scan area with 
the original. 

15. Cover your scanner with the plastic dust cover when not in use.  

 Caution: Make sure the scanner power is OFF when using the scanner dust cover. 
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Cleaning – To access the scan area - Move the sliders to the exit position and free the pressure-platen 
 

1. The extended media thickness adjustment sliders are on each side of the scanner. 
2. Place both hands on a slider - push down and move the slider all the way towards the scanner’s middle 

while maintaining pressure until the metal button pops up. 
3. Repeat this on both left and right side sliders to free the pressure-platen. 

The metal button 
pops up when the 
slider is in the Exit 
position. 

Exit position :  
The slider is pushed all 
the way towards the 
scanner’s middle.  
 

The metal button pops up.

 
Flip up the handles and use them to lift out the pressure-
platen.  Clean the exposed glass and the white-
background-platen on the backside of the    
pressure-platen.  
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Cleaning the Scan Area  

On Scanners:   

1. Turn the scanner power off and disconnect the power plug.  
2. Place your fingers in the insertion slot and flip open the scanning area lid. 
3. The drive system automatically lifts up. 
4. Grasp the white pressure-platen on its back edge braces. Tip up the back edge of the 

pressure-platen and lift it out to expose the glass-plate underneath.  
5. Clean the glass with a lint-free cloth and a mild, streak-free, glass cleaner. Dry the 

glass completely using a separate clean, dry lint-free cloth like the one provided with 
the maintenance kit. 

6. On this scanner, the pressure-platen’s backside also serves as the white background. 
Wipe the white backside of the pressure-platen and the transport rollers with a lint-free 
cloth and a mild, streak-free, cleaner.  

7. Dry the pressure-platen and rollers completely using separate clean, dry lint-free cloths. 
8. Reinsert the pressure-platen. First place the pressure-platens front braces so they rest 

on the front drive axle. 
9. Tip the platen backwards until the pressure-platen’s back braces rest on the backmost 

drive axle. 
10. Close the scanning area lid. 
11. Clean also the scanner surface so dirt and dust are not dragged into the scan area with 

the original. 
12. Cover your scanner with the plastic dust cover when not in use.  

 Caution: Make sure the scanner power is OFF when using the scanner dust cover. 
 

To remove the pressure-platen 
Grasp by the braces on the pressure-platen’s backside
edge.   

 
Flip up the back edge and lift out the pressure-platen. 
When you reinsert the pressure-platen: position so 
the braces rest on the parallel drive axels.  

 
Drive Axles  

Cleaning – To access the scan area – remove the pressure-platen 
 

 
Front brace.   

 
Back brace.  
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Cleaning the Scan Area  

On Scanners     
 

1. Turn the scanner power off and disconnect the power plug.  
2. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid. 
3. The scanning area lid locking mechanism should now be disengaged. 
4. As you hold both lever buttons down, place your free fingers in the insertion slot and flip 

the scanning area lid open. 
5. The glass-plate is now exposed for cleaning. 
6. Clean the glass with a lint-free cloth and a mild, streak-free, glass cleaner. Dry the 

glass completely using a separate clean, dry lint-free cloth like the one provided with 
the maintenance kit. 

7. The pressure-platen with the white-background-platen (white metal area) is fixed in the 
scanning area lid. Hold the lid open as you clean.  

8. Wipe the white area and the transport rollers with a lint-free cloth and a mild, streak-
free, glass cleaner. Apply the cleaner to the cloth and first wipe the platen’s white area 
and then the transport roller’s surface.  

9. Dry the platen and rollers completely using separate clean, dry lint-free cloths. 
10. Close the scanning area lid when finished. The locks will reengage.  
11. Clean also the scanner surface so dirt and dust are not dragged into the scan area with 

the original. 
12. Cover your scanner with the plastic dust cover when not in use.  

 Caution: Make sure the scanner power is OFF when using the scanner dust cover. 
 
  Push down lever (on both sides) to 
unlock scanning area lid. 

While holding down the levers, insert fingers in the slot and flip
the lid open to access the glass-plate and white-background- 
platen.  

Glass-plate 

White-
background-
platen 
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7.3 Running the Scanner Maintenance Program 

On All Scanners       
 
For optimal results, you should always run the Scanner Maintenance program after 
cleaning.  
 

1. Make sure that the scanner has been turned on for at least one hour prior to camera 
alignment and calibration. Slight light intensity changes and camera shifting can occur 
just after turning the scanner on and the warm-up time will ensure that light conditions 
and camera heights have stabilized. 

 
2. On your PC, Select Programs > Scanner Maintenance to start the Scanner 

Maintenance Wizard. 
3. The wizard will guide you through the maintenance steps - Camera Alignment, Stitching 

and Calibration. Click the Next button in the welcome dialog to proceed. 
4. The wizard will ask you to insert the Calibration Sheet that came with your scanner. The 

sheet’s printed side must be inserted face down. Align the midpoint arrow with the 
scanner’s midpoint arrow and feed the sheet into the scanner. Click Next to continue. 

Inserting the Maintenance Sheet 
 
Align the midpoint arrow  with the scanner’s midpoint 
mark and feed the sheet into the scanner. 

 
5. The program immediately analyses alignment and stitching status of the cameras. If 

the cameras are unaligned, the program and scanner will automatically make the 
necessary corrections. This step will be bypassed on single camera scanner models. 

6. After Camera Alignment, the Scanner Maintenance program automatically moves on to 
Basic Calibration. Basic Calibration sets black/white values and ensures stable and 
clean scans by reducing noise and unwanted effects caused by dust particles. 

7. On color scanners, the program automatically proceeds to Color Calibration. Color 
Calibration uses the ANSI IT8 standards to ensure stable and predictable colors every 
time. 

8. Calibration completes the maintenance process. Remove the Scanner Calibration 
Sheet from the scanner.  

9. Return the Scanner Calibration Sheet to its protective cover and then place it in the 
storage folder. Store the folder in a dry place and out of direct light. 
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7.4 Replacing Scanner Parts 
This section describes how to replace those scanner parts that are liable to wear down over 
long-term use. Changing parts will renew your scanner and ensure optimal results. 
WIDEsystem monitors scanner usage and will warn you when it is time for a replacement.  
 
NOTE:  For glass plate and White background platen replacement: After receiving a warning by 
WIDEsystem and replacing the part, be sure to reset the part replacement warning flag though 
WIDEsystem’s “Status” tab.  
 
Some scanner models are designed so users can replace parts on their own (user-replaceable 
parts) while other scanner models will require a service technician. The instructions in this 
section apply only for scanners with user-replaceable parts.   
 

Scanner Type Parts that are User-Replaceable 

 

 

No parts user-replaceable  - Contact your service technician for 
replacing parts. 

 

No parts user-replaceable  - Contact your service technician for 
replacing parts. 

 

Glass-plate, White-background-platen, Lamp 
 

 

Glass-plate, White-background-platen, Lamp, Dust filters 
 

 

Glass-plate. 
 

 
 Important Safety Instruction: Before replacing any user-replaceable parts, be sure to turn 

the scanner power off and disconnect the power plug. 
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7.4.1 Replacing the Glass-plate  
Some scanner models are designed so users can detach the glass-plate from the scanner in 
order to replace scratched glass-plates with new ones. On other scanner models, a service 
technician must perform this process. See your scanner’s model specifications to see if the 
glass-plate is detachable.  
Replacing the Glass-plate: 

On Scanners:   

1. Turn the scanner power off and disconnect the power plug.  
2. Place your fingers in the insertion slot and flip open the scanning area lid. 
3. The drive system automatically lifts up. 
4. Lift out the pressure-platen to expose the glass-plate underneath.  
5. On the right side of the glass-plate there is a small round finger-handle.  
6. Place your finger under the finger-handle and lift the glass-plate’s right side upwards. 
7. As soon as there is space under the glass-plate, use your free hand to grip under the 

glass-plate and carefully lift it out of the scanner. 
8. Reverse the process to reinsert a new glass-plate. Position the right side of the new 

glass-plate in the scanner and let down the right side using the round finger-handle. 
9. Reinsert the pressure-platen so its braces rest on the parallel drive axles. 
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NOTE: Make sure you clean a new glass-plate before using it with the scanner. 
NOTE:  Be sure to reset the part replacement warning flag though WIDEsystem’s “Status” tab. 
 
 
 
 

To Remove the glass-plate 
Step 1: Open lid and tip up the pressure-platen. 
 

 
Step 2: Remove  the pressure-platen. 
 

Step 3: Locate the small round finger handle on the right 
side. 
 

Step 4: With your finger on the round handle, lift the 
glass-plate up and grasp under it with your free hand.   
 

Finger-handle
Finger-handle 

 
Replacing the Glass-plate:  

On Scanners:    
 

1. Turn the scanner power off and disconnect the power plug.  
2. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid. 
3. The scanning area lid locking mechanism should now be disengaged. 
4. As you hold both lever buttons down, place your free fingers in the insertion slot and flip 

the scanning area lid open. 
5. The glass-plate will be exposed and accessible. 
6. On each side of the glass-plate there is a small lever and round finger-handle (see 

illustration below). Place your thumbs under both handles on each side. 
7. With both arms, pull simultaneously on the left and right levers to flip the glass-plate 

towards your body. 
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8. Each lever is attached to the scanner chassis with a small hook that rests on a pin. 
Simultaneously lift both levers upwards to detach their hooks for the pins and free the 
glass-plate from the scanner.  

9. To reinsert a new glass-plate – Fit the new glass-plate’s lever hooks on the pins on 
each side of the scanner. 

10. While supporting the glass-plate with your thumbs on the finger handles, carefully push 
the glass-plate backwards (away from your body) and ease it down into place.  

11. Close the scanning area lid. 
 
NOTE: Make sure you clean a new glass-plate before using it with the scanner. 
NOTE:  Be sure to reset the part replacement warning flag though WIDEsystem’s “Status” tab. 
 
 Remove the glass-plate: 
 
Step 1: Open the lid. Locate the lever’s finger handle on 
each side. Shown below: Right side finger-handle. 

 
 
Step 2: Flip back. Lift the lever’s hooks and glass-plate 
free of the scanner.                   

Hook    

Finger handle      
Finger handle      

 

7.4.2 Replacing the White-Background-Platen 
Some scanner models are designed so users can replace the white-background-platen. On 
other models, a service technician must perform this process. See your scanner’s model 
specifications to see if the white background is user-replaceable on your scanner.  
A white-background-platen can become worn and discolored after long periods of use and 
replacement with a fresh white-background-platen is recommended. WIDEsystem monitors 
scanner usage and will warn you when it is time for a replacement.  
 
Replacing the White-background-platen: 

On Scanners:  
 
On these scanner models, the pressure-platen itself functions also as the white-background-
platen. Replacing the white-background-platen means replacing the scanner’s (white) pressure-
platen.  
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1. Turn the scanner power off and disconnect the power plug.  
2. Place your fingers in the insertion slot and flip open the scanning area lid. 
3. The drive system automatically lifts up. 
4. Grasp the white pressure-platen on its braces – back edge. Tip up the back edge of the 

pressure-platen and lift it out. 
5. Replace with a new pressure-platen. Insert the new pressure-platen. First place the 

pressure-platens front braces so they rest on the front drive axle. 
6. Tip the platen backwards until the pressure-platen’s back braces rest on the backmost 

drive axle. 
7. Close the scanning area lid. 

 
NOTE:  Be sure to reset the part replacement warning flag though WIDEsystem’s “Status” tab. 
 
  
 
Grasp by the braces on the pressure platen’s back edge. 

 
Flip up the back edge and lift out the pressure-
platen. When you reinsert a new pressure-platen: 
position so the braces rest on the parallel drive axels. 

 
Drive Axles  

The white background and pressure platen are the same. To remove the pressure-platen:   

 
Front brace.   

 
Back brace.  

 
Replacing the White-background-platen: 
 

On Scanners:   
 

1. Turn the scanner power off and disconnect the power plug.  
2. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid. 
3. The lid’s locking mechanism should now be disengaged. 
4. As you hold both lever buttons down, place your free fingers in the insertion slot and flip 

the scanning area lid open. 
5. On the lid’s left edge, you will find a red strip. Remove the red strip to expose the edge 

of the white-background-platen.  
6. Grip the edge of the white-background-platen with your fingers and pull to slide it out of 

the scanner. 
7. Slide in a new white-background-platen.  
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8. Reattach the red strip. 
9. Close the scanning area lid so the locking mechanism reengages. 

 
NOTE:  Be sure to reset the part replacement warning flag though WIDEsystem’s “Status” tab. 
 To change the white-background-platen: 

 
Open the lid and locate the red strip on the left side 
of the scanner. 

 
 
Remove the strip and slide out the white background 
platen. Reinsert a new platen and replace the strip. 

 
 
 
 
 
 
 

7.4.3 Replacing the Scanner Lamp-Unit 
Your scanner comes with a high quality and durable lamp. Even so, its effectiveness will 
gradually weaken over time. Some scanner models are designed so users can replace the 
lamp. On other models, a service technician must perform this process. See your scanner’s 
model specifications to see if the lamp is user-replaceable on your scanner.  
A new lamp-unit (lamp, reflector, power connectors) for lamp-replaceable scanner models can 
be obtained through your dealer. WIDEsystem monitors scanner usage and will warn you when 
it is time for a replacement.  
 
Replacing the Scanner Lamp-unit: 

On Scanners:  
 

1. Turn the scanner power off and disconnect the power plug.  
2. The lamp cover is on the left side of the scanner.  
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3. Place your fingers under the small handle on the bottom of the cover and hold the top 
with your thumb. 

4. Lift upwards to release the catch and then flip back to remove the cover.  
5. You must replace the whole lamp-unit. A lamp-unit consists of a lamp mounted in a 

reflector brace and fixed power connectors. 
6. Grasp the edge of the lamp-unit and carefully pull it out of the scanner. 
7. Reinsert the new lamp-unit. Rest the power-connector side on the slider and carefully 

push the lamp-unit into the scanner. 
8. Insert the lamp-unit all the way so the internal power connections engage with the 

connections on the lamp-unit.  

9. Replace the lamp cover - fit the hinges in the holes and snap the cover shut. The 
cover must always be closed before turning scanner power ON. 

10. Test the replacement by turning power on to see if the lamp lights. 
 
 To replace the lamp-unit: 

Locate the lamp cover on the left side of  the 
scanner. 

 
Open the lamp cover as described above. Pull out the 
lamp-unit and replace with a new one. 

 
 
Replacing the Scanner Lamp-unit: 

On Scanners:   
 

1. Turn the scanner power off and disconnect the power plug.  
2. The lamp cover is on the top right edge of the scanner.  
3. Grasp the cover on each side with both hands and pull back to detach.  
4. Lift the cover upwards to free it from the scanner.  
5. You must replace the whole lamp-unit. A lamp-unit consists of a lamp mounted in a 

reflector brace and fixed power connectors. 
6. Grasp the edge of the lamp-unit and carefully pull it out of the scanner. 
7. Reinsert the new lamp-unit. Rest the power-connector side on the slider and carefully 

push the lamp-unit into the scanner. 
8. Insert the lamp-unit all the way so the internal power connections engage with the 

connections on the lamp-unit.   
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9.  Replace the lamp cover on the scanner - fit the bottom notches in the holes and 
snap the cover shut. The cover must always be closed before turning scanner power 
ON. 

10. Test the replacement by turning power and scanner on to see if the lamp lights. 
 
 
 To replace the lamp-unit: 

 
The lamp cover is on the right side of the scanner. 
Grasp the cover on both sides, pull back and then 
up to detach. 

Free the cover from the scanner. Pull out the lamp-unit 
and insert the new  one. 

 
 

7.4.4 Replacing the Dust-Filters 
Fresh dust filters can reduce the amount of time spent on cleaning and calibration. The dust 
filters protect your scanner’s air-cooling vents. Some scanner models are designed so users 
can replace the dust filters. On other models, a service technician must perform this process. 
See your scanner’s model specifications to see if the dust filters are user-replaceable on your 
scanner. WIDEsystem monitors usage and will warn you when it is time for a replacement.  
 
Replacing the Dust-filters: 

On Scanners:  
 

1. Turn the scanner power off and disconnect the power plug.  
2. Locate the 2 square-shaped dust filter bins on the underside of the scanner.  
3. Pull down on the edge of a dust filter bin to detach it from its frame. 
4. The filter (soft material) is inside the bin. Remove the old filter and replace with a fresh 

one. 
5. Reattach (click on) the bin to its frame on the underside of the scanner.    
6. Repeat the process with the second filter. 
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Changing the Dust-filters: 
The filter bins on the underside of the scanner.  Pull down on a filter bin’s edge to detach a filter bin from its frame. 

Dust Filter Bins 

 

Filters to change. 

 

7.5 Downloading New Firmware 

On All Scanners          
 
Like a computer, your scanner employs processors that require software in order to work. This 
software is called "Firmware”. Firmware is the software that runs inside the scanner. 

When to use new firmware? 
Your scanner is shipped with the latest firmware available. You can afterwards upgrade your 
original firmware with newer firmware and continue to do so as they are released. Firmware 
upgrades can be downloaded from your manufacture’s website or obtained through your dealer.  

Upgrade your firmware when: 
1. One or more new features are released or other improvements are made to the 

scanner though its firmware.  
2. An error is discovered in the firmware version you have in the scanner and your 

manufacturer recommends installation of new firmware in which the error is corrected.  

Your manufacture’s website specifies improvements for every new firmware release.  

How to identify the firmware version running in the scanner? 
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1. Start WIDEsystem – double click on the system tray’s scanner icon. 
2. Select the Info tab.  
3. The Info tab displays useful data about your scanner firmware. 

• Firmware release - Upgradeable firmware version.  
• Firmware revision - Firmware build number. 
• Firmware timestamp - The date/time the current firmware code was compiled. 
• Firmware download time - The date/time the current firmware was downloaded. 

You can upgrade if the Firmware Release number is lower than the newest firmware version 
number on your manufacture’s website. 

How to install new firmware? 
New firmware is installed by opening a firmware .exe file. The firmware .exe file must first reside 
on your machine. Select the Save target (or Save Link) option if downloading from the web.  

To install the firmware file on your scanner: 
1. Download/save the firmware .exe file in a folder on your machine. 
2. Start WIDEsystem’s Quick menu - Right-click the scanner icon in the system tray. 
3. Select Advanced Options. Select Update Scanner Firmware  
4. Browse the folders on your machine and find the firmware .exe file you wish to apply. 
5. Select the firmware file and click OK to install. Installation can take up to 1 minute 

depending on the scanner model and firmware version. The WIDEsystem scanner icon 
on your system tray blinks red during the download process.  

6. Follow the instructions on your screen. 
7. For recovery of errors during firmware installation, see the section on the Firmware 

Boot mode. 
 

7.6 Monitoring Your Scanner  

On All Scanners        
 

 
 
You installed WIDEsystem in order to install the scanner drivers (see this guide’s section on 
Installation – Install Drivers and Maintenance Software). WIDEsystem also contains an 
application part that monitors the scanner and reports on its functionality. You can access 
WIDEsystem directly by clicking on the scanner icon on your Windows system tray.  
 
Double click the system tray’s scanner icon to activate the WIDEsystem control interface.  
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Here are some of the features obtainable with WIDEsystem: 
 
• Gain visual indication that the scanner is connected to the PC. 
• View the scanner’s status, in WIDEsystem called the Scanner Mode, by moving the mouse 

over the scanner icon on the system tray. Status messages include remaining warm-up 
time, interface connection errors, and an indication that the scanner is ready for scanning. 

• View useful Error messages that relate to the actual Scanner Mode. Press F1 to launch the 
WIDEsystem on-line help system and find descriptions/instructions on trouble shooting 
specific errors displayed.  

• View the load status of the original (media) to be scanned.  
• Setup the scanner’s timer to determine times for automatic power-up / power-down for 

each day of the week. 
• View information on the scanner device in relation to firmware and hardware revisions. The 

information helps you keep track of your upgrades and is useful for support purposes. 
• Initiate a scan of the systems hardware bus for re-establishing the interface. 
• Quick launch of installed scanning applications. 
• Assign/reassign applications to the scanner’s one-touch-scan buttons, or disable the one-

touch-scan buttons altogether. 
• Set up your scanner so it can be shared by user PC’s on the network. 
• Set up your PC to receive scanned files into a special scan-to-file designated folder. 
 
Note: 
Double-click the scanner icon and press F1 to launch the WIDEsystem on-line help system. The 
on-line help contains full instructions on using the WIDEsystem program.  
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8. Trouble Shooting Common Problems 
 
This section describes trouble-shooting procedures for the most common problems that can 
arise with your scanner. Please look for a problem description that matches your actual 
situation. If found, perform the trouble-shooting procedures before requesting a service call. 
 

8.1 Problems Related to Scanner Installation 
 
Problem Possible Causes and Remedies 
 
“Unknown device is found“ 
message. 

1. Your interface is not enabled on the PC or set up correctly. Go through the 
installation steps for your interface board and its driver and control that the 
Windows device manager lists the interface option. 

2. WIDEsystem drivers were not installed before connecting the scanner. Shut 
down the scanner and PC, unplug the connections and restart the installation 
from step 1 as described above. If you continued installation before installing 
WIDEsystem, see the troubleshooting instructions below.   

3. Loose interface connection – on both ends, unplug and then firmly plug-in the 
interface cable. 

4. Smart Card not inserted correctly. Control that the smart card contact side faces 
downwards and the card is inserted all the way in its slot.  

5. System needs rebooting - shut down the scanner and PC, unplug the 
connections. Then plug in the interface connections,  turn on the PC and when 
Windows is loaded, turn on the scanner.  

 
 
Need to reinstall. 
I got the “Unknown device 
is found“ message and 
continued installation of the 
scanner. Now the scanner 
appears as incorrectly 
installed on my system. 
 

If you connected and tried to install the scanner before installing WIDEsystem, the 
unknown device found message will appear. If you continued to step through the 
dialogs from there, the scanner will be entered on the system as a new device without 
functional drivers. If this is the case, the scanner will be displayed in the Windows 
Device Manager with a yellow error icon.  The scanner entry must be removed from 
the Device manager before re-installing correctly.  
1. In the Device Manager - remove the scanner entry. 
2. Shut-down the PC, shut down and unplug the scanner, disconnect the scanner 

from the PC. 
3. Reboot the PC and install WIDEsystem and Maintenance software 

4. Refer to the installation instructions for your interface type in this guide. 

 
SCSI interface connection 
not detected. 
 
 
 

1. Go through the Cause/Remedies suggestions for “Unknown device is found 
message”. If this does not help, try the suggestions below.  

2. Make sure the default device number or the device number you set in the DIL 
switches is set to a number that is different from other devices on the system. 

3. Make sure that device termination is set correctly in the SCSI DIL switches.  
Follow the instructions in this manual under Installation - SCSI interface 
connection.  

4. Make sure you have not set any of the test control DIL switches 5, 6, 7, 8 to ON.  
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WIDEsystem does not 
detect the scanner.   
 

1. The WIDEsystem driver version installed on your PC is older than your scanner 
model. Install the WIDEsystem drivers form the WIDEsystem TOOLS CD-ROM 
that came with your scanner. If not available, download the newest version from 
your manufacturer’s website or contact your dealer to obtain the right 
WIDEsystem version.  

2. WIDEsystem drivers were not installed before connecting the scanner. Shut 
down the scanner and PC, unplug the connections and restart the installation 
from step 1 as described above. 

3. Loose interface connection – on both end, unplug and then firmly plug-in the 
interface cable. 

4. System needs rebooting - shut down the scanner and PC, unplug the 
connections. Then plug in the interface connections,  turn on the PC and when 
Windows is loaded, turn on the scanner.  

 

8.2 Problems Related to Operation of the Scanner 
 
Problem Possible Causes and Remedies 
 
Wait light flashes, 
diagnostics light is off  
 

 

 

1. The scanner needs to run Self-Adjustment but cannot. Self-Adjustment cannot 
run with a raised pressure platen or with media in the scanner. 
Self-Adjustment is necessary for maintaining optimal and stabile internal 
conditions.  
Remedy: Any original in the scanner should be removed, and the pressure-platen 
should be set to the Normal position (i.e., not a thick media setting).  

2. When Self-Adjustment becomes possible, the Wait LED stops flashing, but 
continues to be on until Self-Adjustment is completed.  

3. If the error doesn't disappear turn the scanner off and then on.  

4. If the error persists, you can reinitialize all settings by unplugging the scanner and 
waiting a few minutes before turning power on again.  

 
 
Wait LED goes on during 
calibration  
 

 

 
 

1. This is NORMAL - The Wait LED goes on during Calibration to indicate that the 
original should not be removed or moved during the Calibration procedure. All 
panel input is prevented during basic calibration. 

  

 
 
Diagnostics LED flashes 
 

 

 
 

1. An Error was detected during the scanner’s Self-Test. Open WIDEsystem 
(scanner icon on your system tray) and select the Status tab to view additional 
information about the error. 
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Both wait and diagnostics  
LEDs flash 
 

 

 
 

1. The scanning area needs cleaning and the cameras need to be calibrated. Run 
through the scanner maintenance steps described in this guide. 

2. If the Diagnostic and the Wait LEDs continue to flash after scanner maintenance, 
then there may be camera position errors that require help for your technical 
service provider. 

 

 
Paper Ready lights RED 
 

 

 
 

1. The pressure-platen is in a thick media setting (a raised pressure-platen) but the 
scanner does not detect the media. If you are scanning thick media, insert the 
thick media into the scanner. 

2. If the problem persists with thick media in the scanner, control that the pressure-
platen level is correct. Repeat the steps for correct adjustment for thick media as 
described in this guide. 

 
Error message: Paper Jam  
 

 

 

 
1. A Paper jam error has occurred when the scanner stops scanning and the Paper-

Ready key shuts OFF (from blinking) while the original is still engaged in the drive 
system. Your scanning application and WIDEsystem’s Status tab will report the 
Paper Jam error.  Remove the original from the scanner. Use the Paper-Back or 
Paper-Forward keys.  

2. If the original does not respond to the Paper Forward, Paper-Back keys, remove 
the pressure-platen as described under the section Maintenance – Cleaning and 
take the original out of the scanning area. 

3. Select the Soft-handling option in your scanning application.  
4. Feed the document again to scan. 

 

 
Error message: Correction 
of Camera X (A, B, C, or D..) 
failed 

1. Your scanner is continuously monitoring its cameras. This error message often 
appears when the internal glass plate or white background platen is dirty or 
smudged.  Clean the scanning area, reboot the scanner and then complete the 
maintenance steps (alignment and calibration) as described in the section 
Maintenance in this guide. 

2. If the problem persists after cleaning the scanner area - The problem could be 
caused by a loose object in the optical path. Remove any torn pieces of paper or 
other loose objects from the scanning area. Even the smallest loose objects will 
disturb the scanner’s adjustment function.  

3. Summon your technical service provider if the problem persists.   

 



Trouble Shooting Common Problems  8-4 

 
Error message: Stitching of 
Camera X/Y  (A/B or B/C or 
C/D) failed 

1. Your scanner is continuously monitoring its cameras. This error message often 
appears when the internal glass plate or white background platen is dirty or 
smudged.  Clean the scanning area, reboot the scanner and then complete the 
maintenance steps (alignment and calibration) as described in the section 
Maintenance in this guide. 

2. If the problem persists after cleaning the scanner area - The problem could be 
caused by a loose object in the optical path. Remove any torn pieces of paper or 
other loose objects from the scanning area. Even the smallest loose objects will 
disturb the scanner’s adjustment function.  

3. Summon your technical service provider if the problem persists.   

 
Error message: Invalid 
Smart Card for this scanner 
type. 
 
Error message: No Smart 
Card found. 

1. Control that a Smart Card is in the Smart Card slot. See the section Smart Card 
in this guide for instructions on locating your scanner’s Smart Card slot. 

2. Smart Card not inserted correctly. Control that the smart card contact side faces 
downwards and the card is inserted all the way in its slot. Shut down scanner 
power and restart to initialize with the smart card data.  

 
Error message: Unable to 
Adjust Camera 

 
1. Control that the scanner is set for Normal (lowest) media thickness. The 

scanner’s pressure-platen must not be raised.  Lower the original guide plate on 
both sides to let the scanner make its adjustments. 

2. If the thickness setting is/was Normal - there could be a loose object in the optical 
path. Remove any torn pieces of paper or other loose objects from the scanning 
area. Even the smallest loose objects will disturb the scanner’s adjustment 
function.  

3. If the problem persists after controlling for loose objects in the optical path – the 
problem is often caused by an unclean or smudged internal glass plate or white 
background platen.  Clean the scanning area, reboot the scanner and then 
complete the maintenance steps (alignment and calibration) as described in the 
section Maintenance in this guide. 

4. If the problem persists after cleaning the scanner area and all above possibilities 
have been attempted - summon your technical service provider.  

 
Application control keys 
(one touch) do not work 

1. Check the One Touch setup entries in WIDEsystem. Click on the scanner icon to 
open WIDEsystem and select the One Touch tab. View WIDEsystem Help for 
instructions. 

2. Check that the applications defined in the WIDEsystem One Touch setup entries 
are installed on your PC 

3. Make sure that the applications defined in the WIDEsystem One Touch setup 
entries are actually designed to work with (compatible with) your scanner’s 
application control keys. See the application’s documentation or contact the 
application software dealer. 
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Can’t operate or contact 
scanner after Firmware 
upgrade failure. 

1. A power failure could interrupt an ongoing firmware upgrade process. The 
scanner will not run correctly after an interrupted firmware update process. Only 
part of the intended firmware may be loaded, rending the scanner inaccessible. 
You need bring the scanner into firmware boot mode to reapply the firmware. 

2. Restart the scanner. The scanner should start up in boot mode. If not, you can 
use the following panel function to force the scanner into boot mode.   

3. Turn the scanner ON so it starts its Init-Sequence (all LEDs on). Towards the end 
of Init-Sequence, the Power LED lights green while the other LEDs remain 
lighted, signaling that you can interrupt the self-test to force Firmware Boot mode. 

 

   
You have to activate the boot mode before the scanner moves into self-
adjustment. Self-adjustment is started when the Wait LED lights yellow, the 
Power LED still lights green and all the other LEDs are off.) To activate boot 
mode, press and hold down the Power key.  

When the Power LED turns red and the other LEDs flash (see below), the 
scanner is in Firmware Boot mode and you can reapply the Firmware. 

 

  
4. On scanners wih SCSI interface, you can force firmware boot mode by setting the 

DIL switch 7 to ON. 
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8.3 Problems Related to the Scanning Results 
 
Problem Possible Causes and Remedies 
 
Not whole image scanned 
 

1. Check in your scanning application that your size settings are either for Auto 
detection or correspond to the size of the whole original. 

2. Check in your scanning application that you are loading the original correctly in 
relation to your choice of Center-loading or Side-loading. If you selected Side-
loading in your application then the original must be fed into the side of the 
scanner starting from the 0 marking on the top ruler. If Center-loading was 
selected in the application then align the center of the original with the scanner’s 
center arrow marking.   

 
 
Stitching problems – Image 
sections misaligned (at 
points between the cameras -
overlapping pixels) 

1. If scanning normal paper thin media – Remove the original from the scanner, turn 
power off and then on to reboot so the scanner runs its self-test procedure. The 
self-test includes camera-stitching correction.  

2. If scanning normal paper thin media and above procedure does not correct the 
problem – Remove the original from the scanner and run full scanner 
maintenance. 

3. If scanning thick media, thick stiff originals will rest on top of the scanner rollers 
and thus raise a small distance over the glass-plate. This can lead to stitching 
irregularities. In such cases, the stitching parameters will need to be modified. 
You can modify stitching parameters through your scanning application. See the 
section When Scanning in Thick Media Positions in this guide. 

4. Summon your technical service provider if the problem persists.   

 
Edge distortion with thick 
originals 

1. Scanning thick stiff originals can give distortions when the front edge meets the 
exit rollers or the trailing edge leaves the entry rollers. To omit this, the leading 
and trailing edges are by default skipped when in one of the extended media 
thickness positions.  
Leading/trailing edge skipping can be turned off/on through the scanning 
application’s setup dialogs. If you encounter edge distortion, control that the 
Leading/trailing edge skipping option is set in your application.   

 
One or more thin vertical 
lines (in the direction of 
paper feeding) on the scan 
result, but not on the 
original drawing. 
 

1. This is often caused by an unclean glass plate or unclean white background 
platen. Even a single spec of dirt in the wrong spot on the glass plate or 
background plate can apply a streak through your entire scan. To remedy, run a 
full scanner maintenance session – cleaning, alignment and calibration. The last 
two maintenance steps are also vital, as the scanner will have memorized dirt 
specs in previous calibrations and self-adjustments and you need to reset after 
dirt-removal.  
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9. Appendix A: Important Safety Instructions 

Read all of these instructions and save them for later use. Follow all warnings and 
instructions marked on the scanner.  
 

A. Do not place the scanner on an unstable surface, stand, cart or table. Serious damage can 
be caused if the unit falls. 
B. For cleaning, do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning. 
C. Before cleaning or replacing any user-replaceable parts, be sure to turn the scanner power 
off and disconnect the power plug. 
D. The scanner should be operated from the power source type  indicated on the marking label. 
If you are unsure of the type of power available, consult your dealer or local power company. 
E. The scanner is equipped with a three-wire grounding type plug. This plug will fit only into a 
grounding-type power outlet. This is a safety feature. If you are unable to insert the plug into the 
outlet. contact your electrician to replace your obsolete outlet. Do not defeat or ignore the 
purpose of the grounding-type plug. 
F. Do not allow anything to rest on the power cord. Do not locate the scanner where persons 
will walk on the cord. 
G. If an extension cord is used with the scanner, make sure that the total ampere ratings of the 
products plugged into the extension cord does not exceed the extension card ampere rating. 
Make sure that the total rating of all products plugged into the wall outlet does not exceed 15 
amperes. 
H. Slots or openings in the cabinet at the back or bottom are provided for ventilation. This 
ensures reliable operation of the product and protects it from overheating. These openings must 
never be blocked or covered. The openings should never be blocked by placing the unit on a 
bed, sofa, rug, or other similar soft surface. This product should never be placed near or over a 
radiator or heat register. This product should not be placed in a built-in installation unless proper 
ventilation is provided. 
I. Never push objects of any kind into the scanner through cabinet slots since they may touch 
dangerous voltage points or short out parts that could result in a risk of fire or electrical shock. 
Avoid any possibility of spilling liquid of any kind on the scanner. 
J. Do not attempt to service the scanner yourself. Opening or removing those covers requiring 
tools may expose you to dangerous voltage points or other risks. Refer all servicing in those 
compartments to authorized service personnel. 
K. Unplug the scanner from the wall outlet and refer servicing to authorized service personnel 
under the following conditions: 

• When the power cord or plug is damaged or frayed. 
• If liquid has been spilled into the scanner. 
• If the scanner has been exposed to rain or water. 
• If the scanner does not operate normally when operating instructions are followed then 

adjust only those controls covered by the instructions in this manual. Improper 
adjustment of controls other than those mentioned in this manual may result in 
permanent damage and will at best require extensive work by a qualified technician to 
restore this product to its normal operation. 

• If the scanner has been dropped or the cabinet has been damaged. 
• If the scanner exhibits a distinct change in performance, indicating a need for service. 
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10. Appendix B: Regulations 
FCC Regulations 
 
USA 
 
NOTE: This equipment has been tested and found to comply with the limits for 
a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required 
to correct the interference at his own expense. 
 
Caution: Pursuant to Part 15.21 of the FCC Rules, any changes or modifications not expressly 
approved by the manufacturer may cause harmful interference and void the use's authority to 
operate the equipment. 

 
CE Regulations 
 
EU 
 
Warning 
This is a class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take adequate measures. 
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1. About This Guide 
This guide explains how to maintain and operate your wide format copy (iJET) scanner and its 
iJET Panel. The guide assumes basic knowledge of other optional configuration components 
such as printer, computer and operating system and does not repeat material from their 
documentation. 

Be sure to refer to: 
• The Installation Guide – accessed from the menu on the WIDEsystem TOOLS CD-ROM 

– describes installation of your driver if interfacing your scanner with a PC. 
• The readme.htm file in the ws folder on the WIDEsystem TOOLS CD-ROM – contains the 

most current installation and OS compatibility issues. 
• WIDEsystem TOOLS Help – Press F1 after installing and opening WIDEsystem. – 

Contains information on using the WIDEsystem application, Scan2Net functionality and 
Scanner Maintenance software if interfacing your scanner with a PC. 

Scope 
This guide covers installation, operation and maintenance of your scanner. The guide covers 
only copying and scanning operation through the iJET Panel.  
The scanner can also be operated and controlled though compatible scan and copy software 
installed on a PC that is either directly connected with the scanner or on the same network. 
While this guide will provide instructions on setting up the scanner with a PC, it will not describe 
in detail how to operate the scanner from that PC. Operation of scan and copy software is not 
within the scope of this guide. Please refer to the software’s documentation and on-line help for 
instructions on using the specific software application with the scanner. 

Identify your scanner model icon 
This operator’s guide covers several scanner models, although there are individual differences 
between the models.  Use the guide’s scanner type icons to direct you to descriptions about 
your specific scanner model. Topics describing scanner functions that apply solely for specific 
models will be marked with one or several of the icons shown in the table below. Topics 
describing functions that apply for all models will be marked with all the icons.  
 
Before proceeding, identify the icon that applies to your scanner model. You can then use the 
icon throughout this guide to find the function description that applies for your specific scanner.  
 
If in doubt as to which icon refers to your scanner model, see the Model ID on the sticker on the 
back of the scanner. Models not listed in the table below are not within the scope of this guide. 
 

Icon in Guide Applies for scanners… Main Characteristics Model IDs 

 

18” (A2) wide format 
copy scanners 

• Top fed - Flatbed  
• iJET Panel 

AA51A 
 

 

36” wide format copy 
scanners  
 

• Sheet fed - Insertion slot 
• iJET Panel 
• ATAC (Automatic Thickness 

Adjustment Control) 
 

KA67E 
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Additional Guide Icons: 

• Reference additional Details within this guide – Look for the “Manual” icon  

The Manual Icon:  marks a reference to another section in this guide where you can 
find more instructions on a certain function just named.   

 

• Operation from the panel – Look for the “On the iJET Panel” icon  

The On the iJET Panel Icon:  marks instructions to actions you perform by pressing the 
buttons on the scanner’s copy operator’s panel. 

 

• Actual iJET Panel Button – Look for the “Button” icon  
 
The Button Icon will often appear in this guide together with the iJET Panel Icon. The 
Button Icon marks which button to look for and press on the iJET Panel to initiate an 
action. The icon will contain the button name as seen on the iJET Panel. For example, 
instructions describing an action reached through the menu button will be marked with the 
button icon:   

 

 

 Menu 
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2. Using the iJET Panel 
Before setting up your copy/scan configuration, you will need to familiarize yourself with the 
iJET Panel. A number of setup tasks are performed through the iJET Panel and will require that 
you know how to navigate the iJET Panel’s menus. 

 Instructions on making specific settings will be described under each configuration type in 
the chapter “Copy Scanner Configuration and Setup”.   
 
 

 

Scan Option Area 

Copy Option Area 

Control Buttons 

Size Button 

Menu Button 

Display Window 

Stop Button 

 
The iJET Panel enables you to perform advanced copy and scan-to-file jobs straight from the 
scanner (and not from a PC and scanning software interface). The panel contains a display 
window, control buttons and option buttons. 
 
• The Display Window contains the current selections as you make them and useful 

messages from the scanner regarding maintenance and operation. 
• The Menu button leads to a options for copy settings and an Advanced submenu for 

configuration settings.  
• The control buttons arrow up, arrow down, Back, Enter, are for navigating the menus 

and for selecting menu options.  
• The Stop button is for interrupting a copy or scan process. 
• The Size button is for setting the original’s size (input size) for both copy and scan jobs. 
• Below the control and menu buttons, are a Copy Option Area and a Scan Option Area, 

each with its own set of quick option buttons. These buttons are described below. 
 

 A complete overview of the panel’s buttons follows at the end of this section. 
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2.1 To make a simple copy 
The following procedure for making a copy presumes the following: 
• The scanner and printer(s) are setup correctly as described in this Operator’s guide. 
• The Size button option is set to Auto. 
• Options such as Lightness, Scale, Original Type, Quality and so on are all set to your 

standard settings and the job does not require special adjustments.  
 
1. Load the original 
2. Press the Color Copy button for color jobs or B&W copy button for B&W jobs. 
 

Color 
Copy    or   

B&W 
Copy 

 
For jobs that require adjusting the copy parameters, see the section “How do I make a Copy?” 
See also relevant sections for setting up the system and setting options. 
 

2.2 To perform a simple Scan-to-File 
The following procedure for making a copy presumes the following: 
• The scanner is setup correctly with a local or network PC as described in this Operator’s 

guide. 
• The Size button option is set to Auto. 
• Scan-to button options such as Scan Mode, File Format, Resolution and so on are all set to 

your standard settings and the job does not require special adjustments.   
 
1. Load the original 
2. Press the Scan to button and select a scan target. A (USB) target is a local PC. 

 
 

Scan to 

3. Press the Scan button to start the job. 

  
 

Scan 

For jobs that require adjusting the Scan to parameters, see the section “How do I Scan to File?” 
See also relevant sections for setting up the system and setting options. 

2.3 Operations on the iJET Panel 
• Turn the scanner power ON/OFF (Soft Power ON/OFF) 
• Make quick settings for Copying – Lightness,  Quality, Copies (no. of..) and Scale. 
• Make additional high level copy settings through the Menu button. 
• Apply scanner and printer setup options through the Menu button - Advanced. 
• Apply personal and local preferences through the Menu button - Advanced. 
• Select a scan-to-file target through the Scan to button. 
• Make advanced scan-to-file settings through the Scan to button 
• Start a Copy (BW or Color) job. 
• Start a Scan-to-file job. 
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2.4 Power ON/OFF 
These power on/off instructions apply only after you have setup and configured your 
system as described in the relevant sections under “Scanner Configuration and setup”.  
 
First time during setup (hard power ON) 
1. Connect the scanner to the power outlet and turn on the outlet switch (scanner’s back). 
2. The scanner runs a self-test and init procedure and after warming up it is ready to scan.  
3. The text in the display window will tell you what the scanner is doing and when the 
scanner is ready to scan. Prior to the “Ready” message the scanner will need to self adjust.   

 
Normally, after powering up for the first time as described above, you will leave the outlet switch 
permanently in the ON position, and turn scanner power on and off in the “soft” manner from 
the iJET Panel as described below. This is the method recommended for daily use as it is faster 
than hard power on.  
 
To turn power ON from the iJET Panel (soft power ON) 
1. The scanner must be in Soft Power OFF mode. When the scanner is in soft power OFF 

mode, you will see the 3 Print Quality LEDS flashing alternately as shown below.  

 
Press and hold down the STOP button for a few seconds until the iJET Panel’s display 
window becomes active (lights up). 

 
2. The text in the display window will tell you what the scanner is doing and when the scanner 

is ready to scan. Prior to the “ready” message the scanner may need to initialize itself and 
warm up.  

 
 
To turn power OFF from the iJET Panel (soft power OFF) 
1. Press and hold down the Stop button   for a few seconds until the iJET Panel’s display 

window light goes off.  

 
When the scanner goes in soft power OFF mode, the 3 Print Quality LEDS light alternately 
as shown below.   

 
 

 NOTE: The outlet switch at the back of the scanner must be constantly flipped to the ON 
position in order to use Soft Power ON/OFF.  
 
 

Stop 

 Initializing  
 FW:xxxx …….   Ready 

  

    Fast   Normal   Best     Fast   Normal   Best    Fast   Normal   Best 

Stop 

    Fast   Normal   Best     Fast   Normal   Best    Fast   Normal   Best 

 Initializing  
 FW:xxxx 

  Adjusting 
  

  Ready ……. 
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2.5 The iJET Panel Buttons - Overview 
The Menu button    

 
Menu button - The Menu button leads to the total range of options for copying and also the 
Advanced menu with all the system setup and configuration functions.  

Menu 

A complete description on how to navigate the menu and select options follows below.  
 

The Back button 

 
Control Button – for moving one level up when in a menu or for returning to an option’s current 
(active) setting while in the process of editing the option’s value. 

Back 

 
The Enter button 

 
Control Button – for entering the menu functionality for changing an option’s value and for 
setting (accepting) the value once it is selected. 

Enter 

 
The Size button 

  
Settings button - For setting the size of the original. The Size button is used for both copy and 
scan-to-file operation. Press the button to activate option setting. You then change the value 
each time you again press the button or with the arrow up/down buttons. You can select Auto 
detection or a standard size setting.  
NOTE that Size is a global system variable that can be changed in 3 different ways: 1. With the 
Size button 2. With the Menu button > Size option and 3. With the Scan-to button > Size option. 
This means that when you change the size for a copy job, it will also apply for a scan-to-file job 
and vise versa unless you change it again.   

Size 

 
The Lightness button 

 
Settings (quick) button  - For increasing or decreasing lightness in the copy. Press the button to 
activate option setting. You then change the value each time you again press the button or with 
the arrow up/down buttons.  

Lightness 

 
The Quality button 

 Quality 
Settings (quick) button - For setting copy quality to Fast, Normal or Best. Press the button to 
activate option setting. You then change the value each time you again press the button or with 
the arrow up/down buttons.  

 

 

The Copies button 

Copies 
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(…Copies button) Settings (quick) button - For setting the number of (how many) copies you 
want output. Press the button to activate option setting. You then change the value each time 
you again press the button or with the arrow up/down buttons.  

 
The Scale  button 

   
Option button - For setting a value that defines the output size in relation to the input size. For 
making copies larger or smaller than the original. Press the button to activate option setting. 
You then change the value to predefined scale ratios each time you again press the button. Use 

Scale 

the arrow up/down buttons for fine tuning - 1 step increments of the currently displayed value.  
Press the Enter button to save. 

 
The B&W Copy button    

 
Action Button: The B&W C

B&W 
Copy 

opy button will start the copy job using the settings made for B&W 
Menu button and the Size, Quality, Copies, Lightness and Scale buttons. copying through the 

 
The Color Copy button    

 
Action Button: The Color C

Color 
Copy 

opy button will start the copy job using the settings made for Color 
Menu button and the Size, Quality, Copies, Lightness and Scale buttons.. copying through the 

 

cting a scan-to-file target (PC on the network) and for setting scan-to-file 
You change the scan target each time you press the button. Keep pressing until you 

see the right target in the window. Then, pressing  will lead to the Scan Menu with its 

The Scan to button.  

 
Menu Button - For sele

Scan to 

options. 

wide range of scan-to-file options you can select for the job. Scan-to-file options include modes, 
formats, and resolution. 

 
The Scan button    

Enter

  
Action button - The 

Scan 

Scan button will start a scan job using the settings made for scanning 
Scan To button. through the 

 

is button has 2 functions: 1. For interrupting and terminating a scan or copy
hed. 2. For turning the scanner ON, OFF in soft power mode.   

The Stop button 

 
Action Button – Th
job before it is finis

Stop 

 

 

 More details on using the iJET Panel buttons with copy and scan-to-file tasks are 
described in the relevant sections in the chapters “How do I Make a Copy” and “How do I Scan 
to File?”. 
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2.6 

You will learn here how menu options and values are shown in the display 
d arrows up/down to reach them for 

menu option items 
option item can be shown at a time in the 
t menu option item and its current value is 

shown in the display window as shown below for the Menu button. 

4. 

hoto”. The “>” marks which one of the two lines is currently active for changing with the 
rrow up/down buttons. In the example above, the first line, i.e the menu option item line is 

5. The “>” marker  in the example above shows that the menu option item “Org, Type B&W” is 
now active and “Sepia” is its current setting. To enter the menu option in order to make 
changes to its setting, you press the Enter button.  
 

6. The “>” marker now indicates that the setting for “Org. Type B&W” option can be changed. 
Pressing the up/down arrow buttons will move through the available settings. Press the 
Enter button  when the right setting is displayed to the right of the “>” marker. The 
selected setting will then become the option’s active setting and the “>” marker will hop 

How do I Navigate the iJET Panel Menus? 
This section explains how you find and set the many options behind the Menu button and the 
Scan to button. 
window and how you use the control buttons Back, Enter an
setting and changing their values. 

2. When you press the one of these buttons you start its underlying menu. 

     or…  

3. A menu contains an ordered list of menu option items and each of these 
can be set to different values. Only one menu 
display window. When you start a menu, its firs

 
 

“P
a

The first line in the display is the menu option item and the second line is its current value. 
In the example above, the current menu option item is “Org. Type Color” and its value is 

active.  

Pressing the down arrow button  in this case will move the menu forward to the next 
menu option item and that option’s own current setting as shown below: 

 

In the display panel the “>” mark will move down to the next line as shown below.  

 

back to the menu level (top line) so you can resume leafing through the menu option items 
with the arrow up/down buttons.  

   

     Org. Type B&W 

 >  Sepia  

Menu option item 
 
Current setting for the option item

> Org

   Se

. Type B&W 

pia  

Menu 
Scan to 

> Org. Type Color 

   Photo  

Menu option item 
 
Current setting for the option item

Menu option item 
 
Current setting for the option item

Enter

Enter
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7. bove to the display window below: The user pressed the 
arrow down button until the value “Line” was displayed and then pressed  to accept 
that value as the new setting for the “Org. type B&W” option. The “>” marker moved back to 

 

8. 

9. Press the Stop button if you need to cancel a started scan-to-file or copy job. 

ts to option 
Menu button. Their values can be changed through repeated pressing of 

the quick button or else in the traditional manner with the arrow up/down buttons as with 
other menu option items.     

From the display window shown a

Enter 

the menu option item level enabling the user to continue navigating the menu with the arrow
up/down buttons. 
 

 

When in a menu, you can press the Back button  to return to a previous menu 
level or to reset the active option item to its last saved value. 

  >  Org. Type B&W 

     Line  

Menu option item 
 
Current setting for the option item

Back

Stop 
 

10. The copy area quick buttons Lightness, Quality, Copies and Scale are shortcu
items behind the 

 The quick buttons Lightness, Quality, Copies and Scale are described in detail in the 
relevant sections of the chapter “How do I Make a Copy”. 
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3. Scanner Configuration and Setup Instructions 
Your Copy scanner supports iJET technology for copy and scan-to-file functionality. The iJET 
panel enables you to set options on the scanner so you can copy straight from the device 
without a controller-PC and software. Furthermore, your scanner can be connected directly to 
the LAN enabling it to function with other devices such as printers and PCs that are on the 
same network. Finally, your scanner supports both USB device (input) and USB host (output) 
interfaces for direct connection to a printer and to a PC that can control the scanner through 
scan/copy software.  
This wide range of connection and operation capabilities means that your scanner can be set 
up in many different ways or “configurations” to match the needs of your business. For clarity, 
we have termed the main configuration possibilities and their components as follows: 
 
 Configuration Type Components - Description 

1 Stand Alone Copier Configuration Scanner connected directly (no PC) to one or two printers. 

2 Network Scan/Copy Device 

Scanner connected directly (no PC) to the network. The 
scanner is set up to be recognized on the network by 
network PCs and also setup to recognize/use network PCs 
as scan targets. The scanner is setup to use network  
printers.  

3 Scan/Copy Station on Local PC  Scanner connected to a PC through USB interface. 
Scan/copy software is installed on the PC. 

4 Combinations of the above for Multiple Functionality 

The scanner is connected to a local PC and a local printer. 
The scanner is also connected directly to the network in 
order to be shared by network PCs and to use network 
PCs as scan targets. The scanner can also use network 
printers.  

 
This operator’s guide section describes each of these configurations, including its components, 
requirements and step-by-step installation instructions. Please note that combinations of the 
first three configurations (present in above list as configuration nr. 4) are not only possible, but 
in many cases also recommended in order to get the full range of scan-to-file and copy 
functions out of your device and maximum flexibility for your business .  

 More on combining configurations in the section “Combining Configuration Types for 
Multiple Functionality.” 
 
 
NOTE: About interface connection cables: Your scanner came with a number of interface 
cables. Refer to the supplied document: “NOTE ON INTEFACE CABLES” for instructions on 
which cables to use with your specific configuration.  
 
 
All the configurations described in the following sections apply… 
 

On All Scanners   
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3.1 Connect the scanner directly to printer(s) - Stand Alone Copier 
Components: Wide format copy scanner and one or two large format printers. The Scanner is 
connected directly (no PC or network) to one or two printers. 
 
Usage: For copying large format documents. This configuration can create printed output only. 
All operation takes place from the iJET Panel (scanner). 
 
System Requirements:  
• Wide Format Copy scanner 
• Compatible large format printer(s) 
• USB cable or twisted LAN cable or both. - for connecting the scanner to the printer(s) 
 

Printers are connected through USB or LAN interface  
 
Step  Description – Stand Alone Copier Configuration 

1 Set up your scan station and control the smart card 
Your wide format copy scanner should be placed either on the specially designed stand-alone floor stand or on 
a sturdy table. For sheet-feed models, make sure there is enough space behind the scanner to allow the media 
to run out.  
Make sure that the scanner’s smart card is in place. 

 See the sections “Physical Placement of the Scan Station” and “Maintenance-Locate the Smart Card” for 
detailed instructions for your specific scanner model. 

2 Connection – scanner end 
Connect the USB cable or LAN cable to the scanner. Check your printer’s interface options to select which of 
these to use. For USB use the USB host (output) port which is the flat rectangle shaped socket. See the 
document: “NOTE ON INTERFACE CABLES” for instructions on the specific interface cable types to use with 
this configuration. 
 
You can attach two printers at a time – a B&W printer and a Color printer. Note that the scanner has only one 
USB out connection so a second printer will have to be able to use the LAN connection. 

LAN port 

USB host port  
(output to printer)   

 
 

 

 See the section “Locating the Interface Cable Connector Panel” for instructions regarding your specific 
scanner model. 
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3 Connection - printer end 
Connect the other end of the USB interface cable or LAN cable to the large format printer.  

 See the section “Locating the Interface Cable Connector Panel” for detailed instructions for your specific 
scanner model. 

4 Connect scanner power cable 
At back of the scanner, you will find the scanner-end power cable socket, just below an Outlet switch. Connect 
the cable to the scanner plug socket and the grounded power source.  Do not yet turn on the Outlet switch on 
the scanner. 
 

Scanner-end power socket 

 
 

 

Caution: The scanner is equipped with a three-wire (pin) grounding type plug. If you cannot insert the 
plug into your outlet, contact your electrician to replace the outlet and ensure a grounded power connection. Do 
not try to defeat or ignore the purpose of the grounding-type plug. 

 

5 Connect the printer’s power cable. 

6 Perform Preliminary Maintenance – Cleaning  
Clean your scanner’s flat surface so dirt and dust are not dragged into the scan area with the original. Clean the 
internal Scan area.  

See the section “Scanner Maintenance” for instructions on accessing the scan area and cleaning for your 
specific scanner model.  

7 Turn (power) on the scanner and the printer 
To turn on the scanner - at back of the scanner, above the scanner-end power cable plug you will find an Outlet 
switch. Flip the Outlet Switch to ON. The scanner starts the init and self test sequence and you must wait until 
these are finished.  

 Power outlet and switch is found at the back of the scanner 

 Perform Preliminary Maintenance - Calibration 
Some scanner models support calibration from the iJET panel. For other models you will need to use a PC with 
WIDEsystemNET and Scanner Maintenance software installed.  
To run scanner maintenance: 

   
On the iJET Panel 
Select Menu > Advanced > Options > Calibrate Scanner > Yes to start calibration. If the option is not present in 
the iJET panel menu: 
 
Use a local or LAN connected PC with WIDEsystem and Scanner Maintenance installed. Left click on the 
WIDEsystem scanner Icon and select Launch Scanner Maintenance from the menu. Follow the instructions on 
your screen.   

 See the section “Scanner Maintenance” for detailed instructions. 

Menu 
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8 Set localization Preferences 
 

  
On the iJET Panel -  Select Menu > Advanced > Options >… to set preferences for language, paper series and 
media handling (loading).   

 See the section on options for ”Personalizing and localizing the system” for details. 

Menu 

9 Make Printer Setup settings on the scanner 
You can setup for two printer types – a B&W printer and a color printer. After you setup your printers, pressing 
the Color Copy button will send the output to your color printer and pressing the B&W Copy button will send the 
output to your B&W printer.  

 

  
On the iJET Panel 
 
Printer set up is described for Color Printer below. The same rules and method applies for B&W Printer setup.  
Select Menu > Advanced > Printer Setup > Color Printer  to make settings. 
Select Menu > Advanced > Printer Setup > Color Printer > Interface > USB  if you used a USB connection 
between the scanner and the printer and LAN if you used a LAN connection. If you selected LAN, use the arrow 
up/down buttons to enter the printer’s IP address.  
Select the Printer Model setup method – Auto Configure, Printer List or Custom Setup and apply the additional 
setting(s) attached to the Printer Model setup method you selected. 

 See the section on “Printer Setup on the Scanner” for more details. 

10 

Menu 

Turn On and Prepare the Printer  
Perform actions and settings on the printer device such as check that the right paper is loaded and the printer is 
ON. See your printer’s documentation for help. 

11 Create a system media type for your printers media (Closed Loop Calibration) 
For the color printer only - You must create a system media type profile in order to color match paper media, 
printer and scanner before using the system. Identify the media type (Coated, Glossy, Semi-Glossy) you use 
with the printer then perform   closed loop calibration (3 steps).     
 

  
On the iJET Panel 
Select Menu > Advanced  > Options > Closed Loop Cal.  
Press Enter and then use the arrows up/down buttons to reach the right media type and Enter to select.    
On “Print Sheet” select Enter. The system will print a color patch sheet. 
Feed the sheet into the scanner  
On “Scan Sheet” select Enter. The system will scan the color patch sheet and calculate color matching values 
for future jobs with the current media type. 
 

 See the section on “how do I… Create a New Media Type” for more details. 

….. 

12 Test your system 
Make a simple copy to test your system. 

 See the section on “how do I… Make a Copy” for details. 
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3.2 Connect the Scanner to LAN – Network Scan/Copy Device 
Components: Wide format copy scanner and Local network. Peripheral devices such as PCs 
and printers are setup and active on the network. The scanner will be setup to recognize PCs 
on the network as scan-to-file targets. The scanner will also be setup to be recognized and 
accessed by PCs on the network (sharing). The scanner will be setup to recognize and use 
network printers.   
 
Usage: For copying and digitizing large format documents. For creating both printed and file 
(digitized) output. Operation is from the iJET Panel (scanner) or from network PCs. Users 
operating from the panel can copy to printers on the network and scan-to-file to PCs on the 
network. Network PCs with compatible scan or copy software installed can “share” the scanner 
and use it with network printers or for scan-to-file tasks.  
 
System Requirements:  
• Wide Format Copy scanner 
• Compatible large format printer on the network (for copy functionality). 
• LAN cable connecting the scanner to the network. 
• One or more PCs on the network (for scan to file and shared scanner functionality). 
• The PCs need: compatible operating system (see ws/readme.htm on WIDEsystem TOOLS 

CD). 
 
 

 
Scanner’s LAN interface

 
 
Step  Description 

1 Set up your scan station and control the smart card 
Your wide format copy scanner should be placed either on the specially designed stand-alone floor stand or on 
a sturdy table. For sheet feed models, make sure there is enough space behind the scanner to allow the media 
to run out.  
Make sure that the scanner’s smart card is in place. 

 See the sections “Physical Placement of the Scan Station” and “Maintenance-Locate the Smart Card” for 
detailed instructions for your specific scanner model. 

2 Connection – scanner end 
Connect the LAN cable to the scanner’s LAN port. See the document: “NOTE ON INTERFACE CABLES” for 
instructions on the specific interface cable type to use with this configuration. 
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LAN  port 

 
 

 

 See the section “Locating the Interface Cable Connector Panel” for instructions regarding your specific 
scanner model. 

3 Connection – network end. 
Connect the other end of the LAN cable to the network or switch. 

4 Connect scanner power cable 
At back of the scanner, you will find the scanner-end power cable socket, just below an Outlet switch. Connect 
the cable to the scanner plug socket and the grounded power source.  Do not yet turn on the Outlet switch on 
the scanner. 
 

Scanner-end power socket 

 
 

 

Caution: The scanner is equipped with a three-wire (pin) grounding type plug. If you cannot insert the 
plug into your outlet, contact your electrician to replace the outlet and ensure a grounded power connection. Do 
not try to defeat or ignore the purpose of the grounding-type plug. 

 

5 Perform Preliminary Maintenance – Cleaning  
Clean your scanner’s flat surface so dirt and dust are not dragged into the scan area with the original. Clean the 
internal Scan area.  

 See the section “Scanner Maintenance” for instructions on accessing the scan area and cleaning for 
your scanner model.  

6 Turn (power) on the scanner and the printer 
To turn on the scanner - at back of the scanner, above the scanner-end power cable plug you will find an Outlet 
switch. Flip the Outlet Switch to ON. The scanner starts the init and self test sequence and you must wait until 
these are finished.  

 Power outlet and switch is found at the back of the scanner 
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 Perform Preliminary Maintenance – Calibration 
Some scanner models support calibration from the iJET panel. For other models you will have to use a PC with 
WIDEsystem and Scanner Maintenance software installed. To run scanner maintenance: 

   
On the iJET Panel 
Select Menu > Advanced > Options > Calibrate Scanner > Yes to start calibration. If the option is not present in 
the iJET panel menu: 
 
Use a local or LAN connected PC with WIDEsystem and Scanner Maintenance installed. Left click on the 
WIDEsystem scanner Icon and select Launch Scanner Maintenance from the menu. Follow the instructions on 
your screen.   

 See the section “Scanner Maintenance” for detailed instructions. 

7 
 

Menu 

Set localization Preferences 

  
On the iJET Panel -  Select Menu > Advanced > Options >… to set preferences for language, paper series and 
media handling (loading).   

 See the section on options for ”Personalizing and localizing the system” for details. 

Menu 

8 Make Printer Setup settings on the scanner 
You can setup for two printer types – a B&W printer and a color printer. After you setup your printers, pressing 
the Color Copy button will send the output to your color printer and pressing the B&W Copy button will send the 
output to your B&W printer. In this configuration, both printers are on the network. 

  
On the iJET Panel 
 
Printer set up is described for Color Printer below. The same rules and method applies for B&W printer setup.  
Get the network id information for the printer(s) you want to use from your network administrator. 
Select Menu > Advanced > Printer Setup > Color Printer  to make settings. 
Select Menu > Advanced > Printer Setup > Color Printer > Interface > LAN.  Use the arrow up/down buttons to 
enter the printer’s IP address.  
Select the Printer Model setup method – Auto Configure, Printer List or Custom Setup and apply the additional 
setting(s) attached to the Printer Model setup method you selected. 

 See the section on “Printer Setup on the Scanner” for more details. 

Menu 

9 Make Scanner Network Setup settings on the scanner 

  
On the iJET Panel 
Select the Menu > Advanced > Network Setup. You can use DHCP network setup if your network supports it. 
Otherwise you need to enter the network address information manually. Contact your network administrator for 
the correct address values. Select Menu > Advanced > Network Setup > Share Scanner > Yes if you want to 
enable PCs on the network to use the scanner. 

 See the section on “Scanner on Network Setup Settings” for details. 

Menu 

10 Turn On and Prepare the Printer  
Perform actions and settings on the printer device such as check that the right paper is loaded and the printer is 
ON. See your printer’s documentation for help. 

11 Create a system media type for your printers media (Closed Loop Calibration) 
You must create a system media type profile in order to color match paper media, printer and scanner before 
using the system. Identify the media type (Coated, Glossy, Semi-Glossy) you use with the printer then perform   
closed loop calibration (3 steps).     
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On the iJET Panel 
Select Menu > Advanced  > Options > Closed Loop Cal.  
Press Enter and then use the arrows up/down buttons to reach the right media type and Enter to select.    
On “Print Sheet” select Enter. The system will print a color patch sheet. 
Feed the sheet into the scanner  
On “Scan Sheet” select Enter. The system will scan the color patch sheet and calculate color matching values 
for future jobs with the current media type. 
 

 See the section on “how do I… Create a New Media Type” for more details. 

Menu 

12 Test your system 
Make a simple copy to test your system. 

 See the section on “how do I… Make a Copy” for details. 

13 Verify Scan to File functionality 
Scan to a network PC to test Scan to file functionality. The PC must have WIDEsystemNET installed and must 
be setup for network scanning.  

 See instructions on setting up a PC for scan2net in WIDEsystemNET on-line help. See more on 
scanning to a PC in the section “How do I… Control from the iJET Panel – Scan to local or network PC” 

14 Verify Shared Scanner functionality 
The netwok PC must have WIDEsystemNET and compatible scan/copy software installed. Check that you can 
identify the scanner from the PC and perform a test scan.    

 See instructions on setting up a PC for scan2net in WIDEsystemNET on-line help. See more on using a 
shared scanner in the scan or copy application’s on-line help. 
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3.3 Connect the Scanner to a PC - Scan/Copy workstation  
Components: Wide format copy scanner and PC. For scanning to file and saving on local PC. 
If this configuration is to be used for copying purposes, it must include a printer that is either 
connected directly to the PC (local printer) or the PC can be connected to the network and have 
access to network printers. 
 
Usage: For digitizing large format documents. Used for scan-to-file (digitized) output only 
unless a printer is attached to the PC or PC to network printers. Operation is possible both from 
the iJET Panel and from the PC. 
 
System Requirements:  
• Wide Format Copy scanner 
• PC with Compatible operating system (see ws/readme.htm on WIDEsystem TOOLS CD)   
• USB port on the PC 
• The WIDEsystem TOOLS CD supplied with your scanner. 
• Scanning software or compatible third party software. 

 
NOTE: Scanning and Copying in this configuration would often be performed through scan 
and copy software installed on the PC rather than through the scanner’s iJET Panel. 
Usage of scan and copy software is not within the scope of this operator’s guide. Please refer to 
the software’s documentation and on-line help for instructions on using the software with the 
scanner. 
Users can scan-to-file to the PC from the iJET Panel in this configuration. See the section “How 
do I Scan to File?” in this guide. 
 
 
 
 

 Scanner’s USB device (input) interface
 

 
 

Step  Description 

1 Insert the WIDEsystem TOOLS CD-ROM into your PC. 

IMPORTANT : DO NOT YET CONNECT THE SCANNER TO POWER OR PC. install WIDEsystem 
before you connect the scanner or install any scanner software applications. Your scanner drivers are 
automatically installed with WIDEsystem and your PC will then be fully prepared to detect and setup the 
newly connected scanner device.  
Start up the WIDEsystem TOOLS CD-ROM by inserting the CD-ROM into your PC. Normally the setup 
program interface will start automatically. If it does not, perform the following steps to activate it. 

Click the Start button on the Taskbar and choose Run from the menu. 
Type D:\setup in the Command Line Box (where D: represents the name of your CD-ROM 

drive). 
Choose the OK button. 

 Important: Be sure to use the WIDEsystem TOOLS CD-ROM that came with your scanner or a 
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newer version. Out-of-date versions of WIDEsystem software may not detect your scanner model.  
 

2 Install WIDEsystem Software 
Click on the option Install WIDEsystem Software from CD main menu or run the setup.exe program 
directly from the WIDEsystem (ws) folder on the CD-ROM. Follow the installation instructions that appear 
on your screen. 

3 Install Scanner Maintenance Software 
Click on the option Install Scanner Maintenance Software from CD’s menu. Follow the instructions that 
appear on your screen. 

4 Shut down (power off) the PC 
Your PC is now prepared and must be powered off before connection with the scanner. 

5 Perform Preliminary Maintenance – Cleaning  
Clean your scanner’s flat surface so dirt and dust are not dragged into the scan area with the original. 
Clean the internal Scan area.  

 See the section “Scanner Maintenance” for instructions on accessing the scan area and cleaning 
for your specific scanner model. 

6 Set up your scan station and control the smart card 
Your wide format copy scanner should be placed either on the specially designed stand-alone floor stand 
or on a sturdy table. For sheet feed models, make sure there is enough space behind the scanner to 
allow the media to run out.  
Make sure that the scanner’s smart card is in place. 

  See the sections “Physical Placement of the Scan Station” and “Maintenance-Locate the Smart 
Card” for detailed instructions for your specific scanner model. 

7 Connect the interface cable – scanner end 
Connect the USB interface cable to the scanner’s USB device (input) port (squared formed socket). See 
the document: “NOTE ON INTERFACE CABLES” for instructions on the specific interface cable type to 
use with this configuration. 

USB device (input)  port 

 
 

 

 See the section “Locating the Interface Cable Connector Panel” for instructions relating to your 
specific scanner model. 

 Connect the interface cable – PC end 
Connect the other end of the USB cable to the PC’s USB connection port (flat rectangle socket). 

8 Connect scanner power cable 

The scanner is equipped with a three-wire (pin) grounding type plug. If you cannot insert the plug 
into your outlet, contact your electrician to replace the outlet and ensure a grounded power connection. 
Do not try to defeat or ignore the purpose of the grounding-type plug. 
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9 Turn on the Scanner 
To turn on the scanner - at back of the scanner, plug in the power cable and flip the Outlet Switch to ON. 
The scanner starts the init and self test sequence. 

 Power outlet and switch is found at the back of the scanner 

10 Turn on the PC 

 Make sure the PC connected to the scanner is likewise power-connected to a grounding-type power 
outlet with a three-wire (pin) grounding type plug. 

11 Verify installation of new hardware 
Double click on the WIDEsystem scanner icon on the Windows system tray. The program should detect a 
Selected Scanner in the dialog.  

12 Run preliminary Scanner Maintenance - Maintenance program 
Left click on the WIDEsystem scanner Icon and select Launch Scanner Maintenance from the menu. 
Follow the instructions on your screen.   

 
NOTE: On Windows Compatibility - Your scanner and drivers are tested and developed to 
support the most current active Microsoft Windows version OS systems. Drivers and interface 
support in regard to specific Windows versions will follow the Microsoft Support Lifecycle Policy. 
The compatibility specifications can therefore change accordingly. The most current OS 
compatibility specifications and drivers will be available on your manufacturer’s website.  
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3.4 Combining Configuration Types for Multiple Functionality 
Although they were described separately, the three configurations: Stand alone copier, Scan/ 
Copy device on a network, Scan/ Copy station on local PC can be combined to provide multiple 
functionality.  For most companies, a combined solution would be recommended to get the 
most out of the scanner and provide a flexible, multi-purpose device.  
 
 

 Scanner’s USB device (input) interface 

 Scanner’s USB host (output)  interface 
i t f

Scanner’s LAN interface

 
 
In the example illustrated above, we have connected both a printer and a PC directly to the 
scanner and both the scanner and the PC are each attached directly to the network. This 
means that the configuration can be used as a stand alone copier, a stand alone scan-to-file 
station, a device for saving scans to network PCs and a shared device that can be controlled 
and used by network PCs. The scanner can use both the local printer and printers on the 
network.  Both scan-to-file and copying can be performed either through the iJET Panel or 
through scan/copy software.  
Use the instructions for each configuration in the previous sections for setting up a combined 
solution. You will find that many of the steps are general and apply for all configurations so you 
only need to perform them once. 
 
NOTE: Your Copy Scanner supports a single LAN connection port. This means that if you 
connect a printer directly through this port, you will not be able to set up a combined solution 
with network accessibility. You can use LAN switch boxes to work around this problem. It is 
advisable to use the USB host (output) port for direct printer connection if USB connectivity is 
supported on the printer. 
 
Regulatory Notice: Your scanner product has been tested to comply with the EMC Standards 
EN55022 and FCC, Part 15. To maintain compliance, only use the interface cables supplied 
with the scanner.  
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3.5 Physical Placement of the Scanner 
Please follow the guidelines below for optimal safety, scanner functionality, and scanning 
results. 
 
Physical placement of the scan station: 

On Scanners:  
 
Your wide format flatbed scanner should be placed on a sturdy table. If convenient, you can 
place the backend of the scanner against a wall. The lid will not open all the way back and 
stops at an approximate 650 angle.  
 
Physical placement of the scan station: 

On Scanners:  
 
Your wide format scanner should be placed either on the specially designed stand-alone floor 
stand or on a sturdy table. Make sure there is enough space behind the scanner to allow the 
media to run out. Thick stiff media naturally requires space that is at least as large as the media 
length. 
 
Physical placement of the scan station: 

Guidelines that apply for all scanners:    
 

 Slots and openings in the cabinet at the back and bottom are provided for ventilation. This 
ensures reliable operation of the product and protects it from overheating. These openings must 
never be blocked or covered by placing the unit on a bed, sofa, rug, or other similar soft 
surface.  
 

 Your scanner should never be placed near or over a radiator or heat register.  
 

 You should not place the scanner in a built-in installation unless proper ventilation is 
provided. 
 

 The scanner is equipped with a three-wire (pin) grounding type plug. This plug will fit only 
into a grounding-type power outlet. This is a safety feature. If you cannot insert the plug into 
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your outlet, contact your electrician to replace the outlet and ensure a grounded power 
connection. Do not try to defeat or ignore the purpose of the grounding-type plug.  
 X 

 
 Make sure the PC connected to the scanner is likewise power-connected to a grounding-

type power outlet with a three-wire (pin) grounding type plug. 
 
 

  See also the Safety Instructions at the end of this operator’s guide. 
 
 

3.6 Locating the Interface Cable Connector-Panel 
Your scanner’s interface cable connectors are grouped in a cable connector panel. You will 
need to locate the cable connector panel in order to insert interface cables when setting up the 
system. You can find your scanner’s cable-connector-panel as follows: 

On Scanners:  
 
The scanner has LAN, USB device (input) and USB host (output) interface connectors grouped 
in a cable-connector-panel. The cable-connector-panel is found at the back of the scanner. 

 
The cable-connector-panel is found on the scanner’s back. 
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Locate the cable-connector-panel 

On Scanners:  
 
The scanner has LAN, USB device (input) and USB host (output) interface connectors grouped 
in a cable-connector-panel. You will find the cable-connector-panel by removing the scanner’s 
right side cover. You feed the interface cable through the opening in the back of the scanner 
until it emerges in front of the cable-connector-panel.  

 Be sure to reattach the cover after you connect the interface. The cover must always be 
closed before you turn the scanner ON. 
 

 Remove the scanner’s right side cover Interface connectors (cable-connector-panel) 

    
 
 

 

Feed the interface cable through the hole in the back until it emerges in interface area.  

Interface area is behind the cover 
 

 
 
 

 



Configuration and Setup    3-16 

3.7 Personalizing and Localizing Your System 
The iJET Panel options can be configured to match your local standards regarding the 
language displayed in the menus, paper size series (preferred standard size systems such as 
“ARCH” and ISO A) and media handling (original’s loading method). 
NOTE: The number of languages available for the panel is limited.  
  

3.7.1 Setting the iJET Panel’s Display Language 

On scanners:    
 

  On the iJET Panel 
1. Select the Menu button.  

2. Use the arrow button up or down until the display windows shows Advanced and confirm 
with the Enter button  . 

Menu 

Enter 

3. Use the arrow buttons up or down   until the display shows Options and confirm with 
. Enter 

4. Use arrows down/up    until the display shows Language.  . 

 

Menu option item 
Current setting for option item 

  > Language 
   English  

5. Confirm with . The “>” marker will move down to the option setting line so you can 
change it. 
 

Enter

6. Your display should look like this (the actual text to the right of the “>” will show the current 
setting for the option and may be different than the one shown below). 

 

Menu option item 
Current setting for option item 

    Language 
> English  

7. Use arrows down/up    to select the language you want to use for the texts in the iJET 
panel’s disply and confirm with  .  Enter
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3.7.2 Setting the Paper Series Preference 
Depending on your location and business, you may usually work with a specific standard paper 
series. This option lets you tell the system which paper series you want displayed when you set 
the Size (input size) option. You can also tell the system to always display all the paper series’ 
in the system.   

On scanners:    
 

 On the iJET Panel 
1. Select the Menu button.  

2. Use the arrow button up or down until the display windows shows Advanced and confirm 
with the Enter button  . 

Menu 

Enter 

3. Use the arrow buttons up or down   until the display shows Options and confirm with 
. 

4. Use arrows down/up    until the display shows Paper Series. 

5. Confirm with . The “>” marker will move down to the option setting line so you can 
change it. 
 

Enter 

Enter

6. Your display should look like this (the actual text to the right of the “>” will show the current 
setting for the option and may be different than the one shown below). 

 

Menu option item 
Current setting for option item 

    Paper Series 
> ALL  

7. Use arrows down/up    to select the paper series (...ARCH, ANSI, ISO A...) you want to 
use when setting the paper size and confirm with Enter . You can also select ALL if 
you need to use more than one paper series.  

 

 

Enter
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3.7.3 Setting the Media Handling (load) Method Preference 
This option lets you tell the system how you want to load originals into the scanner.  

On scanners:   (not relevant on flatbed models) 

 On the iJET Panel 
1. Select the Menu button.  

2. Use the arrow button up or down until the display windows shows Advanced and confirm 
with the Enter button  . 

Menu 

Enter 

3. Use the arrow buttons up or down   until the display shows Options and confirm with 
. 

4. Use arrows down/up    until the display shows Media Handling and confirm with 
. 

5. Your display should look like this (the actual text to the right of the “>” will show the current 
setting for the option and may be different than the one shown below). 

 

Enter 

Enter 

Menu option item 
Current setting for option item 

   Media Handling 
>Auto Load  

6. Use arrows down/up    to select the method you want to use and confirm with . 
Auto Load  means the scanner will pull the original into the scan area as soon as you insert 
it into the slot.  You can set a Load Delay factor with Auto Load (see next step). Manual 
Load means you insert the original and press on the panel’s feed forward button.  

Enter 

7. If you selected Auto Load and want to change the delay factor – Make sure the Media 

Handling option is marked with the “>”. If not press enter to move it up. Use arrow down   

to reach the Load Delay option. Confirm with Enter . Use the arrows     to set a 
Load Delay factor and confirm with  .  These steps are illustrated below.                                      

 

Enter

Enter

Press Enter  to confirm  
Auto Load

    Media Handling 
> Auto Load  

The the ‘>’ mark will have moved 
up to the menu option line - Media 
Handling.

> Media Handling 
    Auto Load  
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3.8 Printer Setup on the Scanner  
In order to be operated from the iJET Panel, your copy scanner needs to recognize a printer. 
The setup procedure depends on whether you connect a printer through the USB host (output) 
port or through a LAN port (either directly or indirectly). Direct connection through the LAN port 
will require that you enter the local printer’s IP address. If you connect to the network through 
the LAN port and want to use a printer on that network, you will have to enter the network 
printer’s IP address. 

>  Load Delay 
    0 Use arrow down  to reach the  

Load Delay  option. Press Enter

    Load Delay 
> 3 Use arrows  to change the 

Load Delay  value and confirm with 
Enter . 

On scanners:     
 
To apply printer setup settings: 
 

 On the iJET Panel 
1. Select the Menu button.  Menu 

2. Use the arrow button up or down     until the display window shows Advanced and 
confirm with the Enter button  . Enter

3. Use the arrow buttons up or down   until the display shows Printer Setup and confirm 
with . 

 

Enter 

Press Enter  to confirm  
Printer setup

> Printer Setup 
… 

4. You can set up a Color Printer and a B&W Printer (max 2 printers at a time). Press 
to reach the Color Printer option.  

 

Enter 

 > Color Printer 
… 

5. Press  to confirm Color Printer and reach the Interface option and  again to 

confirm Interface.  Use arrows down/up    to select USB or LAN, depending how you 
connected your color printer and confirm your selection with . 

Enter Enter 

Enter

   Interface 
> USB Use arrows 

 
 to change the Interface setting. Press Enter  to confirm. 
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6. c d to the scanner’s  

Press arrow down  to display the IP setting dialog and then . The default IP 

e 

7. 

o select the Printer Model setup method: Press arrow down  to reach and display the 

     to display one of the following Printer Model options and 

7.1 

e the printer’s parameters automatically from the 
ystem searches for the printer on the port as indicated by your Interface 

If you are using LAN interfacing, either with a printer directly c te
LAN port or to a remote printer on the network, you will need to set the printer’s IP address. 

onne

shows 4 groups with 3 zeros in each group. Use the arrows up/down     to change th
first group (3 digits). Press  to move to the next 3 digit group and again the arrows 
to change them. Repeat this with each group until you have the right IP displayed and 
press Enter o confirm.   

T

 t

 
 

You must now set definitions and parameters for the actual Printer Model. Printer Model 
settings can be set in 3 ways (methods): automatically, by selecting a printer model from a 
list of predefined printers or through making custom settings manually.  

Printer Model dialog and then  to move the “>” mark down and thus enter the 
Printer Model options.  
 

Use the arrows up/down
p

Auto Configure tells the system to retriev

ress  to confirm your selection: 

Auto Configure 

printer itself. The s
setting (USB or LAN-IP address) and then when it

the Custom Setup options instead. The printer must support SNMP in order for its settings 
to be detected automatically. 
 

 finds it, the printer’s setup parameters 
are saved in the scanner device.  
Not all printer models support automatic setup and you will need to use the Printer List or 

NOTE: the actual search and s
to print and not during setup. It is therefore recommended to make a dispensable test copy
just after completing the steps for setting up your scanner. 
 
 

 
 
 

ettings upload process takes place the first time you try 
 

 

   Printer Model  
> Auto Configure 

Enter 

   Printer Model 
> Auto Configure 

Enter

Press  to reach the IP setting dialog. 

    Interface 
> LAN 

Use the arrows to change the IP 
values as described above. 

   IP Address 
> xxx.xxx.x xxx.xx  

Enter

Enter 

Enter
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7.2 rinter List 

 you select Printer List and confirm with enter, you will be able to select an actual printer 
odel by its name.  The model names that appear in the Printer List indicate printers that 

lly tested for compatibility with your copy scanner and their setup parameters 

P

If
m
have been fu
are ready in 

confirm your printer model selection. 
 

the system.  

Use the arrows up/down     to move through the list of printers and press  to 

NOTE: New printer models may become available in the list with new firmware 
upgrades. 

Custom Setup 

 Printer Model - Custom Setup option lets you configure a printer manually. This
gives you th

7.3 

The  option 
e freedom to use other printers than those compatible with the Auto Configure 

e that have been tested and are available through the Printer List method.  method and thos
 

To Ensure the Right Settings for your Printer: Your scanner manufacturer’s support 
pages on the web will provide lists and tables containing recommend settings for specific 
printer models that should be compatible with the scanner but are not tested. Printers on 
the website’s list are similar to tested models. Look for your printer model on the list and 
enter the recommended settings in the Custom Setup options. The website lists will be 
u

e list, you can try to use the printer’s 
documentation to determine the right settings. Please note however that unlisted printers 
may not be compatible with the scanner.   
 
Here follows a short description of the parameter settings. Use the arrow button up or 

down     to move through the options. U Enter
selection. Use again the arrows to change the option values and again the Enter button 

 to confirm your setting. 
 

pdated as new printers enter the market.  
If your printer is not named on the websit

se  to activate the option’s value 

Option Values Description 

Command Set RTL or PCL3GUI This is the printer’s format language  

Ctrl. L e anguage None or HP PJL The control language is used internally by the system to apply som
of the others settings, such as resolution, size, etcetera. 

Orientation Landscape/Portrait 
Feeding orientation for printer. On most large format printers this will 
be landscape while on some of the narrower models it will be Portrait.
 

Scalable No/Yes 
‘No’ means that  the scanner will take
data to the printer.  

 care of scaling before sending 

‘Yes” means that the printer will take care of scaling. 

   Printer Model 
> Custom Setup 

 

Enter 

   Printer Model 
> Printer List 

 

Enter 
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Resolution 300,360,600,720 This is the printer’s fixed resolution 

The printer is defined to be of a certain max standard size - A0, A2 
etcetera.   Printer Size e 

list 
A0,A1,A2….paper siz

Render Type o Simple/ Ctx Default/N
format Scan to print data protocol. See the lists fro right selection. 

 
by looking at the area that was Yes – The printer will cut the output 

actually printed.  Use Inked Area No/Yes 
No – use the whole paper size to determine the place to cut.  

 

t steps ith B&W Print vious 
step: Use the Back button   

arrow down 

8. Repea  4 – 6 w er. To reach the B&W Printer option from the pre
to move back to Color Printer in the menu and then Back 

 to reach the B&W P

 

You  fo
Otherwise, your color copy output colors will not 
qual s ice (scanner) and output device (printer) 

 is a unit that stores data 

e 

edia type so you will need to 
create new media profiles if any of these (printer or print-media) are changed.  

rinter option.  

3.9 Creating Media Profiles – For Color Printer Setup 

must create a Media Profile ch media type you use with the specific color printer. 
necessarily match the original’s colors. Optimal 

ity color result  are only obtained if the capture dev

r ea

"see" colors in the same way on a given output media. A Media Profile
that matches scanner and printer colors on a given media.  

Before you start a copy job, you select a Media Type (Menu button) that corresponds with th
media in your printer and the Media Profile you prepared. By this action you are harmonizing 
scanner, printer and media color factors for achieving optimal color precision in your copies. 

A Media Profile is connected solely to a specific printer and m

 

  On the iJET Panel 
1. Select the Menu button.  Menu 

2. Use the arrow button up or down     until the display window shows Advanced and 
confirm with the Enter button  . 

 

3. e display shows Options and confirm with 

 

 

Enter 

> Advanced 
   … 

Use the arrow buttons up or do   until thwn 
. Enter 

 > Options 
   … 
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4. Closed Loop Cal  should be displayed as the first option. If not use the arrow down 

 

button to reach it. Press  to confirm.  

5. Your display should now look like this (the actual text on the 2. line will show the  

Enter 

 > Closed Loop Cal 
   … 

current
setting for the option and may be different than the one shown below). 

M

 
 

enu option item Media Profile 
Current setting for option item 

> Media Profile 

6. Press  to move the “>” mark to the current setting so you can change it. Use the 

arrow buttons up/down   until you reach the media type (Coated, Semi Glossy, 
Glossy…) that describes the media in your printer. Press  to confirm.  

7. On “Print Sheet” select Enter. The system will print a color patch sheet. 

8. 

9.   ill scan the 
 the current media 

 ying, you will select the option for the Media Type that 

 for the job.  

   Coated 

Enter 

Enter

 
Feed the sheet into the scanner  

The display will now show “Scan Sheet”. Select  to The system w

 > Print Sheet 
t     ‘En go… er’ to

start.
color patch sheet and calculate color matching values for future jobs with
type. 

 

Enter

 > Scan Sheet 
   ‘Enter’ to go… 

10. When you use the system for cop
matches the media loaded on your printer. This is done through the Menu button. The 
system will then load the corresponding Media Profile and use it to create optimal color 
output

 Read more on Media Type selection under the section How do I ma
Other Copy Options - How do I Set the Media Type. 

ke a Copy – 

 

 

 

 

 

 

 

 

 

 

 



Configuration and Setup    3-24 

3.10 Scanner on Network Setup  
 order to be recognized on the network, your copy scanner needs to identify itself. Some 

etworks support DHCP which will enable the scanner to extract its network setup information 
rks, you will have to enter the network ID 

formation manually. 

In
n
automatically from the network. On other netwo
in

On scanners:    
 
To apply the scanners network setup settings: 
 

 On the iJET Panel 
1. Select the Menu button.  

 until the display window shows Advanced and 

3.   until the display shows Network Setup and confirm 

4.  DHCP or not. Follow one of the scenarios 
below: 

 

1.  DHCP Setup and 

 

. Use arrows down/up    to select YES and confirm with 

Menu 

2. Use the arrow button up or down    
confirm with the Enter button  . 

Use the arrow buttons up or down 
with . 

Enter 

Enter 

 
The rest depends on if your network supports

If your network supports DHCP: 

Use the arrow button up or down     until the display window shows
confirm with  to move the “>” marker down change the setting. 

2 Enter . The scanner will then 

 
 
 
 
 
 

get its network setup information directly from the networks DHCP server. 

 
Change value to “YES”  and confirm with Enter       DHCP Setu

> YES 
p 

Press Enter to confirm DHCP 
setup  

> DHCP Setup 
   NO 

Enter

Press > Network Setup Enter  to confirm  
… Network setup

 



Configuration and Setup    3-25 

If your network does not support DHCP: 

1. m your network 
administrator.  

2. Use the arrow button up or down     until the display window shows DHCP Setup and 
confirm with  to move the “>” marker down change the setting. 

 

 and confirm with 

 
Get the values IP Address, Subnet Mask and Gateway Address fro

Enter

3. Use arrows down/up    to select NO Enter . The scanner will then be 
 you enter manually in the next steps. . 

 

identified on the network with the values

4. Use the arrow buttons up/down   until the iJET Panel displays IP Address and confirm
with  

 
Enter .  

5. up/down The default IP shows 4 groups with 3 digits in each group. Use the arrows  to 
change the first group (3 digits). Press  to move to the next 3 digit group and again 

  
the arrows to change them. Continue with each group until you have the right IP displayed 
and press Enter  to confirm. 

 
 

6. Use the arrow buttons arrow buttons up/down  until the iJET Panel displays Subnet 
Mask and confirm with Enter . 
IP address belongs to.  Use the up/down arrow to 

Subnet Mask is a mask used to determine what subnet an 
change a digit’s value in the same 

manner as described above for the IP Address. Confirm with Enter  

Use the arrow buttons arrow buttons up/down 7.  until the iJET Panel displays Gateway 
Address and confirm with Enter . A Gateway addr the IP address of a network point ess is 
that acts as an entrance to another network.  Use the up/down arrow to change a digit’s 
value in the same manner as described above for the IP Address. Confirm with  Enter  

 

 

 

 

 

Use the arrows to change the IP 
values as described above. 

 

 

   IP Address 
> xxx.xxx.xxx.xxx 

Enter

Enter

Change value to “NO”  and confirm with Enter       DHCP Setup 
> NO 

Press Enter to confirm DHCP 
setup  

> DHCP Setup 
   YES 
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3.1
You

quires that you first have setup the scanner to be recognized on the network as described in 
e previous section “Scanner on Network Setup”. The following will describe how to enable 

our scanner to be shared.   
OTE: Using a shared scanner from a PC on the network will require scan and copy software 
lus drivers installed on that PC. The scan/copy software must be compatible with the scanner 
nd shared scanner functionality. See your scan/copy software documentation for details and 
structions. 

1 Setup to Share the Scanner (Use from PCs on the LAN) 
r scanner can be setup to be used for scanning from PC stations on the network. This 

re
th
y
N
p
a
in

On scanners:    
 
To enable a scanner for sharing: 
 

 On the iJET Panel 
1. Select the Menu button.  Menu 

2. Use the arrow button up or down     until the display window shows Advanced and 
confirm with the Enter button  . 

3. Use the arrow buttons up or down   until the display shows Network Setup and confirm 
. 

 

4.  up or down     until the display window shows Share Scanner 
er down in order to change the setting. 

5. Use arrows down/up    to select YES and confirm with 

with 

Enter 

Enter 

Use the arrow button
and confirm with  to move the “>” mark

 

Enter . The scanner will then 

6. 

 

 

 

be enabled for shared scanning from PCs on the network. 

 
Reboot the scanner to ensure that the setting is applied on the network.  

 

Change value to “YES”  and confirm with Enter       Share Scanner 
> YES 

Press  Enter to confirm Share Scanner setup and 
move the ‘>’ marker down to change the setting.  

     Share Scanner 
 > NO 

Enter 

Press > Network Setup 
… 

Enter  to confirm  
Network setup 
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4. Loading Originals for Copying and Scanning 

How do I Load Originals into the Scanner? 4.1 

n Scanners:  O

T
1

o load an original into the scanner: 
. Open the lid backwards. 
. Place your document, face down, on the glass plate. Align the document edges against the 

n the document middle 
use the standard size 

 size.  

 

4. 

2
alignment guide bar at the scanner’s left side for a straight scan. Alig
with the center arrow marking on the alignment bar. You can 
markings to position the original and measure its standard

3. Close the lid over the document. 

 Open the scanner lid  

Place the original face down on the glass plate.  

 
Loading Originals 

On Scanners:  

You can use manual loading or automatic loading. To select your loading method: 

  On the iJET Panel 

the Menu button.  
2. Use the arrow buttons right/left until the iJET Panel displays Paper Setup and confirm with

Media Handling and confirm with OK 

Menu 1. Select 
 

the OK button. 
3. Use the arrow buttons right/left until you reach 
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4. Use arrows down/up to select the load method – Auto Load or Manual Load.  Confirm with 
OK.  

5. With Auto Load you can select a delay factor if the document is grabbed too fast. Press 
arrow right to reach Load Delay and arrow down/up to set a delay factor between 0-1000.  

1. nter with the scanner’s center arrow guide marker. 
2. Push the original into the insertion slot until you feel it contact the rollers. 

gh (yellow for thick media) when the original is positioned 

4. e original in place with one hand, use the other hand to press and hold 

lot. 

1. Align the original’s center with the scanner’s center arrow guide marker. 
 slot until you feel it contact the rollers. 

 original is positioned 

n position.  

4.2 ick Media 

m

 
How do I load the scanner with … 

manual loading - you determine when the scanner pulls in the original:   
Align the original’s ce

3. The Paper Ready LED li ts green 
correctly for a straight scan path. 
While holding th
down the Paper Forward button on the scanner. 

5. The original moves into the start-scan position. 

automatic loading - the scanner takes the original as soon as you insert it in the paper s
Automatic loading is reliable for most jobs and especially useful for batch scanning jobs. 

2. Push the original into the insertion
3. The Paper Ready LED lights green (yellow for thick media) when the

correctly for a straight scan path. 
4. The scanner will grab the original automatically and move it into start-sca
 

 Loading and Scanning Th
You may need to digitize or copy images printed or pasted on thick media such as cardboard, 

boards, gatorboards etc.  foa
 

On Scanners:  
 
Your flatbed scanner can accommodate originals up to 1,5” ( 38 mm,) thick while still allow
ou to close the cover. For very thick originals you can leave the cover open. 

ing 

On Scanners: 

y
 

   
 
These scanners support Automatic Thickness Adjustment Control (ATAC). There is an ATAC 
key on the iJET Panel. You use the key to raise and lower the pressure-platen. You can change 

re-platen height) on your scanner from 2mm to 15 mm (up to 0.6”). 
mm thick sh uld be scanned with the pressure platen all the way down (normal 

the insertion slot size (pressu
riginals up to 2 oO

position). Thicker originals will require you use the ATAC key to adjust for thick media.  
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ATAC Key Paper Ready Indicator Paper Forward      Paper Reverse

 
 
 
 
Adjusting the insertion slot for thick media with ATAC: 
 

1. Press the ATAC key on your iJET Panel to set the scanner in ATAC mode.  

2. The Paper Ready Indicator blinks yellow indicating the scanner is in ATAC mode but not yet 
ready, i.e., the pressure-platen is not yet positioned on the thick original.  

 
3. Press and hold the Paper Forward key (arrow up) key to raise the pressure-platen until 

there is room to insert the thick original.  

 
4. Insert the thick original evenly for a straight scan path. 

laten til the 5. Press and hold the Paper Reverse (arrow down) key to lower the pressure-p un
pressure-platen stops on its own.  

 
6. The Paper Ready indicator will turn yellow (stop blinking) when the pressure-platen is 

positioned correctly and is ready for thick media scanning.  
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7. Once the thick original is loaded, the scanner will automatically leave the ATAC mo
which means that the Paper Forward an

de, 
d Paper Reverse keys will return to their normal 

functionality for moving the original forwards and backwards. 

8. It is important to help support the thick original during scanning - both at the entrance side 

 

. 

and the exit side of the scanner. 

 

 Pressure Platen in UP position - Press and hold the Paper 
Forward key (arrow up) key to raise the pressure-platen.  

9
 

 
About Thick Media Settings and Auto Adjustment 
 

On scanners:  
 
Scanner’s Auto-adjustment – only in the Normal position. 
The scanner employs an automatic self-adjustment procedure (light profile, stitching etc.) that 
can only auto-activate when the scanner is in the Normal position. With prolonged scanning in 
extended thickness settings, you should from time to time return the scanner to its Normal 

ition to allow it to self-adjust. This will ensure refreshed self-adjustment and optimal 
performance of your scanner. Make a habit of always setting the scanner in the Normal position 

hen shutting down, so it can auto-adjust the next time you turn it ON 

OTE:The scanner runs at its optimal speed in the Normal position. To allow stable drive 
handling, scanning speed is automatically reduced when the scanner is in the extended 
thickness positions.  
 
 

pos

w
 
N
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5. How do I Make a Copy? 

.1 Copy Using the iJET Panel – The Basic Steps 5
Once the scanner is set up and configured to the needs and standards of your business, it 
becomes as simple to use as a conventional office copy machine. By “setup and configured” we 
mean that iJET Panel menu options such as original types and paper types are determined and 
et.   

n scanners:

s

     O
o make a copy: 

  

T
 
1. Load the original into the scanner.

  See the section “How do I load originals?” for information regarding your specific 
scanner model. 

 Set the Size of your original 
The value your set here determines the scan area. Usually this would be the size of the 
or

2. 

iginal unless you wish only to input a portion.  Press the Size button to activate size 
setting. 

You then change the value each time you again press the Size button

rrow up/dow  buttonsor with the a n   .  
 
NOTE: About the Size value: Size is a global system variable that can be changed in 3 

2. With the Menu button > Size option and 3. With 
ou change the size for a copy job, 

it will

3. detection or a standard size setting. Auto will detect the edges of the 
original and set the scan area to the full original size. Press 

different ways: 1. With the Size button 
the Scan-to button > Size option. This means that when y

 also apply for a scan-to-file job and vise versa until you change it again.   

You can select Auto 
Enter  to confirm your setting. 

4. 

 

 Apply 
The iJET P

Copy Output Settings 
 

these if needed. Otherwise, go to the last step where you start copying with the current 
anel offers quick buttons for common copy output settings. Apply one 

settings.    

          

or more of

 Detailed Instructions on using each of these buttons plus other copy options 
accessed through the Menu button follow in this “how do I…Make a Copy?” section. 

Size Size 

Change the value (Auto or a standard size) and 

press  Enter  to confirm. 
     Size 
 > Auto 

ScaleCopies QualityLightness 
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 Press the appropriate copy button.  5. 

• Press the B&W Copy button for B&W copy jobs.  

• r color jobs.  

 

 

B&W 
Copy 

Color 
Copy 

Press the Color Copy button fo
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5.2 Main Copy Options - Quick buttons  

his section describes the main copy options you can set with the iJET Panel’s quick buttons. 
he buttons are:  

         

 
T
T

Lightness Quality Copies Scale 
 
 
 
 
 
 
 
 

Lightness Quality

Copies Scale
 

 
 
The buttons Lightness, Copies, Quality and Scale are shortcuts into the iJET Panel Menu 
system to options you can reach through the Menu button. This means that each of the copy 
functions described in this section (copy image Lightness, copy Quality, number of Copies and 
Scale – output size in relation to the original ) can be set both by pressing the corresponding 
Quick button and by entering the Menu and navigating to the function. 
 
There are additional copy options in the Menu that are not accessible through quick buttons and 
can only be reached and set by way of the Menu button. These are Org. Types, Sharpen, 
Background Clean, Media Type, Mirror, reset and Advanced. These copy options will be 
described in the next section “Other Copy Options – Menu Button. 
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5.2.1 How do I… Set Copy Lightness? 
You can change the Lightness value to make the copy lighter or darker and compensate for dull 
or faded originals. The default Lightness value is set to zero which works well with most 
documents. Values +1 to +6 will make the copy lighter in relation to the original and values -1 to 

 will make the copy darker in relation to the original. -3
 
To set the copy Lightness value: 

 On the iJET Panel – 

1. Quick - Press the Lightness button.  The iJET Panel display will open the 
Lightness option with the “>” marker on the value level indicating you can immediately 
change the Lightness option’s value. From here you can skip steps 2 and 3 and go to step 4 
to change the value.  

 
2. Menu – Press the button to enter the main Menu.  

Use the arrow up/down buttons   to move through the Menu options until the display 
shows Lightness. 

 
3. Press  Enter  to move

value.  
 the “>” marker down to indicate you want to change the Lightness 

4. 

5.  value forward in 

6. 

 
There are two ways to change the value: 
 
Repeated presses to the Lightness button will change the Lightness
single steps from -3 to +6. The value list wraps around meaning that you step from +6 to -3 
when you continue to press the button. 

 

Or…press the arrow up/down buttons   to change the Lightness value. With these 
you can step both forward and backward in the value list.  
 

7. Select a positive (+) value from the list to make the copy lighter. Select a negative (-) value 
from the list to make the copy darker. 

the 8. Press  Enter  button to accept the selected value. The “>” marker will move up to the 
Menu level indicating that the value is set and you can step on through the menu options if 
needed. The new Lightness value will be applied every time you press the B&W Copy or 

s above to change it.   

 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down 
buttons. 

Color Copy button until you repeat the step

   >  Lightness 
     +2 

  Lightness 
 > 0 lightness 

  Lightness 
  >+ 1 lightness 

  Lightness 
 > +2 …..

Lightness

n to the value level so you can 
 value.  

      Lightness 
 > 0 

Menu 

    >  Lightness 
     0 

The “>” marker is dow
change the

       Lightness 
  > 0 
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2 How do I… Set a Scale factor? – Output size 5.2.

ale 
100% 
100% 

 

In the beginning of this section (How to… make a copy) we described how to set the input size 
with the Size button. You can enlarge or reduce this size in your output copy through the Sc
option. The Scale value is defined as a percent (factor) of the original. A scaling factor of 
means that the copy inherits the original’s size, under 100% means it is reduced and over 
means it is enlarged. The scaling factor can be selected from a list of predefined factors and if 
needed, these can be fine tuned to create your own factors.  

To set a Scale factor: 

 On the iJET Panel – 

Quick - Press the Scale button.  The iJET Panel display will open the Scale  
option with the “>” marker on the value level indicating you can imm

1. 
ediately change the 

 

Scale

Scale  option’s value. From here you can skip steps 2 and 3 and go to step 4 to change the 
value.  

      Scale % 
 > 100 

2. Menu – Press the button to enter the main Menu.  

Use the arrow up/down buttons   to move through the Menu options until the display 
shows Scale %. 

Menu 

    >  Scale % 
     100 

 
. Press  Enter  to move the “>” marker down to indicate 

value.  
3 you want to change the Scale factor 

 
4. There are two ways to change the value: 

5. h 

 to 25 when you continue to press the button.  

 

6. Or…press the arrow up/down buttons

The “>” marker is down to the value level so you can        Scale % 
  > 100 change the value.  

 
Repeated presses to the Scale button will change the Scale factor value forward thoug
a list of predefined Scale factor values. The value list wraps around meaning that you step 
from 800

    Scale % 
 > 200 

Scale %
 > 201      

Scale

  Scale % 
 > 202 Scale 

   to change the Scale factor value in single 

e button as described above.  

 
 
7. Select a value larger than 100 to enlarge the image and smaller than 100 % to reduce the 

image.   

value steps. You can use this to fine tune one of the predefined values you reached by 
pressing the Scal

 > 200 
    Scale % 

 > 201 
  Scale % 
 > 202 

  Scale % 
 > 200 

Scale % 
 201  >
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8. Press the  Enter  button to accept the selected value. The “>” marker will move up to the 
Menu level indicating that the value is set and you can step on through the menu options if 

 

5.2.
You can determine the output quality. 
the highest amount of ink on inkjets. You may want to use the Fast quality setting for test 
copies. Yo can set Quality to one of its three options: Fast, Normal, Best.   
You can see which of the quality settings is active by the LEDs above the Quality button. The 

. 
  

needed. The new Scale value will be applied every time you press the B&W Copy or Color 
Copy button until you repeat the steps above to change it.   

The ”>” marker is
navigating the m

 

3 How do I…Set Copy Quality? 
The best quality will take the longest to output and use 

 on the Menu level. You can continue 
enu options with the arrow up/down 

buttons. 

   >  Scale % 
     201 

active setting will be the only one that is lighted. In the example below the Best setting is active
You can press the Quality button until the LED for the Quality setting you want to use lights up.

 
 
 Fast       Normal        Best 

Quality  
To set the copy Quality value: 

 On the iJET Panel – 

Quick - Press the Quality button.  The iJET Panel display will open the Quality 
option with the “>” marker on the value level indicating you c

1. 
y change the 

 

Quality
an immediatel

Quality option’s value. From here you can skip steps 2 and 3 and go to step 4 to change the 
value.  

      Quality 
 > Normal 

2. Menu – Press the  button to enter the main Menu.  

Use the arrow up/down buttons 

Menu 

  to move through the Menu options until the display 
shows Quality. 

 
3. Press 

    >  Quality 
     Normal 

 Enter  to move the “>” marker down to indicate you want to change the Quality 
value.  

 

5.  the Quality  will change the Quality value forward through 
Fast, Normal, Best. The list wraps around meaning that you step from Best to Fast when 

The “>” marker is down to the value level so you can 
change the value.  

     Quality 
  > Normal 

4. There are two ways to change the value: 

Repeated presses to  button

you continue to press the button. 
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The LEDs above the Quality button will show the active setting.   

 

6. Or…press the arrow up/down buttons

 

   to change the Lightness value. With 
these you can step both forward and backward in the Fast, Normal, Best ality list.  

7. Press 

qu
 

the  Enter  button to accept the selected value. The “>” marker will move up to 
the Menu level indicating that the value is set and you can step on through the menu 
options if needed. The new Quality value will be applied every time you press the B&W 

t the steps above to change it. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

Copy or Color Copy button until you repea   

 

 
 

 

 
 
 
 
 
 
 
 

    Fast   Normal   Best    Fast   Normal   Best Quality 

    Quality 
 > Fast 

   Quality   Quality 
 >Normal  > Best Quality Quality 

The ”>” marker is on the Menu level. You can continue    >  Quality 
navigating the menu options with the arrow up/down 
buttons. 

       Best 
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5.2.4 How do I… Set number of Copies? 
ou can tell the system to make multiple copies of the original in the scanner. You can set the 

 output between 1 and 50 copies. The default value is 1. 

o set the copy Copies value: 

Y
system to
 
T

 On the iJET Panel – 

. Quick Button Setting - Press the Copies button  The iJET Panel display will open 
the Copies option with the “>” marker on the value level indicating you can immediately 
change the Copies option’s value. From here you can skip steps 2 and 3 and go to step 4 to 
change the value.  

 

. Through the Menu – Press the button to enter the main Menu.  

Use the arrow up/down buttons 

1

2

  to move through the Menu options until the display 
shows Copies. 

 
3. Press  Enter  to move the “>” marker down to indicate you want to change the Copies 

value.  

 
4. There are two ways to change the value: 

5. Repeated presses to the Copies button Copies value forward in single 

6. 

 

 will change the 
steps from 1 to 50.. 

 

Or…press the arrow up/down buttons   to change the Copies
can increase and decrease the value.  

 value. With these you 

7. Press the 

 

 Enter  button to accept the selected value. The “>” marker will move up to the 
 

w Copies value will be applied every time you press the B&W Copy or Color 

 buttons. 

Menu level indicating that the value is set and you can step on through the menu options if
needed. The ne

 

Copy button until you repeat the steps above to change it.   
The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down

   >  Copies 
     3 

  Copies 
 > 1 Copies 

  Copies 
 >2 Copies 

  Copies 
 >3 …..

Menu

 

Copies

you can 
change the value.  

     Copies 
 > 1 

The “>” marker is down to the value level so        

    >  Copies 
     1 

Copies 
  > 1 
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5.3 Other Copy Options – Menu Button  
describeAs d in the previous sections, the copy quick buttons Lightness, Scale, Quality and 

Copies are shortcuts into the options accessible through the Menu button . In this 
section we will describe other options in the same Menu. These options are not accessible 

ed through the Menu button. The option features 
described here are more general than those behind the four quick buttons and they will 

The s described in the following subsections are:  
• Original Type Color and Original Type B&W 
• Sharpen 
• Background Cleanup 
• Media Type 

• 
• Advanced… 

through quick buttons and can only be reach

therefore not be needed as often.   
 

 Menu button option

• Mirror 
Reset 

 
 

 
 

5.3.1 How do I… Set Original Type Color?  
The original type setting – Org. Type-Color is your central input parameter for color copying and 
relates to controlling image capture with color originals. The Org. Type-Color tting tells the 

rocesses that are optimal for the color 
/Map” option will tell the scanner to 

s special parameters for originals that were created on 
kjet printers. 

se
system to use specific internal image enhancement p
original in question. For example, selecting the “CAD
optimize for high detail. The option you choose will be applied by the system when you press 
the Color Copy button. 

  
The available options for Org. Type-Color are described below. Note that for each original type 
there is an “Ink” version that contain
in
 

Org. Type Color 
Photo For reproducing photographs and posters 

Photo Ink For reproducing photographs and posters and  the original to be copied has been 
created (printed) with an inkjet printer. 

Brochure For documents containing both photos and text. 

Brochure Ink For documents containing both photos and text and the original to be copied has been 
created (printed) with an inkjet printer.  

CAD/Map Suitable for color CAD drawings, maps and graphics with a high level of detail. 

CAD/Map Ink Suitable for color CAD drawings, maps and graphics with a high level of detail and the 
ted (printed) with an inkjet printer. original to be copied has been crea

 
 
 
 

Color 
Copy 

Menu 
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To set the copy Original Type for Color:: 

 On the iJET Panel 

2. The Org. Type-Col

– 
1. Press the button to enter the main Menu.  

or option should be the first option to appear.  
Menu 

If it is not, use the arrow up/down buttons   to move through the Menu options until 
display sho

the 
ws Org. Type-Color as shown below. 

 
ss3. Pre   Enter  to move the “>” marker down to indicate you want to change the Org. Type-

 

4. Press the a

Color value.  

rrow up/down buttons   to change the Org. Type-Color value that matches 
ginal  

d 

 

. Press the 

the ori
created on an ink jet printer. The display shown 

and copy job. Choose one of the “(Ink)” original types if your original was
below is set for a brochure (document with 

photos an text) that was printed on an ink-jet printer. 

5  Enter  button to accept the selected value. The “>” marker will move up to the 
 set and you can step on through the menu options if 

needed. The new Org. Type-Color value will be applied every time you press the Color 
epeat the steps above to change it.   

 
 
 
 

Menu level indicating that the value is

Copy button until you r

        Org. Type-Color 
   > Brochure (Ink) 

enu level. You can continue 
 up/down 

The ”>” marker is on the M
navigating the menu options with the arrow
buttons. 

   >  Org. Type-Color 
      Brochure (Ink) 

The “>” marker is down to the value level so you can 
change the value.  

      Org. Type
to 

    >  Org. Type-Color 
      Photo 

-Color 
  > Pho
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5.3.2 How do I… Set Original Type B&W?  
 original type setting – Org. Type-BW is your central input parameter for B&W or graytone 
ying and relates to controlling image capture. The Org. Type-B&W setting tells the system
 specific internal image enhancement processes that are opti

The
cop  to 
use mal for the original in question. 

 
he available options for Org. Type-B&W are described below.  

For example, selecting the “Blueprint” option will tell the scanner to optimize for cleaning up 
background noise and enhancing image quality. The option you choose will be applied by the 
system when you press the B&W Copy button. 

 
T

B&W 
Copy 

Org. Type -BW 
Photo Photo is suitable for photographic images that contain many shades of gray. 

Blueprint 
Suitable for Blueprint and other originals with heavily distorted foregrounds and 
backgrounds. The shades that create image noise are close to the shades that 
represent the image's data and the two are hard to differentiate. 

Sepia 
Suitable for Sepia and other originals with heavily distorted foregrounds and 
backgrounds where the shades that create image noise are close to the shades that 
represent the image's data and the two are hard to differentiate. 
For copying clean and clear line drawings and text. Takes advantage of B&W Line thresholding 

CAD Suitable for black and white CAD drawings and graphics with a high level of detail. 
 
To set the Original Type for B&W copying:: 

 On th
1. Press

e iJET
 the 

e the arro

 Panel – 
button to enter the main Menu.  

2. Us w up/down buttons   to move through the Menu options until the display
 Type-B&W as shown below. 

 
Org.

. Press

shows 

 
3   Enter  to move the “>” marker down to indicate you want to change the Org. Type-

 

4. Press the arrow up/down buttons 

B&W value.  

  to change the Org. Type-B&W value that matches 
h the original and copy job. The display shown below is set for Line originals (documents wit

line drawings and text). 

 

Menu 

    >  Org. Typ
      Photo 

e-B&W 

The “>” marker is down to the value level so you can 
change the value.  

      Org. Type-B&W 
  > Photo 

5. Press the  En

icating that the value is set and you can step on through the menu options if 
B&W Copy 

ter  button to accept the selected value. The “>” marker will move up to the 
Menu level ind
needed. The new Org. Type-B&W value will be applied every time you press the 
button until you repeat the steps above to change it.   

 

        Org. Type-B&W 
   > Line 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down 

. 

   >  Org. Type-B&W 
      Line 

buttons
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5.3.  Sharpen filter?  

You can give your copy sharper lines with the Sharpen option. The Sharpen filter identifies 
edges in the image and intensifies them. You can use the Sharpen option with both Color 

e 

   
 
To apply the Sharpen filter 

3 How do I… apply the

Copying and B&W Copying and with all original types. When set to ON, the option will apply th
Sharpen filter when you press either the Color Copy or B&W Copy button.  

B&W 
Copy 

Color 
Copy 

 On the iJET Panel – 
1. Press the button to enter the main Menu.  

2. Use the arrow up/down buttons   to move through the Menu options until the display 
shows Sharpen as shown below. 

 
3. Press  Enter  to move the “>” marker down to indicate you want to change the Sharpen 

 

4. Press the arrow up 

setting.  

 or arrow down button    to change the Sharpen setting 

 
5. Press the  Enter  button to accept the selected setting. The “>” marker will move up to the 

Menu level indicating that the value is set and you can step on through the menu options if 

Menu 

needed. The new Sharpen setting will be applied every time you press the Color Copy or
the B&W

 

 
 Copy button until you repeat the steps above to change it.   

 

 

 
 
 

 

 
 

 
 
 

        Sharpen 
   > ON 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down 
buttons. 

   >  Sharpen 
      ON 

The “>” marker is down to the value level so you can 
change the setting.  

      Sharpen 

    >  
      OFF 

Sharpen 

  > OFF 
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5.3.4 How do I… apply the Background (Backg.) Clean  filter?  
ackground clean is used if you have an original with a background that is not as completely 
hite as you would like it. If you want the background to appear pure white in the copy, then 
u can increase the background clean value. Background clean should be used with caution, 

s it can also affect light colors that you will not consider as part of the background. 
he Background clean setting is a "cutoff" point. Pixels with a lightness under the setting’s 
lue are affected. The higher the Backg. Clean value, the larger the range of pixels that will 

e turned to white. You can define cutting points from 0 to 12. The default value is zero (no 
ffect). 
xample: 
ou have copied an original and want to improve it through bringing out the text by making the 

rds from its default of 

n.  

B
w
yo
a
T
va
b
e
E
Y
background whiter. You can adjust the background clean value upwa
zero (to 12, for example) and thus make the pixels at high lightness levels go to white.  

The option’s setting will be applied when you press either the Color Copy or B&W Copy butto

   
 
To apply the Backg. Clean filter 

 On the iJET Panel – 
1. Press the button to enter the main Menu.  

2. Use the arrow up/down buttons   to move through the Menu options until the displa
shows Backg. Clean as shown below. 

y 

 
3. Press  Ente  to move the “>” marker down tor  indicate you want to change the Backg. 

Clean setting.  

 

4. Press the arrow up  or arrow down button  to change the Backg. Clean value. The 
. higher the value, the larger the umber of shades that will be converted to white in the copy

 
5. Press the  Enter  button to accept the selected setting. The “>” marker will move up to the 

Menu level indicating that the value is set and you can step on through the menu option
needed. The new Backg. Clean setting will be applied every time you press the Color C
or the B&W Cop

 

s if 
opy 

 

y button until you repeat the steps above to change it.   

 

B&W 
Copy 

Color 
Copy 

Menu 

    >  Backg. Clean 
      0 

The “>” marker is down to the value level so you can 
change the setting.  

      Backg. Clean 
  > 0 

        Backg. Clean 
   > 10 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down
buttons. 

   >  Backg. Clean 
      10  
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5.3.5 How do I… Set the Media Type?  
en making color copies, it is important to tell the system what kind of paper you have in the 
ter. Already during scanning, your system will optimize processing for optimal color 
ching in relation to the media type the image will be printed on. Processin

Wh
prin
mat g for glossy paper 

e described how to create Media Profiles in the sections on Configuration and Setup - Media 
rofiles - Color Printer Setup. A Media Profiles you created during setup will be applied when 
u set the corresponding Media type. 

 

is different than processing for coated paper. Your Media Type setting is not used with B&W 
Copying. 
 
W
P
yo
 
NOTE: If your system does not already have a Media Profile for the media in your printer, then
you must create a new Media Profile. 
Instructions on creating new Media Profiles are described in the section on Media Profiles - 
Color Printer Setup. For convenience, we have repeated these instructions below at end of this 
section - How do I… Set the Media Type? 
 
Your Media Type setting is applied when you press the Color Copy button.  

  
 

Color 
Copy 

To set a Media Type: 

 On the iJET Panel – 
1. Press the button to enter the main Menu.  

2. Use the arrow up/down buttons   to move through the Menu options
shows Media Type as shown below. 

 until the display 

 
3. Press  Enter  to m

setting.  
ove the “>” marker down to indicate you want to change the Media Type 

 

4. Press the arrow up  or arrow down button  to change the Media Type setting. 

 
5. Press the  Enter  button to accept the selected setting. The “>” marker will move up to the 

Menu 

    >  
      Coated

Media Type 
 

The “>” marker is down to the value level so you can       Media Type 
change the setting.    > Coated 

        Media Type 

Menu level indicating that the value is set and you can step on through the menu options if 
needed. The new Media Type setting will be applied every time you press the Color Copy 

 

button until you repeat the steps above to change it.   

   > Semi Glossy 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down
buttons. 

   >  Media Type 
      Semi Glossy  
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To Create a New Media Profile  
e instructions below are repeated from the section – “Creating Media Profiles - Color Printer
up):  

(Th  
Set
 

that matches the 

 Media Profile is connected solely to a specific printer and media type so you will need to 
eate new media profiles if all of these (printer or media) are changed.  

If your system does not already have a Media Profile for the Media Type 
media in your printer, then you must create a new Media Profile. 
A
cr

 On the iJET Panel 
. Sele1 ct the Menu button.  

ow shows Advanced and 

 

3. Use the arrow buttons up or down until the display shows Options and confirm with 

4. Closed Loop Cal  should be displayed as the first option. If not use the arrow down 

5. current 
setting

 

6. 

2. Use the arrow button up or down     until the display wind

Menu 

confirm with the Enter button  . Enter 

 > Advanced 
   … 

  
. Enter 

 > Options 
   … 

 

button to reach it. Press  to confirm.  Enter 

 
Your display should now look like this (the actual text on the 2. line will show the 

 for the option and may be different than the one shown below). 

 > Cl d Loop Calose  
   … 

Menu option item Media Profile 
Current setting for option item 

> Media Profile 
   Coated 

 

Press  to move the “>” mark to the current setting so you can change it. Use the 

arrow buttons up/down   until you reach the media type (Coated, Semi Glossy, 
Glossy…) that describes the media in your printer. Press  to confirm.  

 
8. Feed the sheet into the scanner  

Enter 

Enter

7. On “Print Sheet” select Enter. The system will print a color patch sheet. 
 > Print Sheet 

   ‘Enter’ to go… 
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9. The display will now show “Scan Sheet”. Select  to start. The system will scan the

type. 

 
color patch sheet and calculate color matching values for future jobs with the current media 

 
10. Media Type that 

system will then load the corresponding Media Profile and use it to create optimal color 

5.3.

 B&W Copy button.  

 
 
To 

 > Scan Sheet 
   ‘Enter’ to go… 

Enter

When you use the system for copying, you will select the option for the 
matches the media loaded on your printer. This is done through the Menu button. The 

output for the job.  
 

6 How do I… Mirror the Image?  
You can mirror the image during capture.  
The option’s setting will be applied when you press either the Color Copy or

  

Mirror the image: 

 On the iJET Panel – 
1. Press the button to enter the main Menu.  

2. Use the arrow up/down buttons   to move through the Menu options until the display 

 
. Press

shows Mirror as shown below. 

3   Enter  to move the “>” marker down to indicate you want to change the Mirror option 

 

setting.  

4. Press the arrow up  or arrow down button  to change the Mirror option value to YES o
to NO. YES will mirror the original image in your copy and NO will leave it as it is. 

 

r 

5. Press the  Enter  button to accept the selected setting. The “>” marker will move up to the 
Menu level indicating that the value is set and you can step on through the menu options if 
needed. The new Mirror setting will be applied every time you press the
B&W Copy button until you repeat the steps above to change it.   

 Color Copy or the 

 
 

 
 

B&W 
Copy 

Color 
Copy 

Menu 

    >  Mirror 
      NO 

The “>” marker is down to the value level so you can 
change the setting.  

      Mirror 
  > NO 

        Mirror 
   > YES 

The ”>” marker is on the Menu level. You can continue 
navigating the menu options with the arrow up/down

   >  Mirror 
      YES  

buttons. 
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5.3.7 How do I set Copy defaults?  
 Copy default values that came with your system are those that will work well with the mos
mon copy jobs. The Copy default values are those accessed from the Menu button’s top
l - Lightness, Sharpen, Scale and etcetera. The lower level opti

… Re
The t 
com  
leve ons accessed though the 
Menu - Advanced options, such as network setup and printer setup are not changed by the 
Reset option. The Reset option is useful if you have made a number of special settings for a 

 once and thus reset the system for yourself or 
r other users.  

o Reset the system copy defaults: 

copy job and want to restore all copy settings at
fo
 
T

 On the iJET Panel – 
1. Press the button to enter the main Menu.  

2. Use the arrow up/down buttons 

Menu 

  to move through the Menu options until the display 
shows Reset as shown below. 

    >  Reset 
      ‘Enter’ to go 

 
3. Press  Enter  to move the “>” ma

option.  
rker down to indicate you want to activate the Reset 

 

The “>” marker is down to the value level so you can       Reset 
 change the setting.  go   > Enter to

4. Press  Enter  to activate the option. The system will start restoring the copy defaults.  

 
When finished, the system will display ‘Done’.  

        Reset 
   > Please Wait.. 

5. 

6. Menu level so 

 
ou select the Restore option: 

 
The iJET

        Reset 
   > Done 

 Panel display will automatically return the “>” marker back up to the 
you can step on through the menu options if needed. 

The ”>” marker is on the Menu level. You can continue    >  Reset 

 
navigating the menu options with the arrow up/down 
buttons. 

      ‘Enter to go’ 

The table below shows which copy settings are affected when y
 
Copy settings that return to their default value Copy settings that remain at the last used value 

Lightness Org. Type Color 
Copies Org. Type BW 
Scale Media Type 

Quality  
Size  

Mirror  
Sharpen  

Backg. clean.  
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5.3.8 The Advanced option  

se
s he system to match the company’s business. 
 
The options in th nced submenus are described in the sections on Scanner 

The Advanced option The Advanced option leads to submenus containing options related to the 
ttings. Most of the Advnaced options are for scanner device and not to actual copy or scan 

ystem administrators who are configuring t

e Adva
Configuration and S Scanner Maintenetup and the sections on ance.  
 
To reach the Advanc tions: ed op

 On the iJET Pa
1. Press the enter the main Menu.  

. Use the arrow up/down buttons 

nel – 
button to Menu 

 2  to move through the Menu options until the display 
shows Advanced as shown below. 

 
3. Press  Enter  to reach the first Advanced menu option Printer Setup. 

 

4. Use the arrow up/down buttons   to move through the Advanced submenu options. 
5. Press  Enter  to enter an option. Some options will require one or more additional presses 

to the  Enter   button t
below in which the sys

o reach underlying options and settings as shown in the example 
tem administrator wants to change the color printer’s interface type. 

 
 
 
 
 

 
 
 

 
 
 
 
 

 

 
 
 

 
 
 
 

Printer Setup 
 … Enter 

 Color Printer 
 … Entert 

 > Interface 
  LAN Enter 

    Interface 
 > LAN 

    > Printer Setup 

    >  Advanced 
      … 

      … 
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5.4 Using Copy Software with the scanner (local or network PC) 
our scanner can also be used with compatible copy software from a locally connected or 
etwork PC. If the scanner is connected to the LAN, network PCs will be able to “share” the 
canner and control it with compatible copy software and use it with network printers. Naturally, 
ompatible copy software can also be applied in a stand alone local PC/printer configuration.  

he “Scan/Copy station on Local PC” configuration was described in the section on “Setup and 
onfiguration”. Copying or scanning to file with this configuration can take place through 
oftware installed on the PC. The software would control the scanner and all settings and 
peration would take place from the PC.  

 the scanner is connected and setup with network identification on the LAN, PCs on the LAN 
an recognize and use the scanner (share) if compatible scan or copy software is installed on 
e PC. The PCs must also have WIDEsystemNET installed. 

t up-to-date 

Y
n
s
c
 
T
C
s
o
 
If
c
th
 
Please refer to the scan/copy software documentation and on-line help for the mos
instructions on using the specific software application with the scanner. 
 
Be sure to view the on-line help for WIDEsystemNET for information on scanner sharing and 
scanning to a designated folder (to a network PC)  on the LAN. 
 

 Please refer to this Operator’s Guide section on Scanner On Network Setup Settings for 
details on enabling your scanner to be recognized on the LAN and shared by network PCs.  
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6. How do I Scan to File? 
can-to-file means that you save the image in a file format on a PC’s hard disk rather than 
utputting directly to a printer (copy). Scans cannot be saved in the scanner itself. In order to 
can and save the image in a file, your system must recognize a PC. Therefore, the 
onfiguration must include a PC, either directly through USB or else through the network. The 
C must have WIDEsystemNET installed. Your system can scan to file if: 

. Your scanner is connected to the network through the LAN interface and Scan2Net 
Designated Folder functionality has been configured in WIDEsystemNET on each PC so 
that a special scan input folder is defined on the PC and the PC will be recognized by the 
scanner. 

. Your scanner is connected to a local PC through USB and Scan2Net Designated Folder 
functionality has been configured in WIDEsystemNET on that PC so that a special scan 
input folder is defined on the PC and the PC will be recognized by the scanner. 

. Your scanner is connected to the network through the LAN interface. The scanner has been 
enabled for access from the PC’s on the LAN by setting the scanner’s Share option to YES 
(see section: Setup to Share the Scanner).  The PC’s on the LAN are setup to recognize 
the shared scanner with WIDEsystemNET software and compatible scan/copy software. 

 
OTE: WIDEsystemNET software is on the WIDEsystem TOOLS CD that came with your 

S
o
s
c
P
 
1

2

3

*N
scanner. See the CD’s included documentation and your WIDEsystemNET software on-line 
help for instructions on installing and configuring a PC for Designated Folder functionality. 
 
This section will focus on the first and second scan-to-file scenario in which you use the 

 scan to a designated folder. iJET Panel to select a scan target and
 
You will use the iJET Panel’s Scan to button to make all your settings for a scan to file job and 
the Scan button to start it. You will use the Size button to enter the original’s size before 
pressing the Scan button (unless scanning the whole original with Auto size). Details follow in 
the next section.  
 
 
 

Scan button – start 
the scan job.

Size Button – set 
the original’s size. 
(Skip if set to Auto) 

Scan to Button -  
set scan to file  
target and options 

 
 
 

 



Using the scanner, how do I …?   6-2 

6.1 Scan to Local or Network PC with the iJET Panel 

1. Load your original.   See the section “How do I load originals?” for information 
regarding your specific scanner model. 

2.  On the iJET Panel –Select the Scan to button. The first of the recognized scan targets 
(PCs) will be displayed. 

 
3. Repeated pressing on the Scan to button will step through the list of recognized scan 

targets (PCs). Stop when the right scan target is displayed. A target name that includes 
“(USB)” will be a PC connected directly to the scanner. “No Clients” will be displayed if no 
PCs with Designated Folder functionality were detected locally or on the network. See your 
WIDEsystemNET help for instructions on setting a PC for Designated Folder functionality 
with a scanner connected directly to the LAN. 
 

 

 

4. 

Scan to 

 Set the Size of your original 
The value your set here determines the scan area. Usually this would be the size of the 
original unless you wish only to input a portion.  Press the Size button to activate size 
setting. 

You then change the value each time you again press the Size button or with the 

arrow up/down buttons   . You can select Auto detection or a standard size setting. 
Auto will detect the edges of the original and always set the scan area to the full original 
siz

C after scanning-to-file. Press 
e every time. You will probably use Auto for most jobs. You can always crop the image in 

an image editor on the P Enter  to confirm your setting. 

 

5. 

 
NOTE: About the Size value: Size is a global system variable that can be changed in 3 
different ways: 1. With the Size button 2. With the Menu button > Size option and 3. With 
the Scan to button > Size option. This means that when you change the size for a copy job, 
it will also apply for a scan-to-file job and vise versa until you change it again.   

 Make your scan-to-file settings. The latest (or “default” if none were made) scan to 
file settings are always attached to the scan target, so each available scan target will have 
stored its own settings. If you know your target’s settings to be correct for your current job, 
press the Scan button to send the scan. Otherwise, continue to the next step.  

 

Size 

Change the value (Auto or a standard size) and 

press  Enter  to confirm. 
     Size 
 > Auto 

Local PC set as scan target   Scan to 
  PC_nr8 (USB)  

Network PC named “PC_nr3” set as scan target   Scan to 
  PC_nr3  

Scan 
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6. If you want to change the scan-to-file settings - Confirm the scan target with  Enter  to 
mo The first Scan-to-File Menu option Scan Mode will be 

 

7. Press the arrow up/down buttons 

ve into the Scan-to-File Menu.  
shown in the display.  

  to move through the options in the Scan-to-File 
Menu. Press  Enter  to o e the “>” marker down so you can change the current option
value. 

 

confirmed by pressing the Enter 

m v ’s 

8. 

When you press Enter , the “> “marker moves 
down indicating you can change the option value.  

      Scan Mode 
  > 24-bit Color  

Entry into the Scan-to-File Menu   > Scan Mode 
    24-bit Color  

The Scan-to-File Menu will take you through different options. Each option must be 
 Enter  button. The Scan-to-File Menu and its options 

9. 

10. When you have finished making your settings, press the Scan button to send your scan to 
the

are described in the next section. 

Your new scan-to-file settings will be tied to and stored with the target PC name you 
selected in step 3 and they will be recalled next time you select the same target PC from 
the iJET Panel. 

 target PC.  

 
Scan 
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6.2 Scan-to-File Menu Options – iJET Panel 

6.2.1 Enter the iJET Panel Scan-to-File Menu 

 On the iJET Panel – 

. Select the Scan to button  

. Select the scan target. 
 

 

. Confirm the scan target with 

1
 
2

 
3  Enter  to start the Scan-to-File menu. 

.   The first Scan-to-File Menu option Scan Mode will be shown in the display.  

 
 

 

 
 
4

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Network PC named “PC_nrX” set as scan target 

Scan to 

Entry into the Scan-to-File Menu 

  Scan to 
  PC_nrX  

  > Scan Mode 
    24-bit Color  
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6.2.2 Set the Scan Mode 

 On the iJET Panel – 
If you are not already in the Scan-to-File menu, start/enter the menu with the Scan to button as 1. 
described in the beginning of this section. 

. 

2. The first Scan-to-File Menu option is the Scan Mode. Your display should look as follows: will 
be shown in the display.  

 
3. Press  Enter  to move the “>” marker down so you can change the current option’s value if 

needed.  

 

4. Press the arrow up/down buttons   to move through the values for the Scan Mode option. 
The following Scan Modes are available: 
 
Scan Mode What it Does / Usage Adjustments 
B&W Threshold This mode uses thresholds to determine whether a pixel is black or 

white. Use this mode for drawings and line art. You can set the 
threshold value (Level). Default value is 151.  

Level 

B&W Adaptive Adaptive enhancement for line images. Suitable for scanning all kinds 
of drawings including difficult blueprints, brown transparencies 
(sepias), etc. You set Adaptive level. Provides minimum file sizes and 
is thereby, well suited for digitizing. 

Level 

B&W Copy Adaptive Adaptive enhancement on foreground and background. This mode is 
suitable for copying (scan and print) of Sepia, Blueprint and other 
originals with heavily distorted foregrounds and backgrounds where the 
shades that create unwanted "noise" are close to the shades that make 

o are hard to differentiate. 

Level 

up the image's data and the tw

Graytone In this mode 256 gray levels are recognized for each pixel. Graytone 

otos. 

Gamma 
mode creates good reproductions of complicated B/W images like B/W 
ph

24-bit Color This is the 24 bit true color mode for capturing all of the image's colors 
with the closest reprodu

Gamma 

ction. This mode produces large files since all 
colors, even shades with only slight differences, are captured and 
produced. You use this mode when you want accurate reproduction of 
complicated color images like color photos and posters. You can make 
tonal adjustments through a Gamma value. 

 
5. Press  Enter  to accept the Scan Mode and move the “>” marker back up. From here you can 

set the Scan Mode parameter (Level or Gamma). See details below.   

Scan to 

Press

 
 

 Enter to accept the Scan Mode. The “> 
“marker moves back up.  

   >  Scan Mode 
     Graytone 

When you press Enter , the “> “marker moves 
down indicating you can change the option value.  

      Scan Mode 
  > 24-bit Color  

Entry into the Scan-to-File Menu   > Scan Mode 
    24-bit Color  
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6.2.3 Se  Scan Mode Parameters – Level or Gamma t the

 On the iJET Panel – 
When you pressed  1. Enter  to accept the Scan Mode,  the “>” marker moved back up to the 
option text “Scan Mode”.. From here you can set the current Scan Mode parameter. 

Press 
 

2. w down b

Enter 

ack up.   
to accept the Scan Mode. The “> 

“marker moves b
   >  Scan Mode 
     Graytone 

 

Press the arro utton   to move to the Scan Mode’s parameter option an n d the
 Enter  to indicate you w &W Adaptive or 

, the parameter option will be Graytone or , the 
tion will be tting.  

 

ant to change it. If you selected B&W Threshold, B
Level. If you selected B&W Copy Adaptive

parameter op
Color

our se Gamma. Use the guidelines in the table below to make y

 

Press Enter to indicate you want to change the 
value. The > marker will move 

Scan Mode Adjustment – what it does 
B&W Threshold 55. The default is 

low the threshold 
s above will be represented as 

white pixels. 

Level in this scan mode is the threshold value. Values between 0-2
151. When scanning at a specific threshold value, all gray tones be
will be represented as black pixels, and all gray tone

B&W Adaptive e more of the 
kground is picked up during scanning. Values between 0-255. Default is 0. 

B&W Adaptive Level works like a threshold - the lower the value, th
bac

B&W Copy Adaptive alue, the more of 
ent features are 

sing on different 
ermine the best 
 between 0-255. 

B&W Copy Adaptive Level works like a threshold - the lower the v
the background is picked up during scanning.  Adaptive enhancem
automatically applied in this copy mode, with simultaneous proces
image aspects. You only have to adjust the adaptive "Level" to det
degree of enhancement processing for your specific image. Values
Default is 0. 

Graytone Gamma – Values between 0.1 and 3.0. Default is 1.0. Pixels are intensified 
according to a gamma curve they are mapped to. A low gamma value smaller than 
1.0 darkens the output while a high gamma value larg
the shadow areas and brings out detail. 

er than 1.0 typically lightens 

24-bit Color Gamma– Values between 0.1 and 3.0. Defaul
according to a gamma curve they are mapped to. A low

t is 1.0. Pixels are intensified 

1.0 darkens the output while a high gamma value larger than 1.0 typically lightens 
 gamma value smaller than 

the shadow areas and brings out detail. 

3. Press the arrow up/down buttons   to change the value displayed.  

4. Press  Enter  to accept the new parameter value for the current Scan Mode The “>” marker 
moves back up back up to the Scan-to-File Menu level. From here you can move on 

 

and make 

 

more Scan-to-file menu settings. 

      Gamma 
  >  1.00 

Press 

down..  

Enter  to accept the parameter value.     >  Gamma 
     0.70 
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6.2.4 Set the Scan-to-File Resolution 
 

re
re

This is where you determine image quality. Note that high resolutions create large 
or more is adequate for printing. Certain maps and CAD drawings with high levels 

files. 300 dpi 
of detail 

quire high resolutions. CAD processing of the image may also require that you select a high 
The Dpi (dot per rom 50 to 9600. Dpi value settings below 
he scanners opt al resolutions without interpolation.  

Interpolation involves resa
resolution beyond the actual number of CCD cells (

s are calculated on the basis of their surrounding pixels. See your scanner model 
sc

 
o-File Resolution: 

solution. 
or equal to t

inch) range selectable is f
ical dpi will give pure optic

 
mpling through adding pixels between original pixels to increase 

optical resolution). The new pixel’s colors 
and intensitie
specifications to view the anner’s optical resolution. 

To set the Scan-t

 On the iJET Panel – 
 
1. If you are not already in 

as described in the beginning of this section. 

. 

the arrow up/dow

the Scan-to-File menu, start/enter the menu with the Scan to button 

Scan to 

2. Press n buttons   to move through the Scan-to-File Menu option
lution. 

s until 
the display shows Reso

 
3. Press  Enter  to move the “> m rker down to indicate you want to” a  change the resolution 

.  

 

value
The “>” marker is down to the value level so you can 
change the value.  

       Resolution 
  > 200 

    >  Resolution 
     200 

4. Press the arrow up/down buttons   to change the Resolution value. You can select 
from a list of pre-defined resolution (dpi) values (50, 100, 200, 300 …9600). Resolution 
values above the scanner’s optical resolution will use interpolation.  

5.  Press  Enter  to accept the selected value and move the “>” marker back up to the Scan-
 move on to the next Scan-to-File setting. to-File Menu level so you are ready to

 
 

 
 

level.  
The “>” marker is back up to the Scan-to-File Menu    >  Resolution 

     353 
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6.2.5 Set the Scan-to-File Size (input size) 
This same Scan-to-File Menu option can also be reached by pressing the function Size button.  

unl
 
To set the Scan-to-File Size: 

 
The value you set here determines the scan area. Usually this would be the size of the original 

ss you wish only to input a portion.   

Size 

e

 On the iJET Panel – 
 

If you are not already in the Sca1. n-to-File menu, start/enter the menu with the Scan to button 

 

2. 

as described in the beginning of this section. 

Press the arrow up/down buttons   to move through the Scan-to-File Menu options until 
the display shows Size. 

3. 

 

Press  Enter  to move the “>” marker down to indicate you want to change the Size value.  

4. 

 

Press the arrow up/down buttons   to change the Size value.  

5. The Auto option will detect the edges of the original and set the scan area to the full original 
size. This is the recommended setting. If necessary, you can later crop the image in an 
image editor after it has been saved to the target PC.  
The standard sizes shown are those that belong to the Paper Series  you selected through  Menu > 
Advanced > Options > Paper Series. 

See this guide’s section on “Personalizing and Localizing the System” for details on 
selecting a Paper Series preference. 

 

6. Press  Enter  to accept the selected value and move the “>” marker back up to the Scan-

lobal system variable that can be changed in 3 

to-File Menu level so you are ready to move on to the next Scan-to-File setting. 

 

NOTE: About the Size value: Size is a g
different ways: 1. With the Size button 2. With the Menu button > Size option and 3. With the 
Scan-to button > Size option. This means that when you change the size for a copy job, it will 
also apply for a scan-to-file job and vise versa until you change it again.   

 

.      Size 
 > Auto 

The “>” marker is back up to the Scan-to-File Menu 
level.  

   >  
     Auto

Size 
 

can The “>” marker is down to the value level so you 
change the value.  

       Size 

    >  Size 
     A3 

Scan to 

  > A3 
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6.2.6 Set the File Format ( TIFF, JPEG, PDF ) 

 On the iJET Panel – 
 
1. If you are not already in the Scan-to-File menu, start/enter the menu with the Scan to button 

. 

2. Press the arrow up/down buttons 

as described in the beginning of this section. 

Scan to 

  to move through the Scan-to-File Menu options until 

3. Press 

the display shows File Format. 

 

    >  File Format 
     PDF 

 Enter  to move the “>” marker down so you can change the current option’s value if 

4. 

needed.  

 

Press the arrow up/down buttons 

When you press Enter , the “> “marker moves 
down indicating you can change the option value.  

      File Format 
  > PDF 

  to move through the values for the File Format 
option. The following File Formats are available. 

– If selected you can set a quality factor from 1 to 100. 70 is default. 
JPG – If selected you can set a quality fac

 
5. PDF 
6. tor from 1 to 100. 70 is default.  
7. 

8. 

TIFF – If selected you can set quality to Uncompressed or PackBits.  

Press the arrow up/down buttons   to change the value displayed.  
 
 

Press  9. Enter  to accept the File Format and move the “>” marker back up. From here you 
can set the File Format quality. See details below.   

 
 

 

 

 
 

 
 
 

Press Enter  to accept the File Format. The “>   > File Format    
    JPEG “marker moves back up.  
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6.2.7 Set the File Format Quality 

 On the iJET Panel – 
 
1. If you are not already in the Scan-to-File menu, and want to change the Quality value 

for the current file format setting -   start/enter the menu with the Scan to button as 
described in the beginning of this section. 

. 

2. Press the arrow up/down buttons   to move through the Scan-to-File Menu options until 
the display shows File Format. Then move on to step 4.  

 

 File Format as described 
 

3. If you are in the Scan-to-File menu and have just selected a
in the previous section - When you pressed Enter  to accept the File F
marker moved back up to the option text “File Format”. From here you ca

ormat,  the “>” 
n move forward in 

the Scan-to-File Menu to set the File Format quality parameter. 

 

4. Press the arrow down button   to move to the File Format’s Quality parameter option and 
then  Enter  to indicate you want to change it. 

 

. Press the arrow up/down buttons 5   to change the value displayed.  

. Press6   Enter  to accept the new quality value for the current File Format The “>” marker 
moves back up back up to the Scan-to-File Menu level. From here you can move on and 
make more Scan-to-file menu settings. 

 
 

 

 
 

 
 
 
 

 
 
 

 
 

    >  File Format 
     JPEG 

Scan to 

Press 

Press Enter to accept the File Format. The “> 
“marker moves back up.   

   >  File at 
     JPEG 

 Form

Enter to indicate you want to change the 
value. The > marker will move down..  

      JPEG Quality 
  >  70 

Press Enter  to accept the parameter value.     >  JPEG Quality 
     100 
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6.2.8 Using Scan Software – From Local PC or Network PC 

The ribed in the section on “Setup and 
Configuration”.  Scanning to file with this configuration can take place through scan software 
installed on the PC. The software would control the scanner and all settings and operation 
would take place from the PC.  

 
sharing, PCs on the LAN can recognize and us
soft
 
For both of these cases, please refer to the scan/copy software documentation and on-line help 
for the most up-to-date instructions on using the specific software application with the scanner. 
 

 

 

 
 “Scan/Copy station on Local PC” configuration was desc

 
If the scanner is connected and setup with network identification on the LAN and is enabled for

e the scanner if compatible scan or copy 
ware is installed on the PC. The PCs must also have WIDEsystemNET installed. 

Be sure to view the on-line help for WIDEsystemNET for information on scanner sharing and
scanning to a designated folder (to a network PC)  on the LAN. 

 Please refer to this Operator’s Guide section on Scanner On Network Setup and Setup to 
Share the Scanner for details on enabling your scanner to be recognized on the LAN and 
shared by network PCs.  
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7. Maintenance 

.1 Preliminary Maintenance – scanner setup 7

On scanners:    
 
When you have setup your new scanner and verified your installation, it is important that you 

your first maintenance session before working with the scanner. Shipping and transportation
an affect the cameras and it is therefore highly recommended to calibrate. But before you do 
o, you must thoroughly clean the scanner. Preliminary Maintenance is just the very first 
ession of regular scanner maintenance and involves the same steps. Follow the instructions in 
e next section under Regular Scanner Maintenance. 

.2 Regular Scanner Maintenance 
egular scanner maintenance is a sure way to minimize costly downtime. The three routine 
aintenance procedures cleaning, camera alignment and calibration will improve image 

uality and reduce your service costs.  
OTE: Camera Alignment is not relevant with 18” scanners. 

he maintenance functions are closely entwined and they should all be performed in a single 
aintenance session, starting with cleaning the scan area and ending with calibration. The 
ason for this is simple. If you clean the glass or adjust the cameras then you will have 

hanged conditions in the scanning area and will need to calibrate in order to readjust black, 
hite and color interpretation. This works the other way as well – scanner calibration must 
lways be preceded by cleaning and camera alignment to get reliable calibration results.  

canner Maintenance is very easy to perform and most of it is completely automatic.  After 
anually cleaning the scan area, you just insert a Calibration Sheet, and start the Scanner 
aintenance program.  

n some scanner models you can activate the Scanner Maintenance program from the iJET 
anel. On others you must run the Scanner Maintenance program from a PC that recognizes 
e scanner and has WIDEsystemNET and Scanner Maintenance software installed. See the 
llowing section on Running the Scanner Maintenance Program for details.. 

 

 
 
 
 

run 
c

 

s
s
th

7
R
m
q
N
 
T
m
re
c
w
a
 
S
m
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O
P
th
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7.3 Cleaning the Scan Area 
A clean scan area is vital for optimal results. Cleaning instructions for each scanner type follow 
below: 

 Caution: do not use abrasives, acetone, benzene or fluids that contain these chemicals. 
Do not spray liquids directly onto the scanner glass-plate or anywhere else in the scanner. 

 Caution: Before cleaning the scan area, be sure to turn the scanner 
disconnect the power plug. 

power off and 

 
leaning the Scan Area  C

On scanners:    
 

1. Turn the scanner power off and disconnect the power plug.  
2. Open the scan area lid. 

. The glass-plate 3 is now exposed for cleaning. 

e plastic dust 
cover when not in use.  

4. Clean the glass with a lint-free cloth and a mild, streak-free, glass cleaner. Dry the 
glass completely using a separate clean, dry lint-free cloth like the one provided with the 
maintenance kit. 

5. Close the scanning area lid when finished. Cover your scanner with th

 Caution: Make sure the scanner power is OFF when using the scanner dust cover. 
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 Open the scanner lid  

The glass plate is exposed for cleaning. 

 
 
 

leaning the Scan Area  

On scanners:  

C

 
 

1. Turn the scanner power off and disconnect the power plug.  
2. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid. 
3. The scanning area lid locking mechanism should now be disengaged. 
4. As you hold both lever buttons down, place your free fingers in the insertion slot and flip 

the scanning area lid open. 
5. The glass-plate is now exposed for cleaning. 
6. Clean the glass with a lint-free cloth and a mild, streak-free, glass cleaner. Dry the 

glass completely using a separate clean, dry lint-free cloth like the one provided with the 
maintenance kit. 

7. The pressure-platen with the white-background-platen (white metal area) is fixed in the 
scanning area lid. Hold the lid open as you clean.  

8. Wipe the white area and the transport rollers with a lint-free cloth and a mild, streak-
free, glass cleaner. Apply the cleaner to the cloth and first wipe the platen’s white area and 
then the transport roller’s surface.  

rollers completely using separate clean, dry lint-free cloths. 
10. Close the scanning area lid when finished. The locks will reengage.  
9. Dry the platen and 
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11. Clean also the scanner surface so dirt and dust are not dragged into the scan area with 
the original. 

12. Cover your scanner with the plastic dust cover when not in use.  

 Caution: Make sure the scanner power is OFF when using the scanner dust cover. 
 
  Push down lever (on both sides) to 

ck scanninunlo g area lid. the lid open to access the glass-pla
While holding down the levers, insert fingers in the slot and flip 

te and white-background- 
platen.  

White-
background-
platen 

Glass-plate 
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7.4 Running the Scanner Maintenance Program  
he way you start and run the Scanner Maintenance Program depends on your scanner 
odel and configuration. 

.4.1 Starting Scanner Maintenance from the iJET Panel  
n some scanner models you can activate the Scanner Maintenance program from the iJET 
anel.  

o start the program on these scanners: 

T
m
 

7
O
P
 
T
 

  On the iJET Panel 

. Select the Menu button.  

. Select Advanced > Options > Scanner Maintenance 

. Press Enter to start. 

. Follow the Scanner Maintenance instructions described below. 

.4.2 Starting Scanner Maintenance from a PC on the LAN 
 the Scanner Maintenance option does not exists in your iJET Panel, you must run the 
canner Maintenance program from a PC that recognizes the scanner. This can be done from a 
C on the LAN that has WIDEsystemNET setup to recognize the scanner and Scanner 
aintenance installed. The scanner must also be enabled for sharing. See the sections 

ner” for instructions. See your 
 the list of recognized scanners 

o start scanner maintenance from a PC on the LAN: 

w the Scanner Maintenance instructions described below. 

.4.3 Starting Scanner Maintenance from a Local PC 
If the Scanner Maintenance option does not exists in your iJET Panel and is not enabled for 
network/shared scanning, you must run the Scanner Maintenance program from a PC 

 must  have  WIDEsystemNET and Scanner 
Connect the 

canner Maintenance. 

Menu 1
2
3
4
 

7
If
S
P
M
“Scanner on Network Setup” and “Setup to Share the Scan
WIDEsystemNET on-line help for details on adding a scanner to
on a PC.  
 
T
 
1. Start WIDEsystemNET and select the scanner from your list of scanners. 
2. Right-click on the WIDEsystemNET icon and select Scanner Maintenance. 
3. Follo
 

7

connected locally through the USB port. The PC
Maintenance installed. See cthe se tion: Scanner Configuration and Setup – 
Scanner to a PC. 
 
To start Scanner Maintenance from a local PC: 
 
1. Right-click on the WIDEsystemNET icon and select Launch S
2. Follow the Scanner Maintenance instructions described below. 
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7.4.4 Running Scanner Maintenance - Steps 
The steps for running Scanner Maintenance described below are the same regardless of which 

u use.  of the solutions for starting and running the program yo
 
To run Scanner maintenance Program:  
 

On Scanners        
 

1. Make sure that the scanner has been turned on for at least one hour prior to running the 
maintenance routine. Slight light intensity changes can occur just after turning the scanner 
on and the warm-up time will ensure that light conditions have stabilized. 

 
2. Insert the Calibration Sheet that came with your scanner. The sheet’s printed side must 

be inserted face down.  
. Start the Scanner Maintenance program in one of the ways described at the start of this 

section. 
. The program will run calibration.  

t from the scanner.  

 

On Scanners   

3

4
5. After calibration, remove the Calibration Shee
6. Return the Scanner Calibration Sheet to its protective cover and then place it in the storage 

folder. Store the folder in a dry place and out of direct light.
 

    
 

ure that the ner has been turned on for at least one h ur prior to camera 
alignment and calibration. Slight light intensity changes and camera shifting can occur 

1. Make s scan o

just after turning the scanner on and the warm-up time will ensure that light conditions 
and camera heights have stabilized. 

 
2. Insert the Calibration Sheet that came with your scanner. Align the midpoint arrow with 

the middle mark on the scanner. The sheet’s printed side must be inserted face 
down.  

3. Start the Scanner Maintenance program in one of the ways described at the start of t
section.

his 
  

Alignment, Stitching and Calibration.  4. The program will run Camera 
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5. The program analyses alignment and stitching status of the cameras. If the cameras 

. After Camera Alignment, the Scanner Maintenance program automatically moves on to 
Calibration.  

7. Calibration completes the maintenance process. Remove the Scanner Calibration 
Sheet from the scanner.  

8. Return the Scanner Calibration Sheet to its protective cover and then place it in the 
folder. Store  folder in a dry place and out of direct light. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

are unaligned, the program and scanner will automatically make the necessary 
corrections.  

6

storage  the
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7.5 Replacing Scanner Parts 
his section describes how to replace those scanner parts that are liable to wear down over 
ng-term use. Changing parts will renew your scanner and ensure optimal results. Your 

canner monitors usage of parts and will warn you when it is time for a replacement through a 

ome scanner models are designed so users can replace parts on their own (user-replaceable 
arts) while other scanner models will require a service technician. The instructions in this 
ection apply only for scanners with user-replaceable parts. You can see which parts are user-
placeable on your scanner in the table below.   

Scanner Type Parts that are User-Replaceable 

T
lo
s
message in the iJET Panel display window.  
 
S
p
s
re
 

 

 

White-background-platen, Lamp, Dust filters 
 

 

Glass-plate, White-background-platen, Lamp, Dust filters 
 

 
 Important Safety Instruction: Before replacing any user-replaceable parts, be sure to turn 

the scanner power off and disconnect the power plug. 
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7.5.1 Replacing the Glass-plate  
Some scanner mod te from the scanner in 
order to replace scr er models, such as the 
flat bed models, a service technician must perform this process. Your scanner monitors usage 
of the glass platen and will warn you when it is time for a replacement through a message in the 
iJET Panel display window.  
 

n Scanners:

els are designed so users can detach the glass-pla
tched glass-plates with new ones. On other scanna

Replacing the Glass-plate:  

 O    

. 

 

1 Turn the scanner power off and disconnect the power plug.  
. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid.  
. The scanning area lid locking mechanism should now be disengaged. 
. As you hold both lever buttons down, place your free fingers in the insertion slot and flip the 

scanning area lid open.  
. The glass-plate will be exposed and accessible. 
. On each side of the glass-plate there is a small lever and round finger-handle (see 

illustration below). Place your thumbs under both handles on each side. 
. With both arms, pull simultaneously on the left and right levers to flip the glass-plate 

towards your body. 
. Each lever is attached to the scanner chassis with a small hook that rests on a pin. 

Simultaneously lift both levers upwards to detach their hooks for the pins and free the glass-
plate from the scanner.  

 Fit the new glass-plate’s lever hooks on the pins on each 

2

3
4

5
6

7

8

9. To reinsert a new glass-plate –
side of the scanner. 

10. While supporting the glass-plate with your thumbs on the finger handles, carefully push the 
glass-plate backwards (away from your body) and ease it down into place.  

11. Close the scanning area lid. 
NOTE: Make sure you clean a new glass-plate before using it with the scanner. 
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 Remove the glass-plate:  
 
Step 1: Open the lid. Locate the lever’s finger handle on 

h side. Shown below: Right side 

 
Step 2: Flip back. Lift the lever’s hooks and glass-plate 

eac finger-handle. free of the scanner.                   

Finger handle      
Finger handle      

Hook    
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7.5.2 Replacing the White-Background 
 white-background platen can become damaged, worn or discolored after long periods of use 
nd replacement with a fresh white-background-platen is recommended. Your scanner monitors 
sage of parts and will warn you when it is time for a replacement through a message in the 
ET Panel display window.  

n Scanners:

A
a
u
iJ
 

   O
 
 

1. Turn the scanner power off and disconnect the power plug.  
. Open the scanner’s lid all the way. 
. The white background platen is attached to the lid’s underside. 

the white background platen’s edges and pull it 

ress it firmly on the white background platen. 
. Open the lid and press firmly on the new white background platen corners to make sure the 

Velcro is properly in contact in all places.  
 

2
3
4. Use both hands to place your fingers on 

free.  
5. Place the new white background platen on the glass plate with the Velcro corners facing up. 
6. Align the new white background platen on the glass by making sure there is an equal 

amount of space around all four edges.  
7. Gently close the lid and p
8

 Detachable White Background Platen 
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Replacing the White-background-platen: 
 

On Scanners:   
 
 

1. Turn the scanner power off and disconnect the power plug.  
2. Push down on the two lever buttons found near the insertion slot on each side of the 

scanning area lid. 
3. The lid’s locking mechanism should now be disengaged. 
4. As you hold both lever buttons down, place your free fingers in the insertion slot and flip the 

scanning area lid open. 
5. On the lid’s left edge, you will find a red strip. Remove the red strip to expose the edge of 

the white-background-platen.  
6. Grip the edge of the white-background-platen with your fingers and pull to slide it out of the 

scanner. 
. Carefully slide in a new white-background-platen while taking care not to bend it.  
. Reattach the red strip. 

Close the scanning area lid so the locking mechanism reengages. 

ee the illustration below: 

7
8
9. 
 
S
 To change the white-background-platen: 

 
Open the lid and locate the red strip on the left side 
of the scanner. 

 
 
Remove the strip and slide out the white background 
platen. Reinsert a new platen and replace the strip. 
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7.5.3 Replacing the Scanner Lamp-Unit 
Your scanner comes with a high quality and durable lamp. Even so, its effectiveness will 
gradually weaken over time. A new lamp-unit can be obtained through your dealer. Your 
scanner monitors usage of the lamp and will warn you when it is time for a replacement through 
a message in the iJET Panel display window. To change the lamp, you have to command the 
scanner to move the scan-head to the right position so you can pull out the lamp unit and 
reinsert a new one.  
 
Replacing the Scanner Lamp-unit: 

On Scanners:  

    

 On the iJET Panel 
 
1. Select the Menu button.  

. Use the arrow button up or down     until the display window shows Advanced and 
confirm with the Enter button  . 

3. Use the arrow buttons up or down   until the display shows Service and confirm with 

 

5. Press the arrow down  to change the option to YES and press Enter to accept. The scan 
head will move into position so you can pull it put of the scanner.   

 

Menu 

2

. 

Enter 

Enter 

 
4. The option Replace Lamp appears. Press Enter to move the “>” marker down to its value so 

you can change it.  

6. Turn the scanner power off and disconnect the power plug.  
7.  the backside of the scanner. Slide the lamp cover to the right to open 

h a p-unit. A lamp-unit consists of a lamp with fixed power 

fu
10. onnector side on the slider and carefully push 

The lamp cover is on
it. 

8. You must replace the w m
connectors. 

ole l

9. Grasp the edge of the lamp-unit and re lly pull it out of the scanner. 
Reinsert the new lamp-unit. Rest the power-c
the lamp-unit into the scanner. 

ca

Press Enter  to start     Replace Lamp 
> YES 

Press Enter  to move the “>! 
Marker down so you can change 

   Replace Lamp

Press Enter  to confirm  
Service 

> Service 
… 

 
 > NO
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11. Insert the lamp-unit all the way so the internal power connections engage with the 

12. 

connections on the lamp-unit.  

Close the lamp cover – Slide the cover to the left until it CLICKS shut. The cover must 
always be closed before turning scanner power ON. 

13. Test the replacement by turning power on to see if the lamp lights. 
 

Press the arrow down button  to reach Reset Lamp Cnt., press 

14. Reset the part replacement counter that triggers the warning flag -  

Enter  and use the arrow 
down to select Yes. Confirm with Enter. 
 

 
 

Press Enter  to confirm reseting 
the lamp part replacement counter  

   Reset Lamp Cnt. 
> YES 

The following illustrations show removing and inserting a lamp unit. The lamp must be 
positioned for removal through the iJET Panel: 
 

 To replace the lamp-unit: 
Locate the lamp cover on the backside of  the scanner. Use the iJET panel to position the lamp for removal. 
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 Pull the lamp unit out of the scanner. 

 
 
 
 
 Lamp Unit 

power connectors 
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Replacing the Scanner Lamp-unit: 

On Scanners:   
 

1. Turn the scanner power off and disconnect the power plug.  
2. The lamp cover is on the top right edge of the scanner.  
3. Grasp the cover on each side with both hands and pull back to detach.  
4. Lift the cover upwards to free it from the scanner.  
5. You must replace the whole lamp-unit. A lamp-unit consists of a lamp mounted in a reflector 

brace and fixed power connectors. 
. Grasp the edge of the lamp-unit and carefully pull it out of the scanner. 
. Reinsert the new lamp-unit. Rest the power-connector side on the slider and carefully push 

the lamp-unit into the scanner. 
. Insert the lamp-unit all the way so the internal power connections engage with the 

connections on the lamp-unit.   

. 

6
7

8

 9 Replace the lamp cover on the scanner - fit the bottom notches in the holes and snap 
the cover shut. The cover must always be closed before turning scanner power ON. 

0. Test the replacement by turning power and scanner on to see if the lamp lights. 
1. Reset the part replacement counter that triggers the warning flag – Go to Menu button > 

Advanced > Options > Service.  

Press the arrow down button  to reach Reset Lamp Cnt., press 

1
1

Enter  and use the arrow 
down to select Yes. Confirm with Enter. 
 

 
 To replace the lamp-unit: 

 
The lamp cover is on the right side of the scanner. 
Grasp the cover on both sides, pull back and then 
up to detach. 

Free the cover from the scanner. Pull out the lamp-unit 
and insert the new  one. 

 
 

Press    Reset Lamp Cnt. Enter  to confirm reseting 
the lamp part replacement counter  > YES 
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7.5 eplacing the Dust-Filters 
Fresh dust filters can reduce the amount of time spent on cleaning and calibration. The dust 

.4 R

d so users 
ss. 

See ions to see if the dust filters are user-replaceable on your 
scanner. Your scanner monitors usage of the filters and will warn you when it is time for a 
rep  t
 
Replacing the Dust-filters: 

On Scanners: 

filters protect your scanner’s air-cooling vents. Some scanner models are designe
can replace the dust filters. On other models, a service technician must perform this proce

 your scanner’s model specificat

lacement through a message in he iJET Panel display window. 

 
 

1. Turn the scanner power off and disconnect the power plug.  
2. Locate the 2 square-shaped dust filter bins on the underside of the scanner.  
3. Pull down on the edge of a dust filter bin to detach it from its frame. 
4. The filter (soft material) is inside the bin. Remove the old filter and replace with a fresh one. 
5. Reattach (click on) the bin to its frame on the underside of the scanner.    
6. Repeat the process with the second filter. 

 

 

Changing the Dust-filters: 
The filter bin is on the underside of the scanner.  Pull down on the filter bin’s edge to detach a filter bin from its frame. 
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Replacing the Dust-filters: 

On Scanners:  
 

1. Turn the scanner power off and disconnect the power plug.  
2. Locate the 2 square-shaped dust filter bins on the underside of the scanner.  
3. Pull down on the edge of a dust filter bin to detach it from its frame. 
4. The filter (soft material) is inside the bin. Remove the old filter and replace with a fresh one. 
5. Reattach (click on) the bin to its frame on the underside of the scanner.    
6. Repeat the process with the second filter. 
 

 

Changing the Dust-filters: 
The filter bins on the underside of the scanner.  Pull down on a filter bin’s edge to detach a filter bin from its frame. 

Dust Filter Bins 

 

Filters to change. 
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7.6 Locate / Change the Smart Card 
Check that the Smart Card is correctly installed (contact side downwards) and corresponds to 
your scanner model. The scanner will function correctly only with a Smart Card inserted.  

 Be sure that the scanner is turned off when removing/inserting a Smart Card or 
accessing the Smart Card area. 

 
 
Locating the Smart Card 
 

On Scanners   
 
On the flatbed scanners you will find the Smart Card at the scanner’s back near the interface 
connectors and above the power switch. The Smart Card is placed in its insertion slot. 
  
 Smart Card slot near interface connectors 

and main power switch

 
 
Locating the Smart Card 

  On Scanners 
 
On these models you will find the Smart Card by removing the scanner’s right side cover. The 
Smart Card is placed in its insertion slot above the scanner interface connectors. 

 Be sure to reattach the cover after inserting the smart card. The cover must always be 
closed before you turn the scanner ON. 

 



Maintenance   7-20 

 Remove the scanner’s right side cover Smart Card slot above interface connectors 
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7.7 Downloading New Firmware 

On All Scanners    
 
Like a computer, your scanner employs processors that require software in order to work. This 
software is called "Firmware”. Firmware is the software that runs inside the scanner. 

When to use new firmware? 
Your scanner is shipped with the latest firmware available. You can afterwards upgrade your 
original firmware with newer firmware and continue to do so as they are released. Firmware 
upgrades can be downloaded from your manufacture’s website or obtained through your dealer.  

Upgrade your firmware when: 
1. One or more new features are released or other improvements are made to the

scanner though its firmware.  
2. An error is discovered in the firmware version you have in the scanner and your 

manufacturer recommends installation of new firmware in which the error is corrected.  

our manufacture’s website specifies improvements for every new firmware release.  

 order to load firmware to your scanner, you will need a PC that can access the 
canner.  

PC on the LAN that has WIDEsystemNET setup to recognize the 
canner. The scanner must also be enabled for sharing. See the sections “Scanner on Network 
etup” and “Setup to Share the Scanner” for instructions. See your WIDEsystemNET on-line 

he list of recognized scanners on a PC.  

 no network PC is available, you must download firmware from a PC connected locally through 
Scanner Configuration and Setup – Connect the Scanner to a 

C. 

ow to identify the firmware version running in the scanner? 

1. Start WIDEsystem – double click on the system tray’s scanner icon and select the 
Scanner if not already selected. . 

2. Select the Info tab.  
3. The Info tab displays useful data about your scanner firmware. 

• Firmware release - Upgradeable firmware version.  
• Firmware revision - Firmware build number. 
• Firmware timestamp - The date/time the current firmware code was compiled. 
• Firmware download time - The date/time the current firmware was downloaded. 

ou can upgrade if the Firmware Release number is lower than the newest firmware version 
umber on your manufacture’s website. 

 

Y

In
s
This can be done from a 
s
S
help for details on adding a scanner to t
 
If
the USB port. See the section: 
P

H
 

Y
n
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How to install new firmware? 
New firmware is installed by opening a firmware .exe file. The firmware .exe file must first reside 
on your machine. Select the Save target (or Save Link) option if downloading from the web.  

To install the firmware file on your scanner: 
 the firmwa .exe file in a lder on your machine. 

ck menu - Right-click the scanner icon in the system tray. 

ply. 
 click OK to install. Installation can take up to 1 minute 

 
 
 
 

 
 
 
 
 
 
 
 

1. Download/save re  fo
. Start WIDEsystem’s Qui2

3. Select Advanced Options. Select Update Scanner Firmware  
4. Browse the folders on your machine and find the firmware .exe file you wish to ap
5. Select the firmware file and

depending on the scanner model and firmware version. The WIDEsystem scanner icon on 
your system tray blinks red during the download process.  

6. Follow the instructions on your screen. 
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8. Appendix A: Important Safety Instructions 

Read all of these instructions and save them for later use. Follow all warnings and 
instructions marked on the scanner.  
 

A. o not place the scanner on an unstable surface, stand, cart or table. Serious damD age can 

ing. 
er power 

off a
T   indicated on the marking label. 
o ble, consult your dealer or local power company. 

. The scanner is equipped with a three-wire grounding type plug. This plug will fit only into a 
rounding-type power outlet. This is a safety feature. If you are unable to insert the plug into the 
utlet. contact your electrician to replace your obsolete outlet. Do not defeat or ignore the 
urpose of the grounding-type plug. 
. Do not allow anything to rest on the power cord. Do not locate the scanner where persons 
ill walk on the cord. 
. If an extension cord is used with the scanner, make sure that the total ampere ratings of the 
roducts plugged into the extension cord does not exceed the extension card ampere rating. 
ake sure that the total rating of all products plugged into the wall outlet does not exceed 15 
mperes. 
. Slots or openings in the cabinet at the back or bottom are provided for ventilation. This 
nsures reliable operation of the product and protects it from overheating. These openings must 
ever be blocked or covered. The openings should never be blocked by placing the unit on a 
ed, sofa, rug, or other similar soft surface. This product should never be placed near or over a 
diator or heat register. This product should not be placed in a built-in installation unless proper 

entilation is provided. 
 Never push objects of any kind into the scanner through cabinet slots since they may touch 
angerous voltage points or short out parts that could result in a risk of fire or electrical shock. 
void any possibility of spilling liquid of any kind on the scanner. 
. Do not attempt to service the scanner yourself. Opening or removing those covers requiring 
ols may expose you to dangerous voltage points or other risks. Refer all servicing in those 

ompartments to authorized service personnel. 
. Unplug the scanner from the wall outlet and refer servicing to authorized service personnel 
nder the following conditions: 
• When the power cord or plug is damaged or frayed. 
• If liquid has been spilled into the scanner. 
• If the scanner has been exposed to rain or water. 
• If the scanner does not operate normally when operating instructions are followed then 

adjust only those controls covered by the instructions in this manual. Improper 
adjustment of controls other than those mentioned in this manual may result in 
permanent damage and will at best require extensive work by a qualified technician to 
restore this product to its normal operation. 

• If the scanner has been dropped or the cabinet has been damaged. 
• If the scanner exhibits a distinct change in performance, indicating a need for service. 

be caused if the unit falls. 
B. For cleaning, do not use liquid cleaners or aerosol cleaners. Use a damp cloth for clean
C. Before cleaning or replacing any user-replaceable parts, be sure to turn the scann

nd disconnect the power plug. 
he scanner should be operated from the power source typeD. 

If y u are unsure of the type of power availa
E
g
o
p
F
w
G
p
M
a
H
e
n
b
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v
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d
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J
to
c
K
u
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9. Appendix B: Regulations 
FC
 
USA 
 
NOTE: This equipment has been tested and found to comply with the limits for 
a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
de
the equipment is operated in a commercial environment. This equipment 
ge
an
int
area is likely to cause harmful interference in which case the user will be required 
to 
 
Ca oved 
by  the 
eq

C Regulations 

signed to provide reasonable protection against harmful interference when 

nerates, uses, and can radiate radio frequency energy and, if not installed 
d used in accordance with the instruction manual, may cause harmful 
erference to radio communications. Operation of this equipment in a residential 

correct the interference at his own expense. 

ution: Pursuant to Part 15.21 of the FCC Rules, any changes or modifications not expressly appr
 the manufacturer may cause harmful interference and void the use's authority to operate
uipment. 

 
CE
 
EU
 
Wa
Th hich 
case the user may be required to take adequate measures. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Regulations 

 

rning 
is is a class A product. In a domestic environment this product may cause radio interference in w
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10. Appendix C: iJET Panel Quick Reference Guide 

 
Quick Reference Guide to the iJET Panel 

Wide Format Copy Scanners with iJET Technology  
 

 

 

 
 

 
 

 
 
 

 



iJET Panel Quick Reference Guide                                 10-2 

About the Quick Reference Guide 
 
This manual is a complete reference guide to the iJET anel buttons, menus and options including short help 
instructions on using these w
 
• Overv
• Option path and panel b s. 
• Option description tables – to guide you on how to use the panel options.  
 
This Quick Reference Guide covers the following scanners: 
 

 P
ith scan and copy tasks. The guide contains: 

iew – description of the iJET Panel buttons 
utton sequence diagrams – to help you find options and setting

 

18” (A2) flatbed wide 
format copy scanners 
with iJET panel 

Model ID: 
AA51A 
 

 
  

 

36” wide format copy 
scanners with iJET panel 
 

Model ID: 
KA67E 
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iJET Panel Buttons Overview 
 
Button Description 
  
SI  OF ORIGINAL – for both Copy and Scan-to-File jobs ZE

Settings button - For setting the size of the original. The Size button is used for both copy
file operation. Press the button to activate option setting. You then change the 

Siz  e

Size

 
NOTE that Size is a global system variable that can 
button 2. With the Menu button > Size option and 3. W

 and scan-to-
value each time you again 

n select Auto detection or a standard size 
setting.  

be changed in 3 different ways: 1. With the Size
ith the Scan-to button > Size option. This means 

 job, it will also apply for a scan-to-file job and vise versa unless 

press the button or with the arrow up/down buttons. You ca

that when you change the size for a copy
you change it again.   

COPY (scan to printer) 
B&W Copy 

B&W 
Copy

 

Action Button: Starts the scan to-printer process (copying) based on the current B&W copy settings 
made through the Menu button and the panel’s Lightness, Quality, Copies, Scale, Size buttons.  
 

-

Color Copy 

Color 
Copy

 

Action Button: Starts the scan-to-printer process (copying) based on the current color copy settings 
made through the Menu button and the panel’s Lightness, Quality, Copies, Scale, Size buttons.  
 

Lightness 

Lightness
 

Settings Button: For increasing or decreasing lightness in the copy. Press the button to activate option 
setting. You then change the value each time you again press the button or with the arrow up/down 
buttons. 

Quality 

Quality
 

Settings Button: For setting copy quality to Fast, Normal or Best. Press the button to activate option 
setting. You then change the value each time you again press the button or with the arrow up/down 
buttons.  

Copies 

Copies
 

Settings Button: For setting the number of (how many) copies you want output. Press the button to 
activate option setting. You then change the value each time you again press the button or with the arrow 
up/down buttons. 

Scale 

Scale
 

Settings Button: For setting a value that defines the output size in relation to the input size. For making 
copies larger or smaller than the original. Press the button to activate option setting. You then change the 
value to predefined scale ratios each time you again press the button. Use the arrow up/down buttons for 
fine tuning - 1 step increments of the currently displayed value.  Press the Enter button to save. 

Menu Button: Leads to submenus and options for: 
• Entering company defaults for color and B&W copy jobs and changing settings for special jobs. 
• Setting up the system including network, printer and preferences. 
• Maintenance and calibration of the scanner. 
Note: See a complete overview of submenus and options in the Menu button section.  

Menu 

Menu

 

SCAN TO FILE 
Settings and Menu Button: For Scan-to-file – For selecting a scan-to-file target (PC on the network) and 
for setting scan-to-file options. You change the scan target each time you press the button. Keep 
pressing until you see the right target in the window. Then, pressing Enter will lead to the Scan to File 
Menu  with its many scan-to-file options you can select for the job. Scan-to-file options include modes, 
formats, and resolution. 
Note: See complete overview of the submenus and options in the Scan to button section. 

Scan to 

scan to
 

Scan 

Scan

 

Action Button: Starts the scan-to-file process based on the current settings made through the Scan to 
button.  

OPERATION – CONTROL / NAVIGATION 
Enter 

Enter

 

Control Button: To move through menu options until the right option is displayed. 
for entering the menu functionality for changing an option’s value and for setting/accepting the value once 
it is selected. 

Arrow Up/ Down Navigation Button: To move through values for a selected option until the correct value is displayed. 
The first value displayed in a menu is the always the current (latest selected) value. If you are setting the 
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first time, this will be the default value. 

Back 

Back

 

Navigation Button: for moving one level up when in a menu or for returning to an option’s current 
(active) setting while in the process of editing the option’s value. 

Stop 
Control Button: For turning the scanner ON and OFF in soft power mode and for interrupting and 
terminating a scan or copy job before it is finished. 
 Stop
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iJET Panel Menu
 
About The menu diagrams: 
 

1. The value displayed first is the current value. In the diagrams the factory Default value is shown as the first value as this 
will be the case until you change it. 

2. The quick butto
means that the q value level so you do not need to press 
Enter to start viewing values with the arrow up/down buttons. 

. The quick butto
button (alternativ isplayed in the diagrams.  

4. When y ou need to press Enter to accept it. This is not shown in the diagrams. 

5. A complete menu option reference table including option descriptions, menu paths and descriptions of available settings 
follows after the menu diagrams. 

 diagrams 

ns (Lightness, Scale, Quality, Copies) are shown as buttons that bypass the option entry point. This 
uick buttons start their options with the “>” marker already on the 

ns (Lightness, Scale, Quality, Copies) can also step through their values by repeated presses to the 
e to using arrow up/down). This functionality is not d

3

ou have set an option, y
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Menu Button – Copy Settings 

Menu

Org. Type-Color
>Photo

> Org. Type-Color
    Photo

Org. Type-Color
>Photo (Ink)

Org. Type-Color
>Brochure

Org. Type-Color

Enter

>Brochure (Ink)

Org. Type-B&W
>Photo

> Org. Type-B&W
   Photo

Org. Type-B&W
>Blueprint

Org. Type-B&W
>Sepia

Org. Type-B&W
>Line

Enter

Org. Type-Color
>CAD/Map

Org. Type-Color
>CAD/Map (Ink)

Org. Type-B&W
>CAD

> Lightness
    0

Lightness
>-0

Enter

Lightness
>-2

Lightness
>+6

Continue to ’Sharpen’ 
(next page)

Lightness

Lightness
>-3
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Sharpen
>OFF

> Sharpen
   OFF

Sharpen
>ON

Enter

> Backg. Clean
    0 Enter

Continue to Scale %
(next page)

From Lightness
(previous page)

Backg. Clean
>0

Backg. Clean
>1

Backg. Clean
>12

> Medai Type
   Coated Enter

Media Type
>Coated

Media Type
>Semi Glossy

Media Type
>Glossy

> Size
   Auto Enter

  Size
>Auto

<Standard Sizes from selected 
paper size list>

See all the paper size options in 
diagram showing
 the Size button

 

 



iJET Panel Quick Reference Guide                                 10-8 

 

Scale
>25

> Scale %
   100

Scale
>50

Enter

Continue to ’Copies’
(next page)

From ’Size’
(previous page)

Scale
>70

> Mirror
   NO Enter

Mirror
>NO

Mirror
>YES

> Quality
   Normal Enter

  Quality
>Normal

Scale
>125

Scale
>141

Scale
>200

Scale
>400

Scale
>800

Scale
>100

  Quality
>Fast

  Quality
>Best

Scale

Quality
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Scale
>2

> Copies
   100

Copies
>3

Enter

Continue to ’Advanced’
(next page)

From ’Quality’
(previous page)

> Reset
   ’Enter’ to go... Enter

Reset
>’Enter’ to go...

Reset
>Done

Copies
>50

Copies
>1

Copies

Enter
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Copy Button – Advanced Menu Settings – System setup Options 

Printer Setup
...

> Advanced
   ... 

>IP Address
  xxx.xxx.xxx.xxx

Enter

From ’Reset’
(previous page)

Wrap around 
- to

Org. Type
 Color

Color Printer
...

Enter

>Interface
  USB

Enter

Interface
>USB

Enter

Interface
>LAN

 IP Address
>xxx.xxx.xxx.xxx

Enter

If Interface
 = ’LAN’

Active if Interface = ’LAN’

Continue to ’Network Setup’ 
(2 pages)

Continue to ’B&W Printer’ 
(Next page)

>Printer List
  LFP WX000

 Printer List
>LFP WX000

Enter

Printer Model
>Auto Configure

Printer Model
>Printer List

Printer Model
>Custom Setup

>Printer Model
  Auto Configure Enter

>Custom Setup
  Command Set

Custom Setup
>Command Set

Enter

Active if Custom Setup’ 
selected

Custom Setup options
(see separate diagram) 

Active if Printer List’ 
selected
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>IP Address
  xxx.xxx.xxx.xxx

B&W Printer
...

>Interface
  USB

Enter

Interface
>USB

Enter

Interface
>LAN

 IP Address
>xxx.xxx.xxx.xxx

Enter

If Interface = ’LAN’

Active if Interface = ’LAN’

From Color Printer 
(previous page)

From Printer Setup’ 
(previous page)

Continue to ’Network Setup’ 
(next page)

>Printer List
  LFP WX000

 Printer List
>LFP WX000

Enter

Printer Model
>Auto Configure

Printer Model
>Printer List

Printer Model
>Custom Setup

>Printer Model
  Auto Configure Enter

>Custom Setup
  Command Set

Custom Setup
>Command Set

Enter

Active if Printer List’ 
selected

Active if Custom Setup’ 
selected

Custom Setup options
(see separate diagram) 
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Network Setup
...

>IP Address
  xxx.xxx.xxx.xxx

From ’Printer Setup’
(previous page)

>DHCP Setup
  YES

Enter

Enter

DHCP Setup
>YES

 DHCP Setup
>NO

 IP Address
>xxx.xxx.xxx.xxx

Enter

Continue to ’Options’
next page

Active (value editable) 
only if DHCP = ’NO’

>Subnet Mask
  xxx.xxx.xxx.xxx

 Subnet Mask
>xxx.xxx.xxx.xxx

Enter

Active (value editable) 
only if DHCP = ’NO’

>Gateway
  xxx.xxx.xxx.xxx

 Gateway
>xxx.xxx.xxx.xxx

Enter

Active (value editable) 
only if DHCP = ’NO’

>Share Scanner
  YES Enter

Share Scanner
>YES

 Share Scanner
>NO
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Options
...

>Print Sheet
  ’Enter’ to go

From ’Network Setup’
(previous page)

Closed Loop Cal
...

Enter

>Media Profile
  Coated  

Enter

Media Profile
>Coated

Enter

Media Profile
>Semi Glossy

Print Sheet
>’Enter’ to go

Enter

>Paper Series
  All

  Paper Series
>All

Enter

  Paper Series
>ANSI

  Paper Series
>ARCH

Continue to ’Service’ 
(next page)

Media Profile
>Glossy

Enter

>Scan Sheet
  ’Enter’ to go

Scan Sheet
>’Enter’ to go

Enter

Enter

Done

Done

  Paper Series
>ISO A

  Paper Series
>ISO B

  Paper Series
>JIS A

Continue to ’Language’
(next page)

 
 

 



iJET Panel Quick Reference Guide                                 10-14 

 

From ’Options’
(previous page)

>Language
  English

  Language
>English  

Enter

  Load Delay
>1000

From ’Paper Series’
(previous page)

>Media Handling
  Auto Load

  Media Handling
>Auto Load

Enter

  Media Handling
>Manual Load

>Load Delay
  0

  Load Delay
>0

Enter

  Load Delay
>1

>Service
  ...

’Load Delay’ only 
active if ’Auto Load’ 

Selected

’Media Handling’ and ’Load Delay’ 
options are not available on flatbed 

scanners

>Replace Lamp
  No

  Replace Lamp
>NO

Enter

  Replace Lamp
>YES

Enter

>Reset Lamp Cnt.
  No

  Reset Lamp Cnt.
>NO

Enter

  Reset Lamp Cnt.
>YES

>Print Settings
  No

  Print Settings
>NO

Enter

  Print Settings
>YES

Press ’Enter’ to 
activate

Press ’Enter’ to 
activate

Press ’Enter’ to 
activate
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‘S

 

can to’ button – Scan-to-file Settings 

Scan Mode
>B&W threshold

> Scan Mode
    24 – bit Color

Scan Mode
>B&W Adaptive

Scan Mode
>B&W Copy Adaptive

Scan Mode
>Graytone

Enter

Level
>0

Continue to ’Resolution’ 
(next page)

Scan to

Repeat pressing 
’Scan to’ button

until 
the right ’Scan to’ 

target 
is displayed.

Scan Mode
>24-bit Color

Enter    Scan to
    PC-office-8

>Level
  151 Enter

Active if 
’B&W Threshold’ 

selected
Level
>255

Level
>0

>Level
  0 Enter

Active if 
’B&W Adaptive’ 

selected
Level
>255

Level
>0

>Level
  0 Enter

Active if 
’B&W Copy 
Adaptive’ 
selected Level

>255

Gamma
>1.0

>Gamma
  1.0 Enter

Active if 
’Graytone’ 
selected

Gamma
>3.0

Gamma
>1.0

>Gamma
  2.2 Enter

Active if 
’24-bit Color’ 

selected
Gamma
>3.0
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From ’Level’ or ’Gamma’
(Previous Page)

>Resolution
  200 Enter

Resolution
>100

PDF Quality
>1

>PDF Quality
  70 Enter

Active if 
’PDF’ 

selected

PDF Quality
>100

TIFF Quality
>Uncompressed

>TIFF Quality
  Uncompressed Enter

Active if 
’TIFF’ 

selected
TIFF Quality
>Compressed

Resolution
>50

Resolution
>9600

> Size
   Auto Enter

  Size
>Auto

<Standard Sizes from selected paper size list>

See all the paper size options in diagram showing
 the Size button (next page)

>File Format
  PDF Enter

File Format
>TIFF

File Format
>PDF

File Format
>JPEG

PDF Quality
>1

>JPEG Quality
  70 Enter

Active if 
’JPEG’ 

selected

PDF Quality
>100
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The Size Button 

  Size
>ANSI E

  Size
>Auto

  Size
>ANSI A

Size

  Size
>ANSI E (L)

  Size
>ANSI A (L)

ANSI

  Size
>ARCH E

  Size
>ARCH A

  Size
>ARCH E (L)

  Size
>ARCH A (L)

ARCH

  Size
>A0

  Size
>A5

  Size
>A0 (L)

  Size
>A5 (L)

ISO A

  Size
>B1

  Size
>B5

  Size
>B1 (L)

  Size
>B5 (L)

ISO B

This dialgram shows the complete list of available Paper Size sets.

Which of the Paper Size sets that are actually displayed from the 
Size button and menus, depend on your selection in:

Menu button – Advanced – Options – Paper Series. 

JIS A
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Command Set
>RTL

> Command Set
   RTL Enter

Diagram - Custom Setup (Printer Model)
From Printer Setup > Color Printer > Printer Model > Custom Setup

or Printer Setup > B&W Printer > Printer Model > Custom Setup
(previous digram showing ”Printer Setup)

Command Set
>PCL 3 GUI

Ctrl. Language
>None

> Ctrl. Language
   None Enter

Ctrl. Language
>HP PJL

Orientation
>Landscape

> Orientation
   Landscape Enter

Orientation
>Portrait

Scalable
>No

> Scalable
   No Enter

Scalable
>Yes

Resolution
>300

> Resolution
   300 Enter

Resolution
>360

Resolution  values...

Printer Size
>A0

> Printer Size
   A0

Enter

Printer Size
>A1

Paper Size list

Render Type
>Default

> Render Type
   Default Enter

Render Type
>No Simple
Render Type
>Ctx Format

Use Inked Area
>No

> Use Inked Area
   No Enter

Use Inked Area
>Yes
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Option Description Tables 
 
Menu Button - Copy Settings  
This menu entry contains options related to image capture when copying. These are the most common settings when making 
copies.   
 
To reach the Copy Settings: 

1. Press the Menu panel button.  
2. The first copy settings option will be displayed.  
3. Use the arrow up/down buttons to move through the options. 

 

Option Description Settings Description of Settings 

Org. Type – Color  For color copy jobs.  
The Org. Type relates to 
controlling image capture.  
Select the original type that 
best describes the document 
you want to copy.  
 

Photo,  
Photo (ink), 
Brochure,  
Brochure (Ink), 
CAD/Map, 
CAD/Map (Ink) 
 
 

 

Default: Photo 

• Photo - For reproducing photographs and 
posters. 

• Photo (Ink) For reproducing photographs and 
posters from   originals created (printed) with 
an inkjet printer. 

• Brochure – For documents containing both 
photos and text. 

• Brochure (Ink) – For documents containing 
both photos and text from originals created 
(printed) with an inkjet printer. 

• CAD/Map - Suitable for color CAD drawings, 
maps and graphics with a high level of detail. 

• CAD/Map - Suitable for color CAD drawings, 
maps and graphics with a high level of detail 
from originals created (printed) with an inkjet 
printer. 

Org. Type – B&W 
 

For B & W copy jobs.  
The Org. Type relates to 
controlling image capture.  
Select the original type that 
best describes the document 
you want to copy.  
 

Photo,  
Blueprint,  
Sepia,  
Line,  
CAD 
 
 
 
 
Default: Photo 

• Photo - Suitable for photographic images that 
contain many shades of gray. 

• Blueprint – Suitable for Blueprint and other 
originals with heavily distorted foregrounds and 
backgrounds. The shades that create image 
noise are close to the shades that represent 
the image's data and the two are hard to 
differentiate. 

• Sepia – Suitable for Sepia and other originals 
with heavily distorted foregrounds and 
backgrounds where the shades that create 
image noise are close to the shades that 
represent the image's data and the two are 
hard to differentiate. 

• Line - For copying clean and clear line 
drawings and text. Takes advantage of B&W 
thresholding 

• CAD –Suitable for black and white CAD 
drawings and graphics with a high level of 
detail. 

Lightness 
 

To make the copy lighter or 
darker and compensate for 
dull or faded originals.  
 
This menu option can also be 
reached and set with the 
Lightness quick button. You 
can press the button to 
change values. 

-6 to +6 
 
Default: 0 
 

The default Lightness value is set to zero which 
works well with most documents. Values +1 to +6 
will make the copy lighter in relation to the original 
and values -1 to -3 will make the copy darker in 
relation to the original. 

Sharpen To give your copy sharper 
lines. The Sharpen filter 
identifies edges in the image 
and intensifies them. You can 
use the Sharpen option with 
both Color Copying and B&W 
Copying and with all original 

Off, 
On 
 
 
 
Default: Off 
 

When set to ON, the option will apply the Sharpen 
filter when you press either the Color Copy or B&W 
Copy button. 
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types.  

Backg. Clean Used for copying originals 
with backgrounds that are 

0 to 12 
 

The setting is a "cutoff" point. Pixels with a 
lightness under the point are affected. The higher 

not as completely white as 
would like it to appear in 

Default: 0 the Backg. Clean value, the larger the range of 
pixels that will be turned to white. You can define 
cutting points from 0 to 12. The default value is 
zero (no effect). 
 

you 
the copy. 

 

Media Type hat kind of paper 
he printer so the 

system will optimize for 
hing in 

be 

sy, 
Glossy 

ted 

hat matches that in your 
oes not already have a 

Media Profile for the media in your printer, then you 
nu – 

Adva ptions – Closed Loop Cal. – Media 
ofi

To indicate w
you have in t

optimal color matc
relation to the media type 
(paper) the image will 
printed on.  

Coated, 
Semi Glos

 
 
Default: Coa

Select the media type t
printer. If your system d

must create a new Media Profile through Me
nced – O

Pr le. 

Size rmines the 
can area. Usually this would 

be the size of the original 
unless you wish only to input a 
portion.  The Size button will 
activate this same option. 
 
This menu option can also be 
reached and set with the Size 
quick button. 

tandard sizes  

Default: Auto 

u ize 
setti t the edges of the original and 

 
Size can be changed 

th n 
and 

T
s

he Size value dete Auto, 
S
 
 

Yo can select Auto detection or a standard s
ng. Auto will detec

set the scan area to the full original size. 

is a global system variable that 
wi the Size button, the Menu button > Size optio

the Scan-to button > Size option.  

Scale To enlarge or reduce the Size 

be 

to change 
alues. 

25 to 800 

 

The Scale value is defined as a percent (factor) of 

100% ts the original’s 

Ove
 
The of 
pred  to 
create custom scale factor

 the original.  
 means that the copy inheri

in your output copy.  
 
This menu option can also 
reached and set with the 
Scale quick button. You can 
press the button 
v

Default: 100
size. Under 100% means it is reduced 

r 100% means it is enlarged.  

scaling factor can be selected from a list 
efined factors and these can be fine tuned

s.  
 

Mirror Mirroring the image Yes,  
No 
 
Default: No 

Whe .  n set to Yes the result image will be mirrored

Quality To determine the output 
quality.  
 
This menu option can also be 
reached and set with the 
Quality quick button.  You can 

. 

Fast, 
Normal, 
Best 
 
 
Default: Normal 

The d 
u may 

n s.  
 
You can see which of the quality settings is active by 
the LEDs above the Quality button.   

press the Quality button until 
the LED for the Quality setting 
you want to use lights up

best quality will take the longest to output an
use the highest amount of ink on inkjets. Yo
wa t to use the Fast quality setting for test copie

Copies 

et with the 
Scale quick button. You can 

1 to 50 
 
Default: 1 

To make multiple copies of the 
original in the scanner.  
 
This menu option can also be 
reached and s

press the button to change 
values. 
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Reset 
 

t to the copy default 
values that came with your 
system. These will work well 

 
 
 

r 
 and want to restore 

l copy settings at once and 
us reset the system for 

yourself or for other users. 

Enter to Go Press Enter to reset the system to the copy default 
values.   
 

 
. Type Color, Org. Type BW, Media 

ype 
 

To rese

with the most common copy
jobs.  The Reset option is
useful if you have made a
number of special settings fo
a copy job
al
th

  

Copy settings that return to their default values are:  
Lightness, Copies, Scale, Quality, Size, Mirror, 
Sharpen, Backg. clean. 
 
Copy settings that retain their values even after
Restore are: Org
T

Advanced system options, such as network setup 
and printer setup are not changed after Restore.  
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Menu
his m

 Button – Ad up O
enu entry contain ill o

nfiguring the system. M erformed by the system administrator and not by system users.  
  
To reach the Advanced S

1. Press the Men
2. The first copy 
3. Use the arrow  the options until you
4. Press Enter. 

 
 

vanced Menu Settings – S
s options related to the system.
any of these settings would be p

ettings: 
u panel button.  
settings option will be displayed.  
 up/down buttons to move through

ystem Set
  Normally you w

ptions 
nly make these settings once when setting up and T

co

 see Advanced … in the display. 

Option Description Settings Description of Settings 

   Printer setup -> 

Printer Setup -> 
olor Printer -> 
terface 

To select the printer to use with 
the scanner for color copying. 
Output will go to this printer 
when you press the Color Copy 
button. 

USB, 
LAN 
 
 
Default: USB 
 

• USB – select this option if the printer is 
connected to te scanner through the USB 
out port. 

• LAN – select this option if the printer is 
connected to the scanner’s LAN port or if the 
scanner is connected to the LAN and printer 
the printer is on the LAN. In this case you 
must enter the printer’s IP Adresse. 

C
In
  

Printer Setup -> 
&W Printer -> 
terface 

To select the printer to use with 
the scanner for B&W copying. 
Output will go to this printer 
when you press the B&W Copy 
button. 

USB, 
LAN 
 
 
Default: USB 
 

• USB – select this option if the printer is 
connected to te scanner through the USB 
out port. 

• LAN – select this option if the printer is 
connected to the scanner’s LAN port or if the 
scanner is connected to the LAN and printer 
the printer is on the LAN. In this case you 
must enter the printer’s IP Adresse. 

B
In
  

Printer Setup -> 
olor Printer / B&W 
rinter -> Printer 
odel 

nd  

rinter Setup -> 
&W Printer -> 
rinter Mode 

To select the method for setting 
up options for the actual printer 
model. 
 
 

Auto Configure, 
Printer List 
Custom Setup 

• Auto Configure - retrieve the printer’s 
parameters automatically from the printer 
itself. Only for printers with SNMP support. 

• Printer List – The right setting for many 
models are predefined in the scanner and 
you just select the model name from a list. 

•  Custom Setup – enter the printers 
parameters manually. (see details below) 

C
P
M
 
A
 
P
B
P
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Printer Setup -> 
Color Printer -> 

rinter Model -> 
your printer model. 
Recommended parameters for 

Ctrl. Language, 
Orientation 

• Command Set - This is the printer’s format 
language – choose RTL or PCL3GUI 

• Ctrl. Language - The control languaP
Custom Setup 
 

specific m

And
 
Prin

&W
rinter Model -> 

odels can be viewed 
anufacturer’s 

similarity to a printers that have 
actually been tested.  
The list will be updated as new 

sted and enter the 

 your printer is not named on 
the website list, you can try to 

ble with the scanner.   
 
 
 
 

Scalable, 
Resolution, 
Printer Size, 

ge is 
used by the system when it applies some of 
the others settings, such as resolution, size, 
etcetera.  Select None or HP PJL. 

 orientation for 
mat printers this will 

be landscape while on some of the narrower 
models it will be Portrait. 

• Scalable - ‘No’ means that  the scanner will 
efore sending data to 

the printer. ‘Yes” means that the printer will 
take care of scaling. 

 Resolution –This is the the printer’s fixed 

f a 
. 

• 

eans to 
use the whole paper size to determine the 

 … contains printer 

ter Setup -> 
 Printer -> B

P
Custom Setup 
 

To set the printer parameters for Command Set, 

on the scanner m
website. The list 
models that are considered to be 
compatible based on their 

Render Type, 
Use Inked Area 

• Orientation – The feeding
printer. On most large for

models are te
market.  
 
If

use the printer’s documentation 
to determine the right settings. 
Please note however that 
unlisted printers may not be 
compati

take care of scaling b

•
resolution. 

• Printer Size - The printer is defined to be o
certain max standard size - A0, A2 etcetera
Render T• ype - Scan to print data protocol. 
See the lists to find the right selection for 
your printer. 
Use Inked Area – ‘Yes’ means that the 
printer will cut the output by looking at the 
area that was actually printed. ‘No,  m

place to cut. 

Network Setup ->    

Network Setup -> 
DHCP Setup 

scanner is to 
be recognized on the network 
through DHCP or manually.   

Default: Yes 

• 

• Select  

To determine if the Y
No, 

es, Select Yes if your network support DHCP 
and if you want to automatically assign an IP 
address for the copy scanner.  

No to assign an IP address manually
(see next three options).   

Network Setup ->  
IP Address  

To set the device IP Address. 
eededN

 
 only for manual setup 

HCP = No).  

s Cons t 
n 

row ft 
arrow   

(D
 

IP Addres
(12 digit value)  

ult your network administrator for the correc
owIP address and enter the digits. Use the up/d

ar  to change a digit’s value and the right/le
s to move to the next digit you want to set. 

Network Setup ->  
Subnet Mask determine w

Subnet Mask is a mask used to 
hat subnet an IP 

address belongs to Needed only 
for manual setup (DHCP = No).  

Subnet Mask(12 
digit value)  

Cons ct 
values. Use the up/down arrow to change a digit’s 
value and the right/left arrows to move to the next 
digit you want to set.   

ult your network administrator for the corre

Network Setup ->  
Gateway Address  
 

Gateway address is the IP 
address of a network point that 
acts as an entrance to another 
network. Needed only for 
manual setup (DHCP = No).  

IP Address
(12 digit value)  

Consult your network administrator for the correct 
Gateway (IP) address and enter the digits. Use 
the up/down arrow to change a digit’s value and 
the right/left arrows to move to the next digit you 
want to set.   

Network Setup ->  
Share Scanner 

To set your scanner so it can be 
used for scanning from PC 
stations on the network. 
 

Yes, 
No 
 
Default: Yes 

This requires that you have setup the scanner to 
be recognized on the network as described in the 
previous 4 options and  there are compatible scan 
and copy software plus drivers installed on the 
network  PCs.  
 
 
 
 
 
 
 
 
 
 

   Options -> 

 



iJET Panel Quick Reference Guide                                 10-24 

Options ->  
Closed Loop Cal. -> 
Media Profile 

This is step nr. 1 in the Media 
Profile creation process. Her
you select the name/type of 
media in the printer.  

Media Profile creation is to 
ensure color matching.  A Media 
Profile is a unit that stores data
that matches scanner and printe
colors on a given media.  

 

e 

 
r 

ted 

le e 

The 

• 

•

Coated 
Semi Glossy 
Glossy 
 
Default: Coa

Se ct the name that matches the media in th
printer and press Enter to confirm. 

three steps for media type creation are:  

• Select the media type 

Print the system’s closed loop sheet. (see 
below) 

 Load and Scan the system’s closed loop 
sheet. (see below)  

 

Options ->  
Closed Loop Cal. -> 
Print Sheet 

a 
ere 

al 
p 

alibration sheet in order to 
utput colors as they are seen 
n the printer and printing 
edia.  

‘Enter’ to go esThis is step nr. 2 in the Medi
Profile  creation process. H
you print the systems intern
color patch closed loo
c
o
o
m

Pr s Enter to start printing the sheet 

Options ->  
Closed Loop Cal. -> his is step nr. 3 in the Media 

Profile  creation process. Here 

color interpretation to the colors 
on the sheet.  

nter’ to go oad the sheet into the scanner.  
ress Enter to start scanning the sheet 

Scan Sheet 

T

you scan the color patch closed 
loop calibration sheet you 
printed in step 2 (above), in 
order to let the scanner match its 

‘E L
P

Options ->  
Paper Series ay usually work 

ith a specific standard paper 
series. With this option you tell 

 

ANSI 
ARCH 
ISO A 

Default: All 

one of the paper series’. 

Depending on your location and 
business, you m
w

the system which paper series to 
display when you set the Size 
(input size) option. You can also 
tell the system to always display
all the paper series’ in the 
system.   
 

All, 

ISO B 
JIS A 
 

• Select the paper series that fits your location 
and business.  

• Select All if your business uses more than 

Options -> 
Language 
  

 
(other languages 

e added to 
list with 

e firmware 

To select the language you want 
displayed in the IJET Panel’s 
menus. 

English,  

 will b
the 
uturf

upgrades)  

• Select the language. 
 

Options ->  
Media Handling  
(not available on 
flatbed scanners) 

Determine how you want paper 
to be loaded.  

Auto Load, 
Manual Load 
 
Default:  
Auto Load 

 -  the scanner will pull the original 
into the scanner when you feed it into 
insertion slot.  

 Manual Load - you position the original in the 
slot and press the paper forward button to 
feed it into the scanner. 

• Auto Load

•

 



iJET Panel Quick Reference Guide                                 10-25 

Options ->  
Load Delay 
(not available on 
flatbed scanners) 
 
This option is active 
if Media Handling 
(above) s set to Auto 
Load.  

0 he scanner. 

 

 

 
 

 

Set a delay factor for Auto Load.  0-1000 
 
Default: 

• Set a delay factor value -  the scanner will 
use the value to determine how long it waits 
before it pulls the original into t
The option is used to give you time to 
position and align the paper for a straight
path.  

 

 

 

  Service ->  

Service ->  

) 

To move the lamp to a position 

lamp moving into position.  
Wait until you hear the motor stop before 
attempting to remove the lamp.  

Replace Lamp 
 flatbed  (available on

scanners only

at the slide-door opening at the 
back of a flatbed scanner so the 
lamp can be pulled out and 
removed. 
  

Press Enter to position the lamp.  
You can open the scan area cover to see the 

‘Enter’ to go 
 

Service -> 
Reset Lamp Cnt. hat tells users when it is 

time to replace the lamp. 

‘Enter’ to go 
 

Press Enter if you have just replaced the lamp 
with a new one. The internal flag will be reset to 
zero and from there keep track of scanner lamp 

For all scanners. For resetting 
the flag t

usage.  

Service -> 
Print Settings 

Print out all your system’s iJET 
panel settings in order to review 
them. 

‘Enter’ to go 
 

Press Enter to start the printout.  
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Scan to Button – S
try contains options related to image capture wh ing to a file

Settings: 
resses to the Scan to panel button until the right scan target is displ

o confirm and accept the scan target. 
 Scan-to-File settings options (Scan Mode)  will be display d.  

n buttons to move through the options and Enter edit them. 

can-to-file Settings  
This menu en en scann .  

ayed.  

 
To reach the Scan-to-file 

1. Repeat p
2. Press Enter t
3. The first of the
4. Use the arrow up/dow

 

e

Option Description Settings Description of Settings 

Scan Mode For defining the type of image 
processing to be used during 

B&W Threshold, 
B&W Adaptive, 

 Copy 
daptive, 

Graytone 

 
 
 
 
 

4 bit Color 

 B&W Threshold - use thresholds to 
determine whether a pixel is black or white. 
Use this mode for drawings and line art. You 
can set the threshold value (Level).  

• B&W Adaptive - Suitable for scanning all 
fficult 

vel.  

. This mode is 
suitable for copying (scan and print) of 
Sepia, Blueprint and other originals that 

ach pixel. Creates good reproductions of 
complicated B/W images like B/W photos. 

 for capturing 
the closest 

reproduction. Produces large files. For 
reproduction of complicated color images 
like color photos and posters. You can make 
tonal adjustments through a Gamma value. 

•

B&W
A

scanning.   

24 bit Color kinds of drawings including di
 blueprints, brown transparencies (sepias), 

etc. You set Adaptive le
• B&W Copy Adaptive - enhancement on 

foreground and background

 
efault:  

could be improved by clarifying foreground 
and background.   

• Graytone - 256 gray levels are recognized 
for e

D
2

• 24 bit Color - true color mode
all of the image's colors with 

Adjustment Options for the Scan Mode: The following 5 options are adjustment settings for the Scan Mode described above. 
There is one adjustment setting option for each Scan Mode and so only one of the 5 options below will be displayed in the panel and 
enabled for changing.  

Level 
ctive if Scan Mode 
 set to B&W 
hreshold)  

For setting the threshold value 
when the Scan Mode is B&W 
Threshold. 

0 – 255 
 
Default: 151 

When scanning at a specific threshold value, all 
gray tones below the threshold will be 
represented as black pixels, and all gray tones 
above will be represented as white pixels. 

(A
is
T

Level 
ctive if Scan Mode 
 set to B&W 
daptive)  

For setting the amount of 
adaptive processing when the 
Scan Mode is B&W Adaptive. 

0 – 255 
 
Default: 0 

The Level works like a threshold - the lower the 
value, the more of the background is picked up 
during scanning.  

(A
is
A

Level 
ctive if Scan Mode 
 set to B&W Copy 
daptive)  

For setting the amount of 
adaptive processing when the 
Scan Mode is B&W Copy 
Adaptive. 

0 – 255 
 
Default: 0 

The Level works like a threshold - the lower the 
value, the more of the background is picked up 
during scanning. Adaptive enhancement features 
are automatically applied. You only have to adjust 
the adaptive "Level" to determine the best degree 
of enhancement processing for your specific 
image. 

(A
is
A

Gamma 
ctive if Scan Mode 
 set to Graytone) 

For tuning gray shades when 
scanning to file in the Graytone 
mode.  

0.1 - 3.0 
 
Default: 1.0 
 

Pixels are intensified according to a gamma curve 
they are mapped to. A low gamma value smaller 
than 1.0 darkens the output while a high gamma 
value larger than 1.0 typically lightens the shadow 
areas and brings out detail. 

(A
is
 

Gamma 
ctive if Scan Mode 
 set to  
4–bit Color) 

For tuning colors when scanning 
to file in the 24-bit Color mode.  

0.1 - 3.0 
 
Default: 1.0 
 

Pixels are intensified according to a gamma curve 
they are mapped to. A low gamma value smaller 
than 1.0 darkens the output while a high gamma 
value larger than 1.0 typically lightens the shadow 
areas and brings out detail. 

(A
is
2
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Resolution DPI 
(dots per inch) 

50 to 9600 Select a value from the 
Hi

Setting image quality in list of values available. 
gh resolutions create large files. 300 dpi or 

more is adequate for printing. Certain maps and 
gs with high levels of detail require 

tions. CAD processing of the result 
also require that you select a high resolution. 

settings below or equal to the scanners 
i will give pure optical resolutions 

without interpolation.  
l specifications to view the 
tion. 

CAD drawin
high resolu
may 
Dpi value 
optical dp

See your scanner mode
scanner’s optical resolu

Size The Size value determines the 
scan area. Usually this would be 
the size of the original unless 
you wish only to input a portion.  
The Size button will activate this 
same option. 
 
This menu option can also be 
reached and set with the Size 
quick button. 

 

u  

 

be 
chan  > 
Size .  

Auto, 
Standard sizes  
 

setti
and

 
Default: Auto

Yo can select Auto detection or a standard size
ng. Auto will detect the edges of the original 
set the scan area to the full original size. 

 
Size is a global system variable that can 

ged with the Size button, the Menu button
 option and the Scan-to button > Size option

File Format To select the best file format for 
your task. 

PEG, 

 
Default: PDF 

• 

• r 

J
TIFF, 
PDF 

JPEG – If selected you can set a quality 
factor from 1 to 100. 70 is default.  

• TIFF – If selected you can set quality to 
Uncompressed or PackBits.  
PDF – If selected you can set a quality facto
from 1 to 100. 70 is default 
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